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• Eclipse is a registered trademark of the Eclipse Foundation, Inc.
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• IBM, AIX, DB2, and WebSphere are registered trademarks of International Business
Machines Corporation.

• Intel and Pentium are registered trademarks of Intel Corporation in the U.S. and/or
other countries.

• JBoss is a registered trademark, and CentOS is a trademark, of Red Hat, Inc. in
the U.S. and other countries.

• Linux is a registered trademark of Linus Torvalds.

• Microsoft, Active Directory, Internet Explorer, SharePoint, SQL Server, Visual
Studio, and Windows are registered trademarks or trademarks of Microsoft
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• Mozilla and Firefox are registered trademarks of the Mozilla Foundation.

• Oracle and Java are registered trademarks of Oracle and/or its affiliates.

• Progress and OpenEdge are registered trademarks of Progress Software
Corporation or one of its subsidiaries or affiliates in the U.S. and other countries.

• Red Hat and Red Hat Enterprise Linux are registered trademarks of Red Hat, Inc.
in the U.S. and other countries.

• SAP and SAP NetWeaver are registered trademarks of SAP SE in Germany and
in several other countries.

• SUSE is a registered trademark of SUSE, LLC.

• Ubuntu is a registered trademark of Canonical Limited in the United States and/or
other countries.

• UNIX is a registered trademark of The Open Group in the United States and other
countries.

All other marks contained herein are for informational purposes only and may be
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Aurea global support
If you encounter a problem while using an Aurea product or require assistance with downloading
the software or upgrading a product release, please, try to:

• Search the articles on the Aurea Knowledge Base for solutions to your issues.

• Search the product documentation and other product-related information that are also available
on Support Central.

If you still cannot find a solution, open a ticket on Aurea Support Central. Information about the
support organization is available on Support Portal as well.

You can also find the setup files on Support Portal.

For information about purchasing an upgrade or professional services, contact your account
executive. If you do not know who your account executive is, or for other queries, contact us
through our website.
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1
Using a Jive community
Here you can find information about navigating and using your community.

For details, see the following topics:

• Using community from mobile browsers

• Using News

• Creating custom streams

• Using Your View

• Finding people, places, and content

• Using social groups

• Using content

• Using projects and tasks

• Public and private communications

• Using Jive Apps

• Using external groups

Using community from mobile browsers
When accessing a Jive community from a mobile device, the mobile browser features
simple navigation with large buttons that are better suited for touch screens. Note
that options that are too complex or too large for narrow screens are not displayed.

To visit your community from a mobile browser, enter your community's URL into
the browser of your mobile device and log in. Likewise, you can see the same narrow
interface on the desktop version by making your desktop browser smaller.

The following options are available from a mobile browser:

Note:  Some content and functionality only make sense in the wider desktop view,
so you won't see some things cluttering up the smaller space. However, iPads always
benefit from the full functionality of a wide-screen view.

You can browse through and interact with your streams,
and read and respond to your Inbox items.

Read and interact
with your streams and
Inbox
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Create different content from your mobile device, for
example, ideas, blog posts, and documents.

Create most content
types

Tap the magnifying glass, enter your search term, and then
click the down-arrow to filter by content, people, or places,
and the time period of the last modification.

Search and filter

Follow, join, or leave places from the mobile browser. You
can also see a place activity, content, people, and any

Access and use
places

subspaces, projects, and custom pages the place may
have. To sor t the content in a place, click Content and
then an icon: documents, discussions, blogs, or polls. If
you're looking for the tiles on a group's activity page, be
sure to scroll down to see them.

Known issues

• The mobile browser does not work on Blackberry devices.

• Older Android browsers struggle with content creation. You can resolve this by
upgrading your Android operating system and using Chrome to browse your
community.

Quick tour from a mobile browser
Here's a quick visual tour of navigating your community from the built-in browser
on your mobile device (or a narrow desktop screen).

If you're totally new to Jive, refer to Getting star ted for a walk through the key tasks,
such as posting a status update, connecting with colleagues, and joining a group.
Otherwise, from your mobile device, enter the URL of your community into the built-
in browser.

9AUREA CONFIDENTIAL

Using community from mobile browsers



See
what's
new

When you first log in using a mobile browser, you see the latest posting
from News, as you see to the right. To see your streams, tap the
down-arrow. You can go to any of them by tapping one.

Check
out
your
Inbox
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If you see a blue aler t next to the person icon, you have something unread
in your Inbox. You could also go to Your Content and Your Places from
here. You could also log out from the community if required.

Create
content

You can create all kinds of content right from the mobile browser. You
can publish it for specific people, in a place, or the entire community.
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Find
what
you're
looking
for

You can search from your mobile browser by tapping the magnifying glass
in the upper right corner. After you enter your search terms, click the
down-arrow to filter by Content, People, or Places, and the time period
of the last modification. Note that we decided that a narrow-screen search
should be just about search, so you won't see Bookmarks or Recently
Viewed Content taking up precious real estate here.

Using News
The News page gives you an account of what is going on in your community. It
features a variety of streams and tiles designed to bring you the latest news and
information.

Overview of News
The News page is the central place for you to see what's happening in
the community. The News page features a variety of streams designed

to direct you to content, people, and places that per tain directly to you. You can
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also see your Following stream, any custom streams you have created, and the All
Activity streams, which show recent activity from all over the community that you
have permission to see.

You can see these streams individually by clicking the link to a stream in the stream
menu at the top of the page and scrolling down the page, or you can use the main
News page to overview the latest items in each stream in a combined block view.
Each block has a header that shows what stream the item came from.

Note: The News page responds to browser width by adjusting to fit all your streams
so your main navigation menu may differ slightly from browser to browser or from
screenshots in this Help. For example, you may see your News subscription streams
listed individually or collapsed into a drop-down menu.

You can pin any of the streams listed on your News page to either the News or
Home button in the main menu, depending on how your community manager has
set up the main navigation menu in your community. Just click the pin icon from the
desired stream's page, and when you click Home or News from anywhere in the
application, you are taken to the page you pinned. For more information, see Pinning
pages for quick access.

The News page also features a variety of tiles to help you find important people,
places, and content quickly. The Trending Content and Trending People tiles are
included by default but may be removed by your community manager.

Here's an overview of what you can see on the News page. For a quick visual tour
of the News interface, see News page interface on page 15.

The News view aggregates and displays content posted in your
News and Following streams. However, unlike your streams, the

News
(top-level
view) News page does not show content updates and comments in a

stream view. Content that gets updated or interacted with is not
moved to the top of the News view: this view shows only new things.

Content is pulled in and displayed in the News view in the order
in which your streams are displayed to the right of News in the
stream menu. Duplicated content is removed if it's already being
pulled in from a higher-order stream. The content you've read (by
clicking through to it either from your desktop or a mobile version
of Jive) stays in News for two days before going away. The content
you haven't yet read stays for ten days. Because the News streams
are designed just for you, you won't see the same content pulled
into the News view that other users see.

These are the streams you see listed when you expand the menu
under News. These streams are created and managed by your

News streams

community manager or people with Manage News Streams
permissions. Because these streams are designed just for you,
you may not see the same News streams or the same content in
them that others see. For more information, see Overview of News
streams
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This stream shows you the trending content in your community to
get you a feel for what's happening right now.

Note:  Content items can be excluded from the Top & Trending
stream. For more information, see Removing content items from
Top and Trending on page 76.

All Activity:
Top &
Trending
stream

This stream shows you all community updates that you have
permission to see as they are posted in real time. Scrolling through

All Activity:
Most Recent
stream this stream can be useful for adding new people and content to

your Following or custom streams.

When you star t following people, places, and content items, they
are automatically added to this stream. Use this stream if you want

Following

to check in throughout the day but not create a lot of custom
streams. This stream is included for you by default, and you can
add to or delete content, people, and places from it.

If you've created any custom streams, you can see those listed to
the right of Following. Custom streams can be a great way to keep

Your custom
streams

up with the content, people, and places that matter most to you in
your community. For some examples of custom streams which you
might want to create for yourself, see Examples of custom streams
on page 20.
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News page interface
Here you can find the visual overview of a News page.

Figure 1: How News page looks

1. Listed first are any streams your community manager has curated for you.

2. The All Activity stream is a great way to see what's happening right now.

3. Activity indicator dots appear next to streams that have a new activity in them
since you last checked.

4. Also listed here are streams that you create yourself to focus on the things you
want to see.

5. Banner images might be pictures, or they might link to helpful places.
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6. Top & Trending shows you the activity getting a lot of attention right now.

7. See how many likes and comments have been given to something right from the
card view.

8. Following shows you the content generated by people, places, and content you
are following. You can add to or remove items from this stream.

Overview of News streams
News streams that are displayed on the News page are configured for you by your
community manager and are designed to bring you the latest news from your
organization, department, team, or product. Additionally, you can create your own
custom streams to tailor the news.

Click News to find your News streams if they've been set up.

Because they are designed just for you, you may not see the same News streams
or the same content in them that others see. For example, everyone in your commu-
nity may see the CEO's Blog stream that shows the latest blog posts from your or-
ganization's CEO. However, only people in the Marketing department may have a
stream called Marketing News that shows activity from the Marketing space.

Also, you might have a News stream based on your role in the community. For ex-
ample, let's say everyone has a stream called What’s New, but what is displayed
there differs depending on the user's role. Or customers might see content pulled
from the Special Promotions blog in their What's New stream, but vendors might
see content pulled from the New Solutions group.

For more information about streams and how they work, see Overview of streams.

Creating custom streams
You can create your own custom streams to help you keep up with the content,
people, and places that matter most to you in your community.

Overview of streams
A stream shows you real-time updates of activity as people interact with content,
people, and places in the community.

You can see streams on the News page and the Activity page of any place. Streams
are updated when someone creates a document, replies to a blog post, posts a
status update, and so on.
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Examples of activities which update streams

Here are some examples of activities that trigger new stream items for people,
places, and content that you're following in a stream:

• Content: Someone modifies the content item, for example, edits, comments on,
or replies to it.

• People: Someone posts a status update, creates a content item, or comments on
a content item.

• Places: Someone updates content in the place, for example, publishes a new
document, edits a blog post, shares content with a place, or comments on a
document that lives in the place.

• Tags: Someone creates or modifies an item with a tag you're following in the
stream, or adds the tag to a content item.

Tracking new activity in streams

Here are some ways you can track new activity in your streams:

When there is new activity in your streams, such as likes, comments,
edits, or new content, you can see an indicator dot next to the stream

Activity
indicators

name on your News page. If you hover over the indicator, you can
see the count of new activity for that stream since you last viewed
it.

When you select a stream, you are viewing all activity, with the Most
Recent content listed first. If you want to view only the content you

Stream
views

are following in that stream, you should select Top & Trending to
sor t activity by the most active content since you last viewed the
stream.

As you are scrolling through your stream, you can see the End of
New Updates line, so you know when you've seen all the new activity

Update lines

for that stream. If you continue scrolling, you can see the End of
Previous Updates line that shows you the updates from last time
you checked.

Streams to follow

Here are some streams you can view to follow activity in your community:

You can see all public activity that you have permission to
see in this stream.

All Activity: Most
Recent stream
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You can create your own custom streams that show only
the people, places, and content items you select.

For more information, see Creating custom streams on page
19.

Custom streams

Each person and place in the community has an activity
stream. You can see yours under your profile, and places
have a place-specific stream that shows up on place pages.

People and Place
activity streams

News streams are those listed to the left of your custom
streams. They were created by your community manager

News streams

to help you see important content. For more information
about how these streams work, see Overview of News and
Overview of News streams.

Notifications about streams

You can also select your notification preferences by clicking Your avatar > Prefer-
ences .

Custom streams interface
Here you can find the News page details.

Figure 2: How a custom stream page looks

1. See all your custom streams.

2. Give your stream a unique name.

3. Delete your stream, if you no longer need it.
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4. Receive email or mobile updates about your streams.

5. View people, places, or tags you've added to a custom stream.

6. Search for more people, places, or tags to add.

7. Add people, places, or tags from the suggested lists.

8. See how many of your streams a person or a place is in.

Creating custom streams
You can create your own customized streams if available in your community.

To create a custom stream:

1. On the News or Home page, click  to the right of the streams.

You can see a two-column layout with suggested stream content on the right.

2. In Stream name, enter a name for this stream, for example, Water Cooler, New
Products, or Team Activity.

3. Drag and drop items from the Suggested People, Places, and Tags in the right
column to the left column, or use the Search box to find specific items you want
to follow in this stream. For more information about how to find and follow useful
things, see Tips for finding things to follow on page 22 or Following tags on page
52.

4. If you want to receive a notification every time there is a new item in this stream,
select Mobile or Email (or both) under Updates at the top of the page.

• The option to change your email notifications preferences may be unavailable
in your community. For more information, see Choosing between email and
stream notifications.

• We strongly recommend leaving Email cleared, which is the default; otherwise,
your email notifications could get overwhelming pretty quickly.

• Mobile notifications go to the Jive Mobile or Jive Daily: Intranet on the go app
if you have it installed on your Android or iOS device. If you don't have one of
these apps, mobile notifications don't have any effect.

5. To save this new stream, click Done.

You can add to, edit, or delete this stream any time you want. For more information,
see Updating custom streams on page 23 and Editing custom streams on page 24.
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Examples of custom streams
Here are some examples of custom streams you might create, depending on your
role in the organization or how you want to check in on community activity throughout
the day.

Strategies for creating streams

You should consider creating and organizing your custom streams based on the
following strategies. You can try using a combination of these to develop the best
approach for your unique needs.

Create a stream where you follow yourself. This can help you get
to your most-used items quickly.

My stream

You can create streams for immediate, soon, and later items. You
could check Immediate often and Soon occasionally. In Immediate,

Priority
streams

follow your high-priority people, places, and content items. In Soon,
follow your less urgent people, places, and content items. This
kind of organization can be good if you like to read some things
later, but don't want to miss your high-priority things as they are
posted.

You can create an Blog stream where you follow the blogs of the
CEO, CTO, and VP of your department. For more information, see
Creating custom blog stream on page 105.

Content
streams

This stream can be convenient if you're in and out of the community
a lot, and especially if you're out of the office for a few days. Add

Can't miss

to this stream only critical items that you can't miss. Then, make
sure to select Email or Mobile from Updates so that you receive
notifications when activity happens in this stream.

Note: The option to change your email notifications preferences
may be unavailable in your community.

To these streams you can add the people you work with, the content
you all are working on, and the places where your team most

Team and
Product
streams frequently posts. Or, create one good Team and Product stream

to check throughout the day for updates from your team and the
product you're working on.

When you star t following people, places, and content items, they
are automatically added to this stream. You can use this stream

Following
stream

if you want to check in throughout the day but not create a lot of
custom streams. This stream is included for you by default, and
you can add to or delete content, people, and places from it.

When you follow tags, you follow updates of the content which is
marked with this tag. You can create an entire stream for one tag,

Tag streams

or add tags to optimize your existing streams. If you're a QA
Engineer, you might add the #test tag to your stream that already
follows the QA Group.
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Examples for creating custom streams

Here are more specific streams that you might create, depending on your role in
the organization.

If you work in the Engineering department, you can create the following new streams:

• Email Watches: Follow critical items here and select Email or Mobile from Updates
so that you receive notifications when activity happens in this stream. Use this
stream wisely so that you don't create an email nightmare for yourself.

Note: The option to change your email notifications preferences may be greyed-
out and unavailable in your community.

Note: You can also select your notification preferences by clicking your avatar
> Preferences .

• Product A: Follow everything related to one of the products you're working on.

• Product B: Follow everything related to another product you're working on.

• Team: Follow everyone on your team so that you stay current with their activities.

• Research: Follow things related to your next big product idea.

• Awesome Blogs: Follow blogs that you like.

• Water Cooler: Follow fun people, content items that are amusing, and community
places where people organize social events.

If you work in the Accounting department, you can create these streams:

• Customer Account A: Follow everything related to one of the customer accounts
you're working on.

• Customer Account B: Follow everything related to another customer account
you're working on.

• Team: Follow everyone on your team so that you stay current with their activities.

• Sarbanes-Oxley: Follow people, places, and content items in your community re-
lated to Sarbanes-Oxley, so that you don't miss important new regulations or
processes.

• Latest Wins: Follow the place where your latest wins are reported. You might also
follow the VP of Sales and the blogs of Sales team members here.

• Email Watches: Follow critical items here and select Email or Mobile from Updates
so that you receive notifications when activity happens in this stream. Use this
stream wisely so that you don't create an email nightmare for yourself.

Note: The option to change your email notifications preferences may be greyed-
out and unavailable in your community.

Note: You can also select your notification preferences by clicking your avatar
> Preferences .

21AUREA CONFIDENTIAL

Creating custom streams



If you work in the Sales department, you can create these streams:

• My Region: Follow everyone working in your region, plus all of the places you
and they post most often.

• Marketing for Product A: Follow the people, places, and content related to the
marketing of Product A.

• Customer Account B: Follow the people, places, and content related to the mar-
keting of Product B.

• Exec Blogs: Follow the blogs of the CEO, CMO, SVP of Sales, and other leaders
who matter most to you.

• Can't Miss: Follow critical items here and then make sure to select Email or Mobile
from Updates so that you receive notifications when activity happens in this
stream.

Note: The option to change your email notifications preferences may be greyed-
out and unavailable in your community.

Note: You can also select your notification preferences by clicking your avatar
> Preferences .

• Comic Relief: Follow enter taining people and places where people post funny
stories and videos.

Tips for finding things to follow
Here are some tips for finding useful activity to follow in your community.

• Browse the content, people, or places that your co-worker or someone with similar
interests follows by clicking Places or People on their profile page. This way you
can quickly find things and people you should also follow.

It can also be helpful to look at their bookmarks. For more information about
bookmarks, see Using bookmarks on page 52.

• Read the All Activity: Top & Trending stream on the News page to see what
other people are excited about.

• Browse for items using the People browse in the main navigation menu or Your
Content or Your Places in your user profile menu in the upper right.

Once you're browsing, type keywords into the filter box to narrow your results.
For more information about filtering, see Browse and filter content, people, and
places on page 47.

• Use Search to find things that interest you. To learn how search works, see Using
Spotlight search on page 40.

• Try following a tag. Note that this can be tricky because people from all over the
community assign tags, so you may not know how other people are tagging content,
places, and people. For more information, see Following tags on page 52.
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Following people, places, and content
There are several ways to star t following a piece of content, a person, or a place
in the community. Here you can find how to star t and stop following items.

Starting following people, places, or pieces of content

To star t following people, places, or pieces of content:

• Use people hover cards. From any stream you're reading, hover your mouse over
a person's name or avatar, or the name of a place, and click Follow. You can
then select the stream in which you want to follow the person or place.

• Use the Browse menus. Click People from the main navigation menu (may also
be nested under the Browse button), or click Your Content or Your Places from
the menu under your avatar, then browse for things to follow. You can also check
the Recommended tab to see recommendations based on your individual activity
and connections in the community. When you see an item you want to follow,
click on its gear icon, and then Follow. Then select the stream in which you want
to follow the content item, person, or place.

• Use the Search feature. Search for keywords of things that might interest you.
When you find something you want to follow, click on the item. From there, click
Actions > Follow . Then select the stream in which you want to follow the content
item, person, or place.

Stopping following people, places, or pieces of content

To stop following something, do one of the following:

• Go to the item, then click Actions and clear the Following check box. You can
also clear check boxes for the streams from which you want to stop following the
person, place, or content item. You will no longer see updates for that person,
place, or content item in those streams. Those updates can still appear in the
Most Recent stream, however, because that stream shows all public activity in
the community.

• Go to the stream and click the edit icon above the stream. From here, click 
next to the items in the left column that you want to remove from your stream.

Updating custom streams
Quickly add content, people, and places to any of your custom streams and your
Following stream using any of these methods.

Tip:  If you are already following something in a stream, you can see the notation
Following in. If you're not following it, it shows Follow.
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Starting following people, places, or pieces of content

To star t following people, places, or pieces of content:

• Use people hover cards. From any stream you're reading, hover your mouse over
a person's name or avatar, or the name of a place, and click Follow. You can
then select the stream in which you want to follow the person or place.

• Use the Browse menus. Click People from the main navigation menu (may also
be nested under the Browse button), or click Your Content or Your Places from
the menu under your avatar, then browse for things to follow. You can also check
the Recommended tab to see recommendations based on your individual activity
and connections in the community. When you see an item you want to follow,
click on its gear icon, and then Follow. Then select the stream in which you want
to follow the content item, person, or place.

• Use the Search feature. Search for keywords of things that might interest you.
When you find something you want to follow, click on the item. From there, click
Actions > Follow . Then select the stream in which you want to follow the content
item, person, or place.

Editing custom streams
As your projects and interests change over time, so should your custom streams.
Edit them to match what you need from the community at any given time. You can
also delete a custom stream.

Your streams should change over time as you add and remove people, places, and
content from them, depending on what you're working on and how your team,
products, and tasks change over time. From any of your streams, you can hover
over a place name or person's name and select Following > Stop Following  or
select the streams you want to follow it in. For content items, click the name of the
item, and then select Actions > Follow  and select or unselect the streams you'll
see it in.

To edit a stream:

1. Select the stream and click .

2. Drag and drop items into the stream to follow them.

3. Click  to remove items from the stream.

4. When you're finished, click Done.
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To delete a stream:

• Select the stream, then click  and confirm deletion.

Items that appear in streams
You can review your stream content and understand why you are seeing something
in a stream with these checks.

Here are some examples of activities that trigger new stream items for people,
places, and content that you're following in a stream:

• Content: Someone modifies the content item, for example, edits, comments on,
or replies to it.

• People: Someone posts a status update, creates a content item, or comments on
a content item.

• Places: Someone updates content in the place, for example, publishes a new
document, edits a blog post, shares content with a place, or comments on a
document that lives in the place.

• Tags: Someone creates or modifies an item with a tag you're following in the
stream, or adds the tag to a content item.

If you are seeing something in your stream that you don't think you are following,
you should check if you follow:

• The person who posted the item?

• The place where the item was posted?

• This content item?

If you discover that you are following the person, place, or content item in your
Following stream or any of your custom streams, but you don't want to, go to or
hover over the person, place, or content and click Stop Following.

Your News streams (those listed when you click News) were created by other people,
so you have to ask them about any unexpected content you see in your News
streams.

A common question is why you're getting email notifications on activity you're not
interested in. Note that each of your custom streams (those listed to the right of
Following) has a configuration setting to enable or disable email notifications. For
more information, see Choosing between email and stream notifications.
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Choosing between email and stream notifications
You can receive notifications in Inbox and on email. Here you can find details about
choosing when and how you want to be notified about new activity in your streams
and when you don't.

Stream and Inbox notifications

You can keep track of activity in your community without ever leaving the community
page through notifications in your Inbox and through streams.

When you collaborate on content in your community, you're
automatically notified in your Inbox when updates are made to
that content.

Inbox
notifications

If there is content that you want to watch but have not directly
collaborated on, you can follow it in a stream. When there is new

Stream
notifications

activity in your streams, such as likes, comments, edits or new
content, you can see an indicator dot next to the stream name on
your News or Home page. If you hover over the indicator, you can
see a count of new activity for that stream since you last viewed
it.

Tip:  Relying on these notifications can save you time and cut down on your emails.

Email notifications

If you want to receive email notifications, do so prudently. You may find that you
rapidly accumulate hundreds of email messages in a busy community, since you
may get an email every time that stream is updated.

To receive emails in addition to Inbox and stream notifications,

1. Go to your avatar > Preferences .

2. Select Yes for Receive email or mobile notifications when there is activity in
the community?.

3. Select Email next to your Inbox or streams.

Note: The option to change your email notification preferences may be unavailable
in your community.

Examples of email notification strategies

Here are some email notification strategies:
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Note: The options to change your email and Inbox notification preferences may be
unavailable in your community.

• Not receive any email notifications: You won't receive notifications on email. All
update notifications you will receive in the community.

• On your Preferences page, select No in Receive email or mobile notifications
when there is activity in the community?.

• Receive emails for the News Digest only. You can change the frequency that you
receive this digest from the drop-down list. For more information, see News Digest.

• On your Preferences page, select Yes in Receive notifications?, and select
Email for News Digest.

• Create an Email Watches stream and follow only critical items. This stream can
be helpful when you're away from the community for a few days or if you want to
watch something that you haven't directly collaborated on. For more information,
see Creating custom streams on page 19.

• On your Preferences page, select Yes in Receive email or mobile
notifications when there is activity in the community? and select Email for
that stream.

• Change the frequency of your email notifications. Instead of receiving an email
for every update, you can receive a digest of updates.

• On your Preferences page, select Yes in Receive email or mobile
notifications when there is activity in the community? and select one of
the summary options from the list next to your Inbox and streams.

Customizing notifications
You can set notifications for your Inbox and any of your streams so that you receive
an email or mobile app notification each time a person, place, or item posts an
update or you have Inbox activity.

There are a few ways to set your notifications.

Remember: You can choose the frequency of these notifications from the drop-down
list next to each Inbox or stream.

When you're viewing or editing a stream

1. On the News (or Home) page, select the stream and click .

2. Select Mobile, or Email, or both from Updates at the top of the page.

3. Click Done.

Note:  Mobile notifications appear in the  or Jive Mobile app if you have it installed
on your Android or iOS device. If you don't have one of these apps, mobile
notifications don't have any effect.
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From the unsubscribe link in the email

You can click the unsubscribe link in an email so you will no longer receive notifi-
cations. It switches the Receive notifications? option to No on your Preferences
page.

From your Preferences page

1. Go to Your avatar > Preferences .

2. Select Yes in Receive email or mobile notifications when there is activity in
the community?.

3. Select Email or Mobile notifications for each stream and your Inbox, and select
the frequency of notifications for each from the list.

4. Click Save when you're done.

Caution: When you select All Activity, you get an email every time that stream or
Inbox is updated. We recommend leaving Email cleared or choosing one of the
summary options; otherwise, your email notifications could get overwhelming.

For more information about notification settings, see Notification Preferences refer-
ence on page 28.

Note: The options to change your email and Inbox notification preferences may be
unavailable in your community.

Notification Preferences reference
Here you can find the description of preferences related to notifications about
activities.

Fastpath: You avatar > Preferences > General Preferences

Notification Preferences

• If you want to receive notifications on email or in the mobile app, you must set
Receive email or mobile notifications when there is activity in the community?
to Yes.

• If you want your email notifications to include the full text of the item you're being
notified about, select Include body of content in email.

Inbox Notifications

Note: The options to change your email and Inbox notification preferences may be
unavailable in your community.
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When you select Email or MobileNotification for Inbox ac-
tivity

Receive a notification when the content you created
or par ticipated in is updated.

Inbox: Activity

Receive a notification when someone @mentions you,
shares content with you, or sends you a message in
the community. For more information about mentions,
see Aler ts for people, places, and content items.

Inbox: Direct Social Ac-
tions

Receive a notification when you have a new task, a
new follower, or a new skills endorsement.

Inbox: Alerts

Receive a notification when you receive a new badge.Inbox: Badges

Receive a notification when you have content to mod-
erate. This option is available if you're a content mod-
erator.

Inbox: Moderation

News & Stream Notifications

Note: The options to change your email and Inbox notification preferences may be
unavailable in your community.

When you select Email or MobileNotification for Inbox ac-
tivity

Receive a notification when a new activity is posted in
custom streams created for you by your community
administrators (if any).

Custom streams created for
you by community adminis-
trators

Receive a notification when a followed person, place,
or item posts an update.

Following

Receive a notification when a new activity is posted in
custom streams you created for yourself (if any).

Custom streams

Receive a summary of community news. For more in-
formation about the digest, see News Digest.

News Digest
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Using Your View
Your View lets you customize a page just for yourself, so that you can get to your
most used items quickly.

You can change what you see from Your View whenever you want. For example,
you might want to update Your View when you change projects or teams, or when
you want to watch new things in your community.

• To go to Your View, click the  icon in the main navigation menu, and then click
Your View in the left sidebar.

Note: You won't see Your View if your community manager has not enabled the
feature.

Setting up Your View as default on 
Your View is pre-populated with a few tiles to get you star ted, but you can edit these
or remove them altogether. You can also add new tiles that you select and configure
to suit your specific needs.

Your View is your own page which you design and change for yourself, however
and whenever you like.

• To go to Your View, click the  icon in the main navigation menu, and then click
Your View in the left sidebar.

You can customize the Your View page with tiles. By default, you can see the fol-
lowing tiles in Your View:

• Frequently Viewed

• Latest Blog Posts (if blogs are enabled in your community)

• Trending Content

• Key Content and Places

To edit Your View:

1. Click Edit page at the upper right corner of the page to open it for editing.

2. To configure a tile, click the gear icon on them and change the tiles settings.

3. To move the tiles up and down on the page, click the up and down arrows on
tiles.
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To pin Your View to the  button:

• Click  next to Your View in the left sidebar.

Now, when you click the  button in the main navigation menu, you go right to Your
View. This can be helpful if you design Your View with links to your most visited
items.

Adding tiles to Your View
You can add new tiles to Your View in a few steps.

Your View can contain tiles of several types. For more information on the tiles which
you can use on here, see Your View tile reference.

Note: The number of wide (that take 2/3 of the page) and custom (listed under the
External Add-ons and Custom Tiles categories) tiles you can add to any Activity,
Custom page or Your View is limited. For details, contact your system administrator.

To add tiles to the Your View page:

1. Click the  icon in the main navigation menu.

2. Click Your View in the left sidebar to open the Your View page.

3. Click Edit page in the upper right corner to open the Your View page for editing.

4. Click Add a tile.

5. In the dialog box, select a category on the left, and select the tile that you want
to add on the right.
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Note:  Note that the list of tiles that appears for selection is different for wide and
narrow columns respectively. Once added, these tiles can be moved ver tically
within the same column or removed within the layout as required.

6. If required, configure the tile by clicking the gear icon at the upper right corner
of the tile and adjusting the tile parameters, and then click Apply.

The tile is added to the page.

7. If required, adjust the tile position in the layout column by using the arrows in the
upper right corner of the tile.

8. Click Save to save the page changes.

With the changes saved, Your View displays the information you want to have on
hand.

For more information about tiles, see Using tiles.

Using tiles
Tiles display useful information in Activity and custom pages for places, News page,
and Your View pages.

• You have plenty of options to choose from when adding a tile to a place. Look
through the categories to see all of your options. For more information, see Tile
reference.
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Two useful tiles that you can choose are the Top Participants and Upcoming
Events tiles:

Figure 3: Example of tiles

• Different tiles are available in different places. Activity and custom pages, News,
and Your View all have different tile options.

Note:  If you own the place, you can choose whether or not to show these default
tiles, and you can also add different tiles.

• You can use a tile as is or customize it to display specific information. For more
information, see Place Templates for designing activity and custom pages for
places.

Your View tile reference
Here's a list of the tiles available on a Your View page.

Tiles are split by category, similar to tiles arrangement in the UI. Some tiles can be
available in more than one category.

Note: This page is not supported by Jive Daily: Intranet on the go.

Note: The number of wide (that take 2/3 of the page) and custom (listed under the
External Add-ons and Custom Tiles categories) tiles you can add to any Activity,
Custom page or Your View is limited. For details, contact your system administrator.
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Collaboration tiles

Wide col-
umn

Narrow col-
umn

DependenciesDescriptionTile

  Content added
manually

Shows a full pre-
view of a document
you choose to dis-
play

Document
Viewer

 Content added
manually

Builds a list of key
links for quick refer-
ence. Links can be
internal to your
community or exter-
nal URLs

Helpful Links

 Content added
manually

Shows selected
dates for your team

Key Dates

Graphic Elements tiles

Wide col-
umn

Narrow col-
umn

DependenciesDescriptionTile

 Set manuallyShows status on a
gauge

Gauge

  Content added
manually

Shows a manually
selected video from
an external, non-
community source

Video (Exter-
nal)
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Custom List tiles

Wide col-
umn

Narrow col-
umn

DependenciesDescriptionTile

  Content added
manually

Shows links to com-
munity content un-
der collapsible
headings

Expandable
Sections

 Content added
manually

Builds a list of im-
portant people for
your place

Featured
People

 Content added
manually

Builds a list of key
links for quick refer-
ence. Links can be
internal to your
community or exter-
nal URLs

Helpful Links

 Content added
manually

Displays a list of
content and places
that you can edit
and manage your-
self

Key Content
and Places

Dynamic List tiles

Wide col-
umn

Narrow col-
umn

DependenciesDescriptionTile

  Relies on an algo-
rithm

Shows the people,
places, and content
you visit most

Frequently
Viewed

  Content added
manually. Blogs
must be enabled

Shows the newest
blog posts in your
community

Latest Blog
Posts

  Relies on an algo-
rithm

Shows the people,
places, and content
you viewed recently

Recently
Viewed
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Wide col-
umn

Narrow col-
umn

DependenciesDescriptionTile

 Relies on content
being tagged

Shows places with
the same tags

Similar
Places

  Relies on a query:
click Use this view
in a tile at the bot-
tom of any People,
Places, or Content
browsing result

Shows an updated,
filtered view of con-
tent, people, or
places

Super List

 Relies on content
being tagged

Displays content
that matches specif-
ic tags

Tagged Con-
tent

  Relies on an algo-
rithm

Shows content
that's attracting
views and interac-
tions

Trending
Content *

* Content items can be excluded from the Trending Content tile. For more informa-
tion, see Removing content items from Top and Trending on page 76.

Support tiles

Wide col-
umn

Narrow col-
umn

DependenciesDescriptionTile

 Content added
manually

Build a list of useful
links for quick refer-
ence. Links can be
internal to your
community or exter-
nal URLs.

Helpful Links

  Relies on a query:
click Use this view
in a tile at the bot-
tom of any People,
Places, or Content
browsing result

Shows an updated,
filtered view of con-
tent, people, or
places

Super List
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Finding people, places, and content
Jive includes several search features to help you quickly find what you're looking
for, or just to browse through content, people, and places. You can use the topic in
this section to understand which feature best suits your searching goal.

Search and browse features
Here is an overview of Jive search and browse features. Note that as you interact
in the community, Jive keeps track of your interests and connections and
recommends relevant content, people, and places.

Clicking  opens the Spotlight search. In order to initiate the search, you need to
click on one of the suggestions or press Enter.

Figure 4: Spotlight search

Search for
something
specific by using
keywords in the
Spotlight search

For information on using it, see Using Spotlight search on page 40.
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If that is not enough, you can switch to the Advanced Search. Click Advanced
Search in the Spotlight search to open the Advanced Search page.

The Advanced Search page offers more options to refine your search than the
Spotlight search and does not apply the wildcard, as it expects you to provide all
of your detailed criteria for the most specific results. For example, here you can
limit a document search by author or search for deactivated users.

Figure 5: Advanced Search

Search for
something
specific by using
keywords in the
Advanced Search
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To see your recently viewed items, click . This opens the lists of content items,
people, and places you recently visited on the Recently Viewed tab.

Check your
recently viewed
items

Viewing your
search history • To see your latest searches, click  and then select Search History. Here you

can find the last three keywords you searched.

• To see your Jive search history, click Show all search history under the latest
searches list.

If you know something is saved in a specific place, you can limit your spotlight
search to just that place. First, go to the place. Then, type your keyword into the
search box and select click here to only show results for <this place>.

Search for
something within
a place

And in the Advanced Search, you can search both the space and its subspaces (if
any). Click Advanced Search from the search box, select a space in Restrict
results by > Place  and select the search depth under Subspace depth. You can
limit the search by the current space, its direct children, or all spaces under it in
the hierarchy.

If you know someone authored a document or par ticipated in a discussion but you
can't remember any keywords from the discussion, go to the person profile and click

Search for
someone's
content Content. From there, browse through their recent content creations and updates,

to find what you're looking for.

To find places marked with cer tain place categories, click your avatar > Your
Places > All , and then click Add Filter and select a predefined place category in
the All list.

This works only if your community manager set up place categories.

Find places by
categories

Click People in the top main navigation menu (it may be nested under the Browse
button), or in the menu under your avatar click Your Content or Your Places. On
the opened page, use the left navigation pane to refine the results by how they relate
to you. For more information on filtering, see Browse and filter content, people, and
places on page 47.

Browse and filter
content, people,
and places

You can bookmark any piece of content. You can find your most recent bookmarks
later by clicking the Spotlight search at the upper right corner, and then clicking

Bookmark useful
content and use
your bookmarks Bookmarks. To browse through all of your bookmarks, click Show all my

bookmarks. From there, you can see the bookmarks of others by clicking All in the
left sidebar.

You can assign tags that act as keywords to existing or new content to describe it
for people who might search for it later. You can also assign tags to a status update.
For more information about tagging, see Using tags on page 51.

Tag content to
make it easier to
find later

Jive includes a powerful "genius" feature that analyzes your business relationships,
expertise, and areas of interest based on your behavior in the community. It then

Use
recommendations

uses that data to recommend relevant content, people, and places that you have
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not yet seen in the community. There are several places in the interface where you
see your recommendations, but a quick way to see them is to navigate to People
(in the main navigation menu) or to Your Places or Your Content (from the menu
under your avatar). Then click Recommended in the left sidebar. For more
information about using recommendations, see Using your recommendations on
page 47.

Using Spotlight search
The Spotlight search is an easy way to find almost anything that exists in your
community. It also displays your activity history and bookmarked items. It can be

quickly accessed by using  in the upper-right corner.

Figure 6: Spotlight Search

Before you enter a keyword to search, you can see some suggestions based on
your recent activity:

• The latest content items, people, and places you viewed on the Recently Viewed
tab. Click Show all my recently viewed content to see more of your browsing
history.

• Content items, people, and places you frequently visit on the Suggestions tab.
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• Your latest searches in quick access on the Search History tab.

• Your latest bookmarks on the Bookmarks tab. For more information on using
bookmarks, see Using bookmarks on page 52.

Tip: You can disable your History and Bookmarks from being displayed in the search
by using the Don't show history or bookmarks in search option on the
Preferences page.

And you get more suggestions when you star t typing:
Figure 7: Possible search suggestions when you type relea

Here you can find details on using the Spotlight Search for the common search
tasks.

Searching content items

To star t searching, type the word, par t of the word, or a phrase you want to search
for and press Enter to initiate the search. Suggestions are displayed while you are
typing the keyword and may be a good star ting point for your search; to use one of
them, select it and press Enter.

At this point, the Spotlight search adds a wildcard (*) to the end of your search term.
This means that if you’re searching for Library of Congress and press Enter after
typing Librar, it searches for library, libraries, and other words with the same
stem, not just librar. Note that the Spotlight Search searches for tags as well as
content, people, and places.
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When searching for content items, you can narrow down the results with filters:
Figure 8: Spotlight search and filters

• With the time filter you get only items updated within the selected period of time:
click All time and select the required period. If All time is selected, then search
is not restricted by period (which is the default setting).

• With content filter, you can limit search to only cer tain content types: click All
content and select the required type (or types) from the available list. If All
content is selected, then search is not restricted by content type (which is the
default setting).

If the Spotlight search does not return the results you need, you can click Advanced
Search to see all matching results on the Advanced Search page. This page provides
more filtering options to perform a more complex and refined search. For more in-
formation, see Search rules on page 44.

Searching people

Start typing the name in the search box and check the suggestions as you type,
then press Enter to initiate the search. You can search not only by name but also
by other details, such as a user's e-mail or department.
Figure 9: Search suggestions when searching for people

A direct match is displayed as a card just under the search box. Any other results
are displayed under People (if the match is fuzzy), Content (the items that are as-
sociated with the users), and Places (the places that are associated with the users).

If you don't see the user you are searching for, you can click Advanced Search.
There you can search for a direct name match if necessary. And you can search for
deactivated users only on the Advanced Search page.
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Searching for places

Start typing the place name in the search box, then press Enter to initiate the
search. You can search also by place description or a content item you know to be
in that place.

A direct match is displayed as a card just under the search box. Any other results
are displayed under Places (if the match is fuzzy), Content (the items that are as-
sociated with the places), and People (who are associated with the places).

Using search history

The Search History tab holds your last three search keywords for quick access.
Figure 10: The Search History tab in the Spotlight Search

And clicking on Show all search history opens your search history.
Figure 11: A Search History page example

You can remove any keyword from the list by clicking .
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Search rules
You can use this search reference to get the most out of the search feature in Jive.
These rules apply to all word search features in the application.

Search for specific words

This is the most basic search mode and is also the default. Type your search terms
and press Enter to see the most relevant content, people, or places for those
specified words in any order.

Search for someone's name

Searching for people is similar to searching for specific words. Note that you can't
use phrase searching, wild cards, or field- and date-specific searching to find the
names of people in the community.

Search for phrases

If you enclose a phrase in quotes, your search returns only content where the words
in quotes occur next to each other and in the same order. For instance, specifying
black cat returns text where this phrase appears exactly as quoted, such as our
black cat brings us luck, but does not return the cat was hiding in the black
box.

Note:  Content searches are case-insensitive. For example, entering any of Jive,
jive, or JIVE returns content with any of the words jive, JIVE, or jIVe. For both
regular and phrase searches, we also match words that are very similar, but not
identical.

Search for content with words containing certain letter sequences

The wildcard character * matches any number of non-whitespace characters when
it is placed at the end of a word or within a word in the query.

You can use the following examples to search for multiplication or concatenation.
Note that Spotlight searches automatically use wildcards, even if you do not type *
in the string.

Matches content containing the words multiplication, multiple,
multimodal, multitude

mult*

Matches content containing the words contagion and concatena-
tion

con*ion

Note:  A wildcard cannot be used at the beginning of a word, and it can't be used
as a standalone word.
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Limitations in searches for certain letter sequences

The search engine splits words into subwords and performs optional transformations
on subword groups. Words are split into subwords with the following rules:

• Split on intra-word delimiters (by default, all non-alpha-numeric characters), for
example, Wi-Fi   Wi, Fi

• Split on case transitions: PowerShot   Power, Shot

• Split on letter-number transitions: SD500   SD, 500

• Leading and trailing intra-word delimiters on each subword are ignored: //hello-
--there, dude   hello, there, dude

• Trailing 's are removed for each subword: O’Neil’s   O, Neil

Based on these rules, sometimes you may not get the results you are looking for.
For example:

• If the name of an idea is Ideatest, this idea is not returned when you search for
test.

• If the name of a document is Summer0718photos, this document is returned when
you search for 0718 or photos. But it is not returned if you search for 07, or 18,
or phot.

Synonym searching

Your community may or may not support synonym searches, depending on whether
your community administrator has enabled this feature. Ask your community admin-
istrator whether synonym searches are supported in your community.

If synonym searches are enabled, your searches return results for synonyms. For
example, if you searched for search tips, the search engine would return any found
results for search tips AND find tips because search and find are synonyms.

Filtering results by date

You can filter the results to see only content items that have been updated within,
for example, the last 30 days: Select the period from the list, and enjoy the filtered
result.

The default setting is All time, which does not put any date range restriction on
your search. The other available ranges are 1 day, 7 days, 30 days, 90 days, and
1 year.

Compound expressions by using Boolean operators

The special keywords AND, OR, and NOT let you create logical expressions in your
searches. When you search, you need to use these terms in capital letters to distin-
guish them from normal words. For instance, the word And in a search is interpreted
as the word and, not the special operator AND.
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The AND operator says that the search should return content containing both the
search terms before and after the AND operator. The OR operator returns content if
either one of the terms matches. The NOT operator excludes documents that contain
(in the fields searched for) the search term after the NOT. You can't star t a search
with the NOT operator.

You can also use these operators with sub-queries enclosed in parentheses to create
more complex expressions as shown in the following examples. If you don't add an
operator to your search, search adds the AND operator between words for any type
of search.

Consider the following examples of searching for a text fragment:

Matches text containing the exact phrase quick brown fox
or the word rabbit.

"quick brown fox" OR
rabbit

Matches content containing the words quick, brown, and
fox in any order. Search implicitly assumes the AND operator
when an operator is not specified.

quick brown fox

Matches content containing both quick and brown in any
order, plus either fox or rabbit, but not containing the word

(quick brown) AND
(fox OR rabbit) AND
NOT forest forest. This example shows how you can use parentheses

to group more than one word together as a regular
(non-phrase) search and to specify the order of operations.

Note: The NOT operator can only be applied to simple terms, not compound
sub-queries, and it cannot be used inside a sub-query.

Special characters and operator words

The following characters and operator words are treated specially in the search
syntax (separated by a single space):

You can't search for these characters and operators, because the
application uses them for special search syntax. If you use these

* ( ) " AND OR
NOT

words in search text in a way that doesn't make sense to the
application, the search engine ignores them. For example, an odd
number of quote characters is ignored, and multiple asterisks next
to each other are interpreted as a single wildcard (*).

Promoted search results

You may see some results marked as Promoted when you search. These results
have been selected by an administrator to ensure that cer tain content is always
associated with one or more search keywords, even if the keyword isn't actually in
the content. For example, your site administrator may want users who type Benefits
to always see the Human Resources page as the first result, even if there are many
other pages with titles containing the word Benefits. If a result has been promoted,
you may see it again far ther down the results page.
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Using your recommendations
You can use the Jive recommendation features to find content, people, and places
you might like to follow in your streams.

Jive includes a powerful "genius" feature that analyzes your business relationships,
expertise, and areas of interest based on your behavior in the community. It then
uses that data to recommend relevant content, people, and places that you have
not yet seen in the community. The more you and others interact in the community,
the better the recommendations you receive.

Depending on how your community manager has set things up, you may see some
of these helpful tiles when cruising through your News streams:

• Recommended Content

• Recommended People

• Trending Content

• Trending People

You can also click on any of the browse menus (People, Your Places, and Your
Content), and then click the Recommended tab on the left.

Recommendations limitations

Jive recommendations obey all content permissions and do not recommend content
that you don't have permission to view. Therefore, you may not see the same
Trending Content or Trending People as others, depending on your content viewing
permissions, when you logged in, and when the last data collection occurred.

Your Recommended Content, Recommended People, Trending Content, and
Trending People all change based on your shifting interests, affinities, and even
changes in the org chart.

Excluded content

Content items can be excluded from the Recommended tab. For more information,
see Removing content items from Top and Trending on page 76.

Browse and filter content, people, and places
You can find the information you need by filtering as you browse content, people,
or places.

The People link is in the main navigation menu only, but content or places you can
star t browsing by selecting Your Content or Your Places in the menu under your
avatar.
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Using the filter keyword search

• Star t by typing a keyword in the text box and waiting for the results to refresh.

Note that every browse page includes a set of filtering tabs on the left and across
the top which lets you refine your search criteria. For example, when you browse
content, you can choose whether to browse everything or only content you authored
or par ticipated in as you can see in the following image.

The icons at the top of each browsed page let you filter by content type.

Refining your filter results by type

You can limit your view by selecting cer tain types of information. For example, you
can limit the searched content to discussions by clicking Discussions next to All
Content. You can even filter by actions or outcomes marked on content. For instance,
you can filter to see only content marked Official.

Similarly, place browsing can be narrowed to spaces, social groups, or projects.

You can use the keyword, tag, and filter options to refine your search even fur ther.
Note that tag filtering only works if the content is tagged.
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For example, here are two ways you might look for last April's East Coast sales re-
port:

• Select Your Content from the menu under your avatar, change the filter to All,
and type Sales Report in the Type to filter by text box. Then click the arrow
under "Sort by latest activity" and select Sort by date created (newest or oldest).
By default, the most recent results are shown first.

• Click People from the top navigation bar and type the Sales Director's name in
the Type to filter by text box. If you don't know her name, try typing in "Sales
Director." After you have located the person, click their name, and go to the
Content tab. From there, select Authored from the left-hand menu and Docu-
ments from the top menu to show only the documents she wrote. You can filter
these fur ther by keyword or tag if she's an especially productive content creator.

Making things easier to find
You can rely on these best practices to make things easier to find for yourself and
others.

To help yourself and other people find the content that you create, try the following:

• Put the content in a place where it's likely to be discovered. For example, put it
in a group that's open-access and of interest to your audience to attract the notice
of community members who follow that group. Before you publish new content in
a place, you can see how many people are following the place, and (if it's a group)
how many are members.

• Bookmark content so that you and others can find it by browsing bookmarked
items. For more information, see Using bookmarks on page 52.

• Apply tags to the content or add them in the body of the content by using the #,
which is a hash or pound sign, and following it with the tag phrase, such as
#tagging_this. Tags give other people a way to find things based on the ways
your community thinks about them. You can follow tags in your streams. For more
information about tags, see Using tags on page 51 and Following tags on page
52.

• As you collaborate on content, make sure you mark it appropriately. For example,
if someone answers your question, mark the answer as Correct. If a document
reaches a final state, mark it Final or Official. Other people can see these
outcomes and use them to filter results when searching and browsing.

• You can make yourself easier to find by adding information to your profile that
other people might be interested in. You can add your experiences to your
expertise list. For more information about profiles, see Setting up your profile.
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Labeling people to manage them around community
You can name and color code groups of people to make them easier to find when
you browse or communicate with people as a group.

You can create labels to group your friends or connections, the people you follow.
You might use this to group people from a cer tain location together. For example,
if you have a New York office in your company, you can create a New York label.
This helps you find people fast when you have a lot of connections. When you apply
a label to multiple friends or connections, the label becomes a way to show only
those with cer tain labels. Additionally, you can type the label name in when you're
creating a direct message or adding collaborators on a document to automatically
include all the people with that label.

To create a label:

1. Browse your friends or connections by clicking People  and selecting Following
on the left.

Note: You can only group and label people you're following.

2. Click Create Label  in the left pane.

3. Select a color, type the name for the label.

4. Click Save .

5. Add someone to that new label group by clicking the gear icon on their profile
card, and then clicking Label People.

6. Select the label that you want to apply to the person.

You can remove the label by clicking it again to deselect it.

7. If you want to delete a label group later, click Browse > Following , and then
click the Delete label icon that shows up when you hover the mouse over the
label.

Role badges
If your community administrator has activated role badges, then you can see small
icons next to cer tain community user names.

A role badge is an icon used to indicate the roles or responsibilities of community
users. You might use this to find someone who can answer a question or identify
people whose answers you can count on. Hover your mouse over the icon to see
the name of the role.

Here's a list of possible roles for the badges:

• Administrator

• Champion

• Employee
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• Expert

• Moderator

• Support

Using tags
Tags are keywords that you and others assign to content. Assigning tags to your
content makes it easier for you and others to find later.

You can assign tags to new or existing content.

Tagging a status update

• To tag a status update, type # followed by your tag.

For example, a status update of "Really enjoying that amazing #presentation about
#XYZ customer" shows up in search results for "presentation" and "XYZ."

Tagging content

You can add tags when you create content: Enter tags
into Tags before you Post or Update.

Adding tags when
creating or editing
content

To add tags to existing content, click Edit Tags at the
bottom of the content editor and add your tags. Then
click anywhere outside of the field to save.

Adding tags to
published content

You can also add tags on-the-fly as you're editing
content. To do this, type # (or click # Tag) followed by
your tag phrase into the content editor.

Adding tags in the
content editor

For example, if you're writing about your competitor's
new corporate branding, you could say, "Company X is
resorting to Comic Sans. #jumpingtheshark."

Tips for tagging

• Consider using any existing tags that appear in the suggestion box. Existing tags
are often assigned to related content, so it's good practice to use them.

• Use an underscore between words, such as sales_report or employee_benefits.

Note:  If you are tagging content that is being moderated by an admin, your tags
may not show up right away because content updates may need to be approved.
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Following tags
You can follow tags to discover new areas where you can become involved and stay
informed.

Tags can generate more participation and collaboration by helping people find your
content. Create custom streams that include people, places, and tags so you can
fine-tune the stream's content. Following tags in custom streams helps bring you
relevant information from uncommon sources.

For example, if you're in the accounting department, you can add the VP of Finance
and the Accounting Group to your Accounting stream. But also think about adding
tags like #money, #pay, #taxes to direct content into your stream that you don't
normally come across. For more information, see Creating custom streams on page
19 and Examples of custom streams on page 20.

To follow a tag:

1. Create a custom stream.

2. Search for relevant terms.

3. Click Tags to see all tags that relate to that search term.

4. Click Add to include tags in your stream.

Note: When you follow a tag, only content that's been tagged with that tag sometime
in the previous 180 days shows up in your custom stream.

Using bookmarks
Bookmarks help you keep track of your favorite content over long periods of time.
You can bookmark content inside or outside of your community.

You can bookmark any content in the community, and sites outside of the community.
When you want to look at that content again later, you can go to it quickly by clicking
in the search box at the top of any page and selecting Bookmarks.

You can see a list of your recent bookmarks. Clicking Show all bookmarks at the
bottom of the list lets you toggle between a complete list of your bookmarks – Your
– and public bookmarks from everyone in the community – All.

Note: You won't see bookmarks created for content that you can't access, such as
documents in a private group.

Bookmarking content inside your community

To bookmark content stored inside your community:

• Go to the content item, and then click Bookmark in the right menu.

Created bookmarks have corresponding titles to easily be located for later use.
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Bookmarking sites outside of your community (external bookmarks)

Note: To enable external bookmarks, you need to file a support ticket with Support.
For more information, see Getting star ted with the new Jive Support Portal on Worx.

To bookmark sites outside of your community, you need to add the bookmarklet tool
to your web browser. The bookmarklet tool allows you to bookmark external sites
and bring them inside your community.

To install the bookmarklet tool:

1. Click Spotlight search, and then select Bookmarks > Show all bookmarks .

2. Under Install Bookmarklet in the left pane, click Click to install.

3. Drag the Add Site button onto your browser's toolbar.

To bookmark a site outside the community:

• Click Add site to community in your browser's toolbar and then add your notes
and tags.

You can use the bookmarklet link to bookmark any content as you browse the Web.
In other words, you don't need to be using Jive to save and share bookmarks in
your Jive community.

You might also be interested in learning about Jive Anywhere, which allows you to
socialize things in your Jive community that you've found on the Web or even in
other applications. Your community may not include this additional module by default.
For more information, see the Jive Anywhere Help.

Can't remember people, place, or title?
Sometimes you can't remember the title, people, or place of something you know
you saw. In that case, try this search method.

For example, you remember par ticipating in a discussion during the last three months
about how to increase customer survey participation, but you can't remember exactly
the discussion title. Or maybe that was not a discussion, but a blog post?

Click  at the upper right and type in keywords, such as customer survey. Click
All content and select Discussions and Blog posts under the search box because
you don't need to see results from documents or polls or ideas. Then click All time
and select 90 days to get only items updated within the last three months.

If you get too many results, you can try clicking Advanced Search (this opens the
Advanced Search page) and narrowing the results even more: by a possible author
or a likely place.
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Using social groups
Social groups help you bring people together around shared interests, ideas, and
projects. Here you can find how to create and manage social groups in Jive.

Groups, or social groups, are isolated containers within a community; they have no
ties to other places and cannot have sub-groups. Permissions are managed on a
per-group basis by the original group creator or the admins selected for the group,
or both. Groups can also house any type of content unless one or more is turned
off by community administrators. Because they are a freely created containers,
groups get used most often for topic-specific collaboration, rather than something
general to a team. They also get used for collaboration between specific teams or
different departments that often work together closely and rely on each other.

Creating groups
Creating a group enables you to set up an area where like-minded people can put
their heads together and share information on the group subject. You must have
special permissions to create a group, which are set by your community administrator.

Before you create a group, you may want to consider the purpose of the group, what
kind of information needs to be included, who will par ticipate, and how people who
need to know about it will find it. The way you name the group and the tags you
assign to it are different ways you can make it available to people who might be in-
terested in the group. For more information, see Group creation options on page
56.

Important: You can change the group URL when you are creating a group. You
won't be able to change the URL after you create the group.

By default, groups use Activity pages with tiles as landing pages.

To create a group:

1. Click  > Group  in the main navigation menu.

This opens the Create Group dialog box.

2. In Name, enter the name of the group.

The group name must be unique within the community. This name shows up at
the top of the group page and at the end of the URL that links to the group. Also,
it should be identifying the group within the community.

3. If required, in URL, change the group URL.

You can use this option to make a short URL for your group. The group URL must
be unique within the community.

4. In Description, enter a brief description to appear in the group's main page.
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You should add information on what the group is about in a way that attracts other
people who might be interested in the group. For example, your RFP Collaboration
group could say "Look for the latest RFP templates and materials here."

Note: This information is displayed behind the information icon  and on the
Overview page if the group uses one.

5. Under Group Type, choose a group type.

You can granularly restrict access for viewing and editing content. For more
information, see Types of groups on page 60.

6. In Tags, enter tags that can be used to find this group. To enter multiple tags,
press Enter after each word or phrase.

Tags are words or short phrases that help other people find your group. For
example, a Sales group might use the following tags: RFPs, sales_videos, and
wins.

7. In Categories, select the place categories to associate with the place.

The place categories are used to identify places while browsing. They are used
to classify places and differ from content categories. This option is available if
place categories are configured in your community.

8. If required, click Advanced options to expose more options and specify the
following:

• Overview page: Specify whether you want to use a widget-based Overview
page. This option may be not available in your community. For more information,
see Adding Overview page.

Important: We do not recommend that you use widgets and widgetized
Overview pages (including the Home page) in your community. For more
information, see Understanding pages in places.

• Locale: Select your default language for the group. The group also uses the
time zone and date format commonly used in this region.

By default, your place uses an Activity page as its main page, with the option to
add more custom pages. We recommend using an Activity page because it can
be displayed on mobile devices and because it's more friendly to streaming
content. If widgets are enabled in your community (not common), you may want
to include an Overview page with widgets.

9. Click Create Group.

10.If required, in the Invite People to Join dialog box, add users who you want to
invite to the group, and then click Send Invitation.

You only see this option for Private and secret (Private: Unlisted) groups.
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The group is created, and the main page opens for your view. Now you can customize
the group, as described in Customizing your group on page 57.

Group creation options
Creating a group always star ts with clicking Group in the Create menu, but it helps
to understand the options that can help your group do what you want it to.

Group landing page

By default, the Activity page is used as the main group page. It uses tiles to present
information. In some cases, you can also enable the Overview page that uses widgets
instead of tiles.

Advanced group creation options

In the following table, the asterisks (*) note when this advanced option for place
navigation might be unavailable. For more information on differences between Ac-
tivity and Overview pages, see Understanding pages in places.

Important: We do not recommend that you use widgets and widgetized Overview
pages (including the Home page) in your community. For more information, see
Understanding pages in places.

Can I change this later?I should. . .I want to. . .

Yes. Note that changing
this setting changes the
visibility setting for all the
group's content.

Choose a Private or Private:
Unlisted (also known as Se-
cret) group type during the
initial setup. You can change
this setting later. For more
information, see Types of
groups on page 60.

Collaborate in private by
limiting who can see
what's in my group, or
even who can see that
my group exists.

Yes.Create a group, then for the
Activity page choose and
configure a Place Template
customized for the kind of
work you want to do. For
more information, see Place
Templates for designing ac-
tivity and custom pages for
places. Place Templates only
apply to Activity pages.

Design a landing page
that's optimized for a
specific work purpose.

Yes.Select the Overview page
check box under the Ad-
vanced Options during set-
up, and fill out a widget lay-
out under gear icon >
Overview Page  from the
group page. For more infor-
mation, see Designing
Overview pages for places.

Design a landing page
with widgets*
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Can I change this later?I should. . .I want to. . .

Yes.Create the group, and then
add the pages to your place
afterward. See Adding cus-
tom pages to places.

Make more custom pages
in the place for displaying
information, not just a
landing page.

Yes, but keep in mind that
some external stream
types cannot be disconnect-
ed from the group except
via a Support call.

Create the group, then click
Add a stream integration
when configuring the Activity
page. For more information,
see Adding tiles with external
stream integrations to Activi-
ty page.

Integrate external
streams from Facebook,
Chatter, or any other
apps your community ad-
min has enabled.*

Yes.During place setup, after you
preview the group, edit the
Activity page.

Limit the kinds of content
that can be included in
this place.

Yes, but if the place is lat-
er disconnected from exter-
nal storage, users will see
references to documents
that they can't access from
Jive anymore.

During place setup, after you
preview the topic, edit the
Activity page. External file
storage is available if at least
one storage provider has
been set up by community
administrators. For more in-
formation, see Using external
file storage.

Store the place binary
documents outside Jive,
for example, in Box or
SharePoint.

Yes. Changing the External-
ly Accessible setting will
remove access by non-
members, but their contri-
butions will stay in the
group.

Make the group Private or
Private: Unlisted, and select
Externally Accessible. For
more information, see Exter-
nal groups overview on page
192

Make this group a place
for collaborating with
people who aren't mem-
bers of the community.

Yes. Just remove or re-
place the tags or place
categories.

Add tags and place cate-
gories to your place in the
place settings.

Make sure people can
find the place.

Customizing your group
After you create a group, you can change it to suit your requirements.

• You can apply a place template to quickly populate the tiles on the Activity page
of your group. The default template is Team Collaboration. For more information,
see Applying place templates and General place template reference.

• You can change the place image or the banner to configure the visual presentation
of your place. For the detailed procedure, see Customizing the group landing
page on page 58.

• To enable features, click Gear icon > Configure activity page . Click the Edit
icon for the Enabled Features and Content Type tile. When it opens, you can
select the types of content that your group will use. This list also controls what
shows in the Content tab of the group, as well as what content types you can use
to filter the Content tab.
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• To set up external storage, click Gear icon > Configure activity page , and
then click External Stream Integration. When it opens, you can select where
the files in this group will be stored.

If your administrator has enabled a connection with an external storage provider
such as Box, Dropbox, SharePoint, or Google Drive, you can set your group to
synchronize document storage to that provider. Files that are uploaded to the
group will be stored in external storage, rather than in Jive, and files can be
added, deleted, or modified from either side.

Note:  For Box users: Although you can connect an open group to a Box folder,
only community members who have joined the group can see Box documents and
have their comments reflected on the Box side. Because of this limitation, it's
recommended to use the Box external storage only with Members Only (Public:
Restricted), Private, or Secret (Private: Unlisted) Groups.

Customizing the group landing page
If you're a group owner or administrator, you can customize your group's landing
page so that it displays the information and images that you want visitors to see.

Adding a banner and logo

To add a group logo and change the group banner to help brand your group's landing
page:

1. Go to the landing page for your place and click the Gear icon > Settings .

Note: The Edit page will appear. You can make changes to this information now
if you want, but it's not required right now.

2. Click OK

3. Click Edit Banner to customize the header.

4. Click the camera icon to select a new image to the header.

5. Click Save.

Adding tiles or widgets to customize the page layout

• If you chose an Activity page, add tiles and external stream integrations, as
described in Adding tiles with external stream integrations to Activity page.

Tip: To make it even easier, assign a place template to get an Activity page with
pre-configured tiles and layout, as described in Applying place templates.

• If you chose an Overview page, change the layout of your widgets, as described
in Setting up Overview page.
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Important: We do not recommend that you use widgets and widgetized Overview
pages (including the Home page) in your community. For more information, see
Understanding pages in places.

Further customizing your landing page and making it express your group's
purpose

• If you chose a tile-based Activity page, see Place Templates for designing activity
and custom pages for places for more details about how to use it effectively.

• If you chose a widget-based Overview page, see Designing Overview pages for
places for more information.

Important: We do not recommend that you use widgets and widgetized Overview
pages (including the Home page) in your community. For more information, see
Understanding pages in places.

Adding Overview page
When widgets are enabled in your community, you can add an Overview page to a
place. Overview pages are based on widgets while other pages, such as Activity
and custom pages are based on tiles. Please note that tiles provide a better user
experience and perform better, especially on mobile devices.

Important: We do not recommend that you use widgets and widgetized Overview
pages (including the Home page) in your community. For more information, see
Understanding pages in places.

You can have Activity, Overview, and custom pages enabled for your place. The
leftmost page in the place navigation menu becomes the landing page of your place.
For more information about changing the order of items in the menu, see Managing
page navigation in places.

Tip:  If you use the checkpoint and status functionality for tracking project tasks,
you may want to stick with the old-style Overview page rather than updating to the
Place Template format. The widgets in the Overview page more effectively support
Projects at this time.

For more information about Overview pages, see Designing Overview pages for
places.

Adding an Overview Page to a place

To use an Overview page in your place:

1. Go to the landing page for your place and click the Gear icon > Settings . The
Edit Group page opens.

2. Click Advanced Options .
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3. Select the Overview page check box.

Note: When widgets are enabled, you can use an Overview page in addition to
an Activity page. By default, the Overview page is set as the landing page for the
place. You can change this by using page navigation, as described in Managing
page navigation in places.

4. Click OK.

5. Click Save at the bottom of the page.

The Overview page is added to your place and becomes visible to other users.

Types of groups
A group's type determines who can join, see content, par ticipate, and invite new
members.

Unlike spaces, which use permissions to determine access, social groups rely pri-
marily on membership to determine access. Because groups do not exist inside
spaces, they do not inherit any space permissions. Note that group owners and
community managers can change the settings for a group after it is created.

Use the following tables to help you understand the different types of groups that
can be created in the community. Most communities use the group scheme in the
first table: if your community has enabled Group Membership Evolution, you'll see
Public and Private as the main group types and should use the second table.

If you have Members Only and Secret Groups

OpenMembers OnlyPrivateSecret

All (no member-
ship)

AllGroup name
only

NoneWhat is visible
to non-mem-
bers?

AnyoneAnyoneMemberMemberWho can see
content?

AnyoneAnyone can in-
teract with con-
tent and create
discussions and
questions. Only
members can
create other
content types

MemberMemberWho can partici-
pate?

AnyoneMember or ad-
ministrator

Member or ad-
ministrator

Member or ad-
ministrator

Who can invite
new members?

No membershipNo membershipAdministratorAdministratorWho can ap-
prove new
members?
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If you have Public and Private Unlisted groups

PublicPublic Restrict-
ed

PrivatePrivate Unlist-
ed

All (no member-
ship)

AllGroup name
only

NoneWhat is visible
to non-mem-
bers?

AnyoneAnyoneMemberMemberWho can see
content?

AnyoneAnyone can in-
teract with con-
tent and create
discussions and
questions. Only
members can
create other
content types

MemberMemberWho can partici-
pate?

AnyoneMember or ad-
ministrator

Member or ad-
ministrator

Member or ad-
ministrator

Who can invite
new members?

No membershipNo membershipAdministratorAdministratorWho can ap-
prove new
members?

Inviting people to join groups
As a group administrator or member, you can invite people to join the group. Note
that if you're using Jive as an internal corporate community, people from outside
the community might not be able to join your group.

You can find out about group members as follows:

Click  on the group's landing page.
Count of members (and follow-
ers)

Click on the Followers and Members links to
be directed to the group's People page.

Who are members (or followers)

Any group member can invite any other user to join a group. If the group is public,
then you can share the group with non-members. If the group is private or secret
(also known as Private: Unlisted), the invited user must accept the invitation. A
group administrator must then approve the request to join the group. If it was a
group administrator who originally sent the invitation to the private or secret group,
the approval is automatic. For more information on how a group's type affects the
content visibility, par ticipation, and invitation permissions for group members, see
Types of Groups.

To invite people to join your group:

1. Go to your group and select Actions > Invite members .

2. In the Invite People dialog box, enter the Jive user names or email addresses
of people you want to invite. If you can't remember them, you can do two types
of searches:
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• To invite several people from your email address book, browse your contacts
by clicking the browse icon. Select the people you want to invite, and then click
Add selected people.

Note: You can also paste in a comma-, space-, or semicolon-separated list of
addresses exported from your email application.

• To invite only those with cer tain skills, click Search by skill to browse people
by their skills. Type in the skill you are looking for, or select a popular one.
Select the people you want to invite, and then click Add selected people.

3. Under Include a personal note, edit the message you want potential group
members to see with their invitation.

4. Click Send Invitation .

The invitations are sent to the persons you specified.

Managing pending invitations
As a group administrator, you can delete or resend invitations while managing group
membership. This can be useful if you've got a lot of outstanding unanswered
invitations.

To resend or delete invitations to the group:

1. Go to your group and select Gear icon > Members .

2. On the Manage group members page, click Open Invitations to view the pending
invitations.

3. To delete pending invitations, select the invitations, and then click Delete
Invitation in the tab menu.

4. To send invitations one more time, select the invitations, and then click Resend
Invitation in the tab menu.

Posting status update in groups
There may be times you want to limit your status update to only a specific group in
your community. When you post a status update to a group, only members and
people following the group see the update in their attention streams.

The status updates are displayed in the Trending Content tiles. If your group has
an Activity page that includes the Recent Activity tile, the status update is displayed
there as well. Note that you can exclude the status update from the Trending Content
tiles and the Top & Trending lists in the News streams; for more information, see
Removing content items from Top and Trending on page 76.

To post a status update for a group:

1. You can create a group update from either the News page or the group's Activity
page.
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Note:  Some groups do not use Activity pages.

• Activity Page: Go to the Activity page for the group where you want the status
update to display.

• News: Under All Activity, click Change next to your community name, and
then select or type the name of the group from the group picker.

2. Type your status update in the What's going on? box next to your avatar.

3. Click Post.

Enabling non-member content sharing
Private group owners can configure their private group so that group members can
share specific documents and discussions with non-group members. This allows
non-group members to help review or edit private group content but does not allow
them to see any other content items that live in the group.

To enable this feature, your community manager first needs to enable non-member
content editing for private groups in your community. For more information, see
Managing external groups in the Community Administrator Guide.

You must be the group owner or administrator to enable non-member content editing.

To enable non-member content editing in a private group:

1. Go to the private group, and then click gear icon > Settings .

2. Click the pencil icon next to the group's name in the header.

3. Under Group Type, make sure that group type is set to Private.

4. Select the Content Editing by Non-Members check box.

If you don't see this option, you need to ask your community manager to enable
non-member content editing in private groups.

5. Click OK, and then Save your changes.

Documents, discussions, questions, and uploaded files in a private group can be
shared with the users who are not members of the group. For more information, see
Sharing content with non-group members  on page 63.

Sharing content with non-group members
Documents, discussions, questions, and uploaded files in a private group can be
shared with the users who are not members of the group. This is useful if you need
a non-group member to help you review and edit a document or discussion.

Content sharing options
Non-member content sharing must be allowed for the group. The group owner or
community administrator may need to enable this feature for you, depending on how
your community is set up. For more information, see Enabling non-member content
sharing on page 63.
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With the feature enabled, you can share documents, discussions, questions, and
uploaded files (when they are stored within the group). Besides, you can choose
both community members and people outside of the community as recipients.

A content item can be shared as follows:

• PDF export: The selected content item is converted to PDF with comments included
and sent by email.
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• Co-authoring: The selected content item is made accessible to a community user
for viewing and editing. The user effectively becomes a co-author of the content
item.
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Note: You can't share files that are stored in external storage, such as Google
Drive.

How you can share a content item depends on whether you can edit this item or
not.
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And the recipient is...

If you are... not a community
member

a community mem-
ber but not a

group member

• PDF export• PDF export
Group member and cannot edit the con-
tent item

• PDF export• PDF export

• Co-authoring

Group member and can edit the content
item

• PDF export• PDF export
Group owner and cannot edit the content
item

• PDF export• PDF export

• Co-authoring

Group owner and can edit the content
item

• PDF export• PDF export
Community administrator with the Man-
age Social Group permissions

• PDF export• PDF export

• Co-authoring

Community administrator with the Full
Access permissions

Note that in groups, documents and files can be co-authored by all group members,
and both methods can be used for sharing. But questions and discussions can be
co-authored only by their authors, other group members can share them only as
PDFs.

Sharing with non-group members
To share a document or discussion with a non-group member:

1. Go to the content item that you want to share.

2. Click Share in the menu.

3. Enter the name or email of the person with whom you want to share the item.

The user is added in a red box under the search box, and a notification with the
sharing details is displayed.

4. If you have a choice for sharing, select one of the following and then click OK.

• Grant this user access to this content only: Grants the selected user access
for viewing and editing to the selected content item. The user becomes a
co-author of the content item.

• Email this user a PDF of this content: Converts the content item with
comments to PDF and sends it to the selected user.

5. Under Message, type a note for the person.

6. Click Share.
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You can see a green bar at the bottom of the screen letting you know the share was
successful. You can also see an orange icon at the top that lets you know the item
is visible to non-group members. You can click the provided link to see which non-
group members the content item has been shared with.

Sharing content with other places
To make using the community easier for people who tend to focus on cer tain groups,
spaces, or projects, you can share your content with their place even if you initially
post it in another place. When you share content with a place, it shows

up in that place's activity stream. Anyone following the place where the
content is shared receives a notification in the stream.

People who don't have access to the original content can not have access to the
shared one either. For example, you post a Contact List document in the Human
Resources group, and some Engineering managers have access to the Human Re-
sources group, but they spend most of their time in their Engineering group. You
could share the document with the Engineering group, which is open, and know that
only the managers can search for and view the Contacts List document.

This feature is turned on by default in internal-facing communities.

To share content with multiple places:

1. Go to the piece of content you want to share, such as a document, blog post, or
discussion.

2. Click Share in the menu.

3. Enter the name of the place you want to share the item with, or use the place
picker to navigate to and select the place.

4. If required, add more places.

5. Type a note about the share in the Message box.

6. Click Share.

At the top, you can see the places it has been shared with so you can keep track.
You can click the x other places link to see which other places the item has been
shared with.

Making bulk changes to content in places
You can make bulk changes to content items stored in a place, including applying
tags, categories, and outcomes. Also, you can move or delete a list of items. This
can be a quick and easy way to organize the content in a place better so that you
and others can find it faster later.

You need to be the place owner or have the Manage Community permissions to
make bulk changes in the place.

To make changes to content in bulk:

1. Go to the place you own and click the Gear icon > Bulk manage content .

2. On the Bulk manage content, select the content items to which you want to apply
the changes.
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3. Click an action icon in the menu above the item list. You can do one of the
following:

DescriptionOptions

Applies the same tags to all of the selected items.Add tags

Applies the same categories to all of the selected items.
You won't be able to select this if categories are not set
up in your community.

Add categories

Applies the same outcomes, such as Outdated or Final,
to all of the selected items.

Set outcomes

Moves all of the selected items to the new place you
choose.

Move

Deletes all of the selected items.Delete

4. In the dialog box, review the list of items. If necessary, click Remove next to an
item to remove the item from the list.

5. Click Continue. You may need to click another Continue depending on the option
you selected.

6. Depending on the selected action, specify the settings or once again review the
issue list.

7. Click Continue.

The selected action is performed, and the results are displayed in the dialog box.

8. Click Close to close the dialog box.

Groups with external file storage
If your administrator has connected your community with an external storage provider
such as Box, SharePoint, or Google Drive, you can take advantage of file storage
and synchronization for groups where this is enabled.

Typically, the default is a binary storage archive on a server that's par t of your Jive
installation. When you create a group, you may have the option to connect it to a
different storage provider than the default configured when your community was set
up. Using external file storage means that when a user uploads a document, it's
stored with a third-party file storage service instead of directly in Jive. Files can
then be automatically synchronized in both directions, which means you can add or
update them from either side. If the storage provider has comment functionality,
comments are also synchronized with comments in the group.

Note:  Attachments to Jive are not stored in external storage.
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Groups with Box Storage
If your administrator has connected your community with a Box.com file store, you
can take advantage of file storage and synchronization with Box for groups where
this is enabled.

When a user uploads a document, it's stored in Box instead of the regularly config-
ured binary storage location. Files are automatically synchronized in both directions,
and so are comments and replies, so that users can interact from either the Jive
side or the Box side.

Attention:  Attachments are not stored in Box.

To take full advantage of the linkage, users should join the Box-linked group. This
allows users to interact with Box-linked content under their own user accounts and
synchronize comments correctly to the Box side. Otherwise, their interactions will
be posted by a system user called the Jive Integration User, and their comments
will not be visible on the Box side.

Note:  Although you can connect an open group to a Box folder, only community
members who have joined the group are able to see Box documents and have their
comments reflected on the Box side. Because of this limitation, it's recommended
to use the Box external storage only with Members Only (also known as Public:
Restricted), Private, or Secret (also known as Private: Unlisted) Groups.

For more information, see Box.com Integration in the More Integrations Guide.

Modifying files in Box

Files can be modified on the Box side by any user who has a Jive account and rights
to the group-linked folder in Box. In addition, file comments made in Box are syn-
chronized and displayed in the Jive group.

Note: There is a known limitation for files that have been deleted from Box, and
then restored on the Box side. Restored files are not synchronized to Jive when
they are restored. However, uploading a new version of the file to the Box side
re-adds the restored version and adds the new version at the same time, resulting
in two added files. Re-adding the file from the Jive side initially return a generic
error, but the second upload attempt succeeds.
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Groups with SharePoint storage
If your administrator has connected your community with a SharePoint storage site,
you can take advantage of file storage and synchronization with SharePoint for
groups where this is enabled.

When a user uploads a document, it's stored in a SharePoint site instead of the
regularly configured binary storage location. Files are automatically synchronized
in both directions, as well as comments and replies, so that users can interact from
either the Jive side or the SharePoint side. Users can also search inside the
SharePoint site without leaving Jive.

For more information, see the Jive for SharePoint 2010 Help or the Jive for Share-
Point 2013/2016 (v5) Help depending on SharePoint installation type.

Groups with Google Drive storage
If your administrator has connected your community to a Google Drive storage site,
you can take advantage of file storage and synchronization with Drive for groups
where this is enabled.

When a user uploads a document, it's stored in Google Drive instead of the regularly
configured binary storage location. Files are automatically synchronized in both di-
rections.

For more information, see Google Drive Integration in the More Integrations Guide.

Note:  One more option for integration with Google allows users to works with Google
documents directly from Jive. For more information, see the Google Drive Files and
Docs Help.

Using content
Content takes up the major par t of Jive, so learning to create, promote, and manage
it effectively is a cornerstone of Jive collaboration.

Creating content
You can create items of the types available in your community. You should choose
a content type based on your collaborative goals.

To create a content item:

• Click , and then select the content type of the item.
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For example, you can draft a discussion, question, document, or blog post.

Note: You may not see the Create menu ( ) if your community manager disabled
the feature.

Most collaborative activities occur in discussions, questions, and documents. Blog
posts are typically used for viewpoint essays and other long-form communications
that don't invite collaboration. For a more detailed analysis of the differences between
these types of content, see Differences between documents, blog posts, and discus-
sions on page 80.

Private and public content

By default, the content you create is public in the community and searchable. The
power of a community is that everyone in the community can benefit from shared
content. However, in some cases, you may want to limit who sees content and who
can collaborate on it with you. For more information about deciding who can see
and collaborate on your documents, see Using documents on page 90. For more
information about private discussions, see Using discussions and questions on page
87. You can also choose to publish your content in a private social group that limits
content to approved members.

For more information about private and public content, see Public and private
communications on page 182.

Monitoring your content

You automatically follow all content that you create, so you receive an update noti-
fication in your Inbox whenever anyone responds to your content or changes it. This
notification is updated whenever you or another user edit or comment on the content,
or make another notable action. Note that if it is you who made the action, the noti-
fication is marked as read. And if the item has been updated by another user the
notification is marked as unread, to attract your attention. If you have the Unread
Only option selected, you will see only notifications about actions of other users.
And if you do not want to receive notifications about this content item, click Hide
new activity in the lower pane.

Note that you can delete any comments on your content if required.

For more information about Inbox, see Tips for using Inbox.

Updating or deleting your content

You can update any content item you created, as well as delete the content entirely.

Using content editor
When you create or edit content, such as writing and formatting text, creating tables,
embedding images and videos, and inserting links, you use the content editor built
into Jive.

The editor includes many of the standard features of other word processing programs.
You can access them by using either the icons in the interface or keyboard shortcuts.
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Here are some features of the content editor you may want to explore.

In-line @mentioning

To @mention someone while you are typing in the content editor:

1. Type the @ symbol (or click the @ button if it is available). A search dialog opens
and suggests possible matches.

2. To narrow matches, use an underscore (_) as a space. For example, @Mike_D
would match the Mikes whose last name begins with D.

3. Select the correct match from the list and note the new link in the content editor.

For more information about @mentioning, see Aler ts for people, places, and content
items.

Adding table of contents

The content editor includes a feature that automatically generates a hierarchical
table of contents based on the headings in your content. When you insert the table
of contents, the editor looks at the headings your content uses, including their levels
(such as Heading 2 or Heading 3). Based on the heading levels, the editor creates
links to the headings, indenting the links at similar levels.

• To insert the table of contents, click More > Table of contents .

While you're editing the content, the table of contents appears as an icon, as dis-
played in the screenshot below.

In the saved or published version of the content, the icon is replaced with a hierar-
chical list of links to headings in your content.
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Working with tables

The content editor table feature allows you to create and manipulate tables.

• To create a new table, click  > Insert table  and select the number of rows
and columns you want.

• To add, remove, or duplicate rows and columns, use the table menu to the right

of the table or the  menu.

• To move around rows and columns, mouse over  and drag them as required.

• To merge cells, select the cells, then click  > Cell > Merge cells .

• To delete a table, click  > Delete table . The table is deleted.

• To format individual cells, rows, or columns, click  and then select the element
whose properties you want to configure.

You can designate and format headers, change the color of text, lines, and back-
ground, and customize many other settings. Note that when you change the header
setting while making changes in a column, only the header for that column changes,
not all of the headers.

In addition, changing the color of text in properties changes the default text color
setting for the selected cell, row, column, or table itself. To make text color changes
that you don't want to apply as a default to the cell, row, or column, use the text
color icon in the editor's toolbar.

When you are finished formatting your table, simply click away from it and continue
editing your document.

Using the spellchecker

The content editor includes a spellchecker that you turn on when you want to check

the spelling. When you're ready to check the spelling in your document, click .
Misspelled words are underlined in red. You should click a misspelled word to view
suggested alternate spellings and scroll down to select the best match.

Note that the spellchecker does not check spelling as you type. You must turn it on
or off by clicking the spellchecker button. After you have made corrections, click
the button again to recheck spelling.

Also, you can change the language used for spell checking by clicking the down

arrow at the right side of .

Viewing code source for content

The content editor's Source Code feature allows you to edit your document in HTML.
Click the < > link in the editor's toolbar when you want to write directly in HTML.
When you're finished, you can toggle back to the default editor view by clicking OK.
Clicking Cancel returns you to the content editor without making changes.
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Some kinds of HTML markup can cause the site to be less secure. For this reason,
cer tain HTML tags aren't supported by default. When you use these tags, Jive re-
moves them before displaying the content. You can include them, and they are
saved, but they don't render when someone views your content. Here's a list of
what's not supported:

Tags: <embed>, <html>, <head>, <iframe>, <link>, <meta>, <object>, <script>,
<style>

Attributes: action, class, method, on* (such as onClick), *src*

Using code syntax highlighter

The content editor's Syntax Highlighter feature allows you to mark text as code and
specify the language so that it renders correctly in the saved and published versions
of your document, blog post, or other content. This is useful to show code examples
in your documentation. Supported code styles are Java, JavaScript, SQL, HTML/XML,
CSS, PHP, Ruby, Python, C, C#, and C++.

• To apply the code formatting, click the More > Syntax Highlighter . The
Insert/Edit code sample dialog box open where you can select the
language-specific formatting and enter the code snippet. After you finish editing,
click Ok.

Here are a few code examples.

Working with links

When pasting internal URL in the default content editor, title will be automatically
generated for that link. To include URL without having it automatically titled, use
the Insert URL option. This way, the URL will be classified as independent link
which you can modify to have its own title.
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Removing content items from Top and Trending
If you do not want your blog post (or other content items) feature in the trending
lists of your community, you can remove this post from the global lists.

Jive uses the Recommender service analyzes content and people over a period of
time and uses that data to display the top and trending lists. The Recommender
counts the things users do (create content, follow people, join groups, etc.) and,
importantly, how users interact with each other's contributions. For example, users
liking another user's content, marking answers helpful or correct, and viewing content
all count toward the trending status of a user or a piece of content. The Recom-
mender weights the various counts in its equations, and then creates a list of users
and content with the highest trending counts over a given time period.

The Recommender works globally for the whole community but some point you may
want to remove your content items from the trending lists. If you use this option,
your content items will not be displayed in:

• In the Top & Trending list in the News streams.

• On the Recommended tabs when you browse content (/content?filterID=rec-
ommended).

• In the Trending Content tiles.

• In the Trending Now section of newsletter emails.

You can hide items of the following content types:

• Status updates

• Discussions

• Questions

• Blog posts

• Documents

• Uploaded files

• Polls

• Events

• Ideas

Content authors and users with the Manage Users, Manage Community, Manage
System, or Full Access permissions can remove a content item from Top and
Trending lists.

To remove a content item from Top and Trending lists

1. Go to the content item.

2. Click Actions > Remove from Top & Trending .

To add a content item to Top and Trending lists

1. Go to the content item.

2. Click Actions > Allow in Top & Trending .
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Earning status points
When you create or respond to content in Jive, you earn status points in the
community.

The success of the community depends on your contributions, so you are rewarded
with points for getting involved. Over time, you develop a reputation for reliability
and authority in your favorite areas. The more people par ticipate, the more informa-
tion that is available for the community as a whole. You can become a top participant
in your community by earning status points.

Checking your points

To find out how many points you have:

Hover over your name from anywhere in the interface. In the profile
hover card, you can see your points and level listing, as well as any
badges you have earned. For a more detailed view, click your name
to go to your user profile.

Or go to a Latest Acclaim notification in your Inbox. Scroll down
through the notification to see your points and how you rank in a list
with other community users.

Quick view

Go to your user profile by clicking your avatar > View Profile  or
your name anywhere in the interface, and then click Rewards. There
you can see a full listing of the badges you've earned, quests you've
completed, your points total, and how many points you need to get
to the next level.

Detailed
view

Note:  In places, the Your Progress or Top Participants tile (which one you see by
default depends on how your community is set up) shows your status points for your
activity in that place only. You may notice that this tile shows different point levels
depending on what place in the community you are looking at.
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Earning points

Because each community can be set up differently, you should ask your community
administrator for details about status points. What activity is rewarded, status levels,
badges, and points awarded may vary. Depending on how your community is set
up, you may earn points and badges when you involve yourself in the following types
of activity:

• Post a discussion or question, or respond to one

• Correctly answer a question

• Provide helpful information in the replies or comments of documents, discussions,
and blog posts

• Create new documents

• Create new blog posts

• Complete new tasks in a project

• Create a new status update

• When someone likes your status update

• When someone shares your status update

Note: When content is deleted, status points are also deleted.

Awarding badges and points
You can award other community members a badge to recognize their contributions,
and even give them some of your status points.

If your community manager has enabled Jive Rewards, you can celebrate and thank
other community members by awarding them badges, and optionally some of the
status points you've earned yourself. Badges show up on the Rewards page, and
the community member receives a notification that explains the reason.

To hand out a badge and optional points:

1. Go to <your_community_url>/rewards.

You can see the available badges at the top of the Badges tab.

2. Select a badge.

3. Star t typing a person's name in Give to, and select their name. You can only give
one person a badge at a time.

4. In Add a personal message, type a brief thank-you message, or explain why
they're getting the badge.

For example, you could type "Thanks for answering so many customer questions!"
This message is shown on the Rewards page and in the notification the user
receives.
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5. If you want to give points with the badge, move the points slider. Points are
removed from your community total and added to theirs. Point levels affect
leaderboards, but won't affect any missions that have already been earned.

6. Click Give Badge.

Sharing content with other places
To make using the community easier for people who tend to focus on cer tain groups,
spaces, or projects, you can share your content with their place even if you initially
post it in another place. When you share content with a place, it shows

up in that place's activity stream. Anyone following the place where the
content is shared receives a notification in the stream.

People who don't have access to the original content can not have access to the
shared one either. For example, you post a Contact List document in the Human
Resources group, and some Engineering managers have access to the Human Re-
sources group, but they spend most of their time in their Engineering group. You
could share the document with the Engineering group, which is open, and know that
only the managers can search for and view the Contacts List document.

This feature is turned on by default in internal-facing communities.

To share content with multiple places:

1. Go to the piece of content you want to share, such as a document, blog post, or
discussion.

2. Click Share in the menu.

3. Enter the name of the place you want to share the item with, or use the place
picker to navigate to and select the place.

4. If required, add more places.

5. Type a note about the share in the Message box.

6. Click Share.

At the top, you can see the places it has been shared with so you can keep track.
You can click the x other places link to see which other places the item has been
shared with.

Who can see my content
In Jive, people post content in places. This means that all content (such as
discussions, documents, and blog posts) are published in a containing place (space,
sub-space, group, or project). All places have visibility permissions (set by the place
owners) that determine who can see the content posted in that place.

For more details on content visibility, see Public and private communications on
page 182 and Content visibility options.
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Creating hidden content

In addition, each user has their own personal container. Content that you set as
Hidden before you publish it is stored in your personal container and is private to
you. When you publish Hidden content, only you can see it as a content update in
your streams; other users do not. For more information, see Creating documents
for yourself on page 84.

Limiting content to a few people

Alternatively, you can publish something in your personal container and select to
show it only to Specific People whom you designate before you publish. In that
case, only you and those other people can see the content and only those people
can see it as a content update in their streams.

Limiting content to multiple places

You can also publish in one place and share it with other places. As long as people
have access to view the original content, they are also able to access it from the
place you share it with. They can find it in the Content tab for that place.

Limiting discussions and questions to a few people

Similar to other content types, you can publish discussions and questions so that
only a few people can see them. For more information, see Creating direct messages
and private discussions.

Saving a document or blog post as a draft

Another handy feature is Save As Draft which allows you to share a draft of a docu-
ment or blog post with other users before you publish it. This is helpful for working
together on a document or blog post before you publish it for a larger audience.
Drafts are not visible in any streams. For more information, see Saving drafts.

Differences between documents, blog posts, and
discussions
Documents, blog posts, questions, and discussions have different purposes and
rewards. Here you find suggests ways to think about these content types.

Documents

Collaborate with others on a single document; capture
information that should be available for a while; create a report,

Purpose

agenda, or meeting notes. For more information, see Using
documents on page 90.

Most of the content is in the document itself; comments by
readers and authors are appended.

Format

Somewhat formal, often in the third person.Style

Whenever the document is edited (and Minor Update is not
selected), and whenever comments are added.

Stream updates
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Blog posts

Express a point of view; call something to the attention of other
users; make a proposal to get feedback from others; ponder
an idea. For more information, see Using blogs on page 103.

Purpose

Most of the content is usually in the initial post, with reader
comments appended.

Format

Informal, usually in the first person.Style

Whenever comments are added. Edits to a blog don't tr igger
an update.

Stream updates

Discussions

Make a short observation or assertion to get feedback; report
a problem. For more information, see Using discussions and
questions on page 87.

Purpose

Most of the content is in the form of replies to the initial
assertion.

Format

Informal, usually in the first person.Style

Whenever replies are added, and whenever a reply is marked
as Correct or Helpful.

Stream updates

Questions

Ask the community a question. For more information, see
Using discussions and questions on page 87.

Purpose

Most of the content is in the form of replies to the initial
question.

Format

Informal, usually in the first person.Style

Whenever replies are added, and whenever an answer is
marked as Correct or Helpful.

Stream updates

Status update tips and tricks
Status updates let you interact with others in the community. You can also delete
your own updates, see who liked them, see other people's updates, and several
other activities.

Comment on, share, follow, or repost a status update by
clicking any of these commands in the footer of yours or
other user's update.

Interacting with others
from status updates

Share your update with only a specific group by clicking
Change beneath the status box, and then selecting the

Limiting your status
update to specific
groups group before you post. When you post a status update to

a group, only members and followers of that group can
see the update in their attention streams. If the Activity
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page of the group includes Recent Activity tile, the status
update is displayed there as well.

Delete your own update by going to your Inbox and
clicking on the time stamp in the update (for example,

Deleting your status
update

"posted 2 hours ago"). From the permalink page, click
Delete.

Alternatively, you can delete an update by going to your
user profile and clicking Activity > Status Updates .
From there, click the update's time stamp, and then
Delete.

Click the number next to Like in your status update to see
the people who liked it.

Seeing who liked your
status update

Inser t one or more tags in your update by preceding
keywords with a hash or pound sign (#) so that you and

Using tags in your
status updates

others can find the update more easily later. For more
information, see Using tags on page 51.

Filter any of your attention streams by selecting Filter >
Status Updates.

Filtering by status
updates

Click a person's avatar or name from any of your attention
streams, or search for the person from the People finder

Seeing someone else
status updates

or Spotlight search. Click on the person's name to go to
their profile page, and then click Activity > Status
Updates .

Categories of content
Content categories associate content with keywords for easier searching later.

Content categories are words or phrases predefined by administrators within a
particular place, such as a space or social group. If there are categories available
in the place, it usually means that the place administrator has given thought to how
that place content should be grouped. An administrator who creates a category can
optionally associate cer tain tags with it.

Note:  Content categories are used only inside a single place and are different from
the place categories that are used to tag and find groups, spaces, and projects.

Applying categories

To apply a category to a content item:

1. Open the content item for editing and scroll to the bottom.
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Under Categories, you can see the list of categories that have been defined for
the place of the content item.

2. Select the categories in which your content item seems to belong.

3. Click Update to publish the content item and assign the selected categories.

Creating polls
You can use polls to get instant feedback on a question. A poll is a fast way to ask
a multiple-choice question in the community.

When you create a poll, you define the question and the possible answers. For ex-
ample, you could create a poll asking the community if your team should change a
workflow process. A poll appears on the home page of the place in which it is created.
As people respond to the poll, results are displayed graphically as colored bars. A
person can vote only once in the poll.

To create a poll

1. Click  > Poll .

2. In Title This Poll, enter a title for your poll.

The title appears above the list of options in the published poll, so you should
use it as the poll question. For example, "Where should we have the holiday
party?"

3. In Choice 1 and Choice 2, enter answer options.

For example, choices for the holiday party poll might be, "In the office," "In a
restaurant," "At someone's house," and so on. You can also add choices.

4. If required, add more choices by clicking Add a Choice and filling in a description
for each choice.

5. Add a description to provide more information about the poll.

The description is displayed below the title, and above the options or the results,
depending on whether the poll is completed.

6. Select where you want to publish the poll. To get wider par ticipation, publish your
poll to the entire community and then share it with people and groups who might
be interested.

7. Under Tags, add tags to the poll for it to appear in searches.

8. If your poll will be published in a space, optionally select the categories to which
this poll belongs.

9. To change the publish and end dates of the poll, do the following:

a. Under Advanced Options, select Change voting options.

b. Set the dates when you want to publish the poll (immediately or a specific date)
and when you want voting to end (on a specific date, in a specified amount of
days, or manually).

10.Click Create Poll.
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The created poll appears in the place you have chosen.

Excluding polls from trending lists

You can exclude your polls from the trending lists if necessary. For more information,
see Removing content items from Top and Trending on page 76.

Events
Events allow you to schedule, discover, and RSVP to events from your Jive
community or privately manage your own schedule. Events can be created in spaces,
groups, projects, or your own personal container, like other content types.

For more information about events, see the Jive Events Help.

Creating documents for yourself
You can create a Hidden document to keep it private. Later, you can change the
visibility to include other people if you need to.

If you don't want others to see your content, you can keep private documents, events,
tasks, bookmarks, ideas, and uploaded files. You can either publish items as hidden
or save as draft to ensure no one else can see it. For more information on which
content types can be hidden, limited to specific people, or public, see Content visi-
bility options.

To create a document that is visible only to you:

1. Click  > Document  or another content type.

2. When you finish editing, under Publish Location, select Hidden before you
publish or save as a draft.

Similarly to documents, you can create other private content items.

To see your hidden content:

• Go to Your Avatar > Your Content  in the main navigation menu, and then click
Authored in the left sidebar.

From there, you can edit your content items and keep them hidden, or you could
make it visible to other users by changing the visibility options before publishing.
You can also filter content by type.

Saving drafts
You can use the Save As Draft feature to quickly jot down and save your thoughts
in documents or blog posts. Then, you can come back later to edit and publish your
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content. You can also collaborate with others on saved drafts before publishing
them.

You can save blog posts and documents as drafts. This can be useful if you need
time to finalize your thoughts before publishing something. Additionally, drafts are
not visible in any streams.

Creating and editing drafts

To save a blog post or a document as a draft:

1. Create and fill in a document or blog post.

2. Click Save Draft.

The document is saved as a draft and is not visible to anyone. You can find it on
the Drafts tab of Your Content.

To edit a draft:

1. Go to Your Avatar > Your Content  in the main navigation menu, and then click
Drafts in the left sidebar to see your drafts.

2. If required, filter your Drafts results by documents or blog posts.

3. Click on the draft to edit the content.

4. Click Publish to save and publish the draft.

You can edit the content and save it again as a draft, or publish it.

Collaborating on drafts

You can collaborate on drafts of blog posts or documents before you publish them
or share an existing draft with other users.

To get people to collaborate on an existing draft:

1. Open the draft.

2. Click Share in the upper right corner of the page.

3. In the Share dialog box, select the people you want to share the post with and
include a message for them.

4. Click Share.

The recipients are able to edit the draft and either save it as a draft or publish it.

Using user profiles
Use your profile to express who you are to your community. If you have something
you want the community to know about you, add it to one of the cards that can be
found here.

Your profile also shows everyone what you've been working on, who you're connected
to, the recognition you've been getting, and the groups you've most recently visited.
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Setting up your profile
Setting up your profile is the first step to par ticipating in the community.

Your user profile provides community members with an easy way to learn about
your skills and interests. Your profile shows up in search results when community
members search for keywords contained in your profile. You can update your infor-
mation at any time.

To set up your profile:

1. Go to Your Avatar > Edit profile  in the upper right corner.

2. On the Avatar or Photos tab, change your avatar and manage your photos.

Your avatar and other photos let people see and recognize you in person. Your
avatar lets community members quickly associate your comments and status
updates with a simple visual cue.

3. On the Profile Details tab, fill in as much profile information as you like.

Note that your profile can found when people search, so if you have professional
roles or interests that would be useful for others to know about, you should include
them. You may not be able to edit cer tain fields, such as username. Usually, the
community manager sets up these fields for you.

4. On the Privacy tab, edit your privacy settings.

These control how different types of users see your profile. For more information
on privacy settings, see Setting up content visibility options.

5. Click Finished.

The profile is set up and becomes available in search.

Adding and endorsing skills
You feature skills on your profile by adding them, and you endorse other user's
skills by going to their profiles.

Skills not only provide more information about others in your community, but they
also tag people with those skills, so when you search the community for users, you
can filter by skills.

To add skills to your own profile:

1. Go to Your Avatar > View Profile  to view your profile.

2. Under Skills, click New skill and type your skills.

Select a tag, or create a new one—just type a word or phrase and press Enter
to turn it into a tag.

3. Click Add to save your skills.
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To endorse the skills of another user:

1. Go to their profile.

2. Under Skills, click Endorse and type their skills.

3. Click Endorse to save the skills.

Community users need to accept new endorsements via an Inbox notification before
they show up in their profile. You can see new skill aler ts in your activity once
community users approve endorsements. To back up an existing endorsement, click
the plus sign next to the skill listed in their Skills card.

Setting up content visibility options
If you're concerned about privacy, you can limit who sees different par ts of your
profile by editing your privacy settings.

To limit profile visibility:

1. Go to Your avatar > Edit Profile .

2. Go to the Privacy tab.

3. For each profile field, select who can view it.

Your community administrator may control who sees cer tain fields, such as those
without a Visible to option.

4. Take a look at how others can see your profile by using the Preview your profile
option in the upper right corner of the page.

5. Click Finished to save the changes.

Using discussions and questions
Use questions and discussions to ask questions or introduce new ideas to the
community.

Discussions and questions are a quick way to get an answer to a question or feed-
back on an idea. You can attach a file or inser t an image, video, or code example
into a discussion to better explain your question or idea.

A questions or a discussion?

Here's the difference between these two content types:

A discussion can help you get feedback on your latest idea or
assertion, for example, "The Accounting team needs feedback on the

Discussions

new expense reporting process" or "To fix or not to fix the old copier
on the third floor..." These kinds of open-ended questions or ideas
can encourage a good discussion in the comments. You or other users
can mark any of the replies as the Decision, a Success, or for Action.
For more information, see Using Marking feature on page 149.

A question can help you get a quick answer to a burning question, for
example, "Have you seen my red stapler?" or "How many pieces of

Questions
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flair are required on our uniforms?" Anyone can jump right in to answer
your question in the comments.

Creating questions and discussions

• To star t a new question or discussion, click  > Question/Discussion .

Note: You may not see these options depending on how your community is set
up.

For either a question or discussion, you can attach a file or inser t an image, video,
or code example to explain your question or idea to the community better.

Later, if you want to transform a question or discussion into a document, you can
save it as a document. For more information, see Converting discussion or question
threads to documents.

Tips and tricks

• If you want to keep track of unanswered questions in a place, use the Unanswered
Questions tile on the place's Activity page. For more information, see Adding tiles
to Activity page.

• If someone replies to your question or discussion with useful information, it's good
practice to mark their reply as either Helpful (discussions and questions) or Correct
(questions only). That way, others who have the same question or thought can
quickly see which replies are the most useful. A Helpful reply is on the right track,
while a Correct reply answered the question. Correct and Helpful answers earn
status points for their creators. Note that only system administrators, place owners,
and question authors can see the Correct Answer option. For more information
about status points, see Earning status points on page 77.

• Tag discussions and questions, so that others can search for and benefit from
them later.

• You can set discussion replies and content comments to be displayed all on one
level (flat) or indented hierarchically (threaded). For more information, see Flat
and threaded views in discussions and questions on page 89.

Choosing where to publish discussions and questions

When you're ready to post the question or discussion, you need to decide how and
where to make it visible. Carefully choosing a space or social group makes the
question or discussion more visible to people who follow the place where you publish
it. For example, publishing a question about technical support in the IT group can
ensure the question is displayed in a stream for users who follow or belong to that
group.

Your discussion or question also inherits the permissions of the place where you
publish it. Therefore, publishing in a members-only group limits par ticipation to
people who are members of the group. If you want community users to be able to
search for and stumble across your question, don't publish it in a private group.

On the other hand, if you need a question or discussion to be confidential, you could
publish in a private group. You can also choose to publish your question or discussion
only to specific people.
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Excluding discussion and questions from trending lists

You can exclude your questions and discussions from the trending lists if necessary.
For more information, see Removing content items from Top and Trending on page
76.

Flat and threaded views in discussions and questions
You can set discussion replies and content comments to be displayed all on one
level (flat) or indented hierarchically (threaded).

Note:  Replies to questions are shown in a unique order: the Correct Answer is
always shown at the top, followed by replies with the most Helpful marks.

Discussion views

The flat and threaded views look like this.

In flat view, you can see comments and replies chronologically in the order
they were received, and there is no indentation between responses. This view

Flat
view

can be helpful if you like to see comments in the order they were made.
However, it can become difficult to follow conversations between people when
a discussion is longer than a few comments.
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In a threaded view, you can see which post a person is responding to because
comments and replies appear indented beneath the post to indicate embedded

Threaded
view

replies or comments. This can help you follow conversations because responses
remain associated together visually.

Setting up discussion view

To set up your view style preferences:

1. Go to Your Avatar > Preferences  in the upper right corner.

2. On the General Preferences tab, select your Discussion View Style and
Comment View Style.

3. Click Save to save and apply the changes.

Using documents
Jive is a powerful tool for creating and uploading documents, collaborating on them
with others, and managing versions.

You can create documents in Jive or upload documents from outside of Jive, such
as Microsoft Office documents or Adobe PDFs. Documents can be available for
viewing or editing only by you, a group of people you designate, or the entire com-
munity. For more information about uploading external files to the community, see
Uploading files to Jive on page 92.

90AUREA CONFIDENTIAL

Chapter 1: Using a Jive community



You can also view and manage the changes between versions of a document, in-
cluding restoring a previous version so that it is the current version.

• To create a document, click  > Document  and star t writing.

Choosing where to publish a document

When you're ready to save the document, you can decide how and where to make
it visible.

Choosing a place, such as a space or social group, makes the document more visible
to group members who follow the place where you publish it. For example, publishing
your schedule document in the Sales Kickoff Planning group highlights your planning
for anyone who's following that group in a stream.

Your document also inherits the permissions of the place where you publish it.
Publishing in a private group, for example, limits the viewers of your document to
the people who are members of the group. If you want community users to be able
to search for and stumble across your document, don't publish it in a private group.
On the other hand, if you need a document to be confidential, a private group could
be the right place.

Controlling who edits documents

Even when you publish your document in a public place, you can still control who
can edit it. After you add the text for your document, scroll down the page and use
the Collaboration Options to set the editing and commenting permissions. You can
also specify that another user must approve the document before it is published.
For more information, see Document approval.

If you want to be the only one who can see your document, select Hidden. You can
add more people as viewers or collaborators later if you change your mind.

Managing versions

When a document has been edited and published multiple times, you can view and
manage the differences between versions and delete specific versions, or restore
a previous version so that it is the current version.

To manage a document's versions:

• Click Version to view a particular version, compare changes between versions,
or restore a par ticular version.

• Click Actions > Manage versions  to view the version history, restore a version
to be the current version, or delete a version.

Excluding documents from trending lists

You can exclude your documents from the trending lists if necessary. For more in-
formation, see Removing content items from Top and Trending on page 76.
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Uploading files to Jive
You can upload a variety of files to the community to collaborate on them with others.

Depending on how your community manager has set up your community, you can
upload a variety of external file types such as Microsoft Word documents and Adobe
PDFs. After you have uploaded a Microsoft Word, Excel, PowerPoint or PDF external
file, you can view and navigate through a preview view of its pages.

Note:  If you have Jive for Office, you can manage and sync the document with the
community while working within Office (Windows only). For more information about
this, see Working with shared office documents on page 94.

Uploading a file is a great way to include an externally-authored document or track
its progress. For example, you can upload a Word document, then add collaborators
so that it gets reviewed in Jive by other team members.

Be careful when uploading documents with proprietary fonts applied. Due to legal
restrictions, these fonts cannot be imported with the document, and the unsupported
fonts are replaced with the one of the supported. This sometimes causes texts for-
matted with proprietary fonts to look strange in Jive preview.

Uploading a single file

To upload an external file to Jive:

• Click  > Files , then click to select the file you want or drag and drop it into
the interface.

If your community manager has enabled the antivirus feature, there may be a slight
delay while the file is being scanned for viruses. For more on where to publish, and
controlling who edits, see Using documents on page 90.

Uploading multiple files

You can use the same procedure to upload up to 50 files simultaneously. (Some
communities may have a different setting). Files are named automatically based on
their original filenames. However, you can edit the names afterward for greater
clarity.

You don't need to worry about filling the activity stream with notifications or sending
multiple email notifications when you upload more than one file. The notifications
are bundled together into a single notification. If there are only a few, you can see
previews of the files in the stream.

Note: The Multiple File Upload feature does not work on Internet Explorer 9. You
can only upload a single file at one go. To avoid this issue, it is recommended to
use the latest version of Internet Explorer or another supported browser. For more
information, see Supported browsers.
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Excluding files from trending lists

You can exclude your uploaded files from the trending lists if necessary. For more
information, see Removing content items from Top and Trending on page 76.

Reserving files and documents
Marking an uploaded file or a document as Reserved indicates that someone is
currently editing it so that other users shouldn't edit it until the Reserved badge is
removed. It does not actually lock the file or document.

The Reserved badge provides important information about file status for anyone
who can't use Jive for Office to edit and merge uploaded files, for example, Mac
users. It can also be used to warn users of a published Jive native document that's
not ready to be edited by other people yet. The Reserved badge doesn't prevent
anyone else from editing, but it shows information about who is working with the
item, making it easy for other people to check in with you before adding their own
edits. Note that if you want to hide an in-progress Jive document before publishing
it, you can just save it as a draft and share it with anyone you want to.

When an author or editor marks a file as Reserved, anyone can see who reserved
the file and contact the person if they're unsure whether it's OK to proceed with
editing. Anyone with the rights to edit a file or document also has rights to mark it
as Reserved. When someone reserves a file, the author and anyone who has already
edited the document receive an Inbox notification. You can filter content to find re-
served documents, too.

Differences in reserving Jive documents and uploaded files

Jive already provide an indicator when someone has star ted editing
a document. (However, note that the lock on the document while

Jive native
documents

someone is editing only lasts ten minutes, and after that, it's possible
to edit the document and overwrite another user's changes.) Mark
as Reserved replaces the need to put "WIP" or another indicator in
the title when a document isn't in a state where you'd like other users
to contribute. It shows an author or editor's intention to keep working
on the document undisturbed until the next time that the author
publishes it.

Mark as Reserved warns users who don't use Jive for Office that
publishing a new version could overwrite and invalidate a version

Uploaded
documents

someone is working on locally. (Windows users with Jive for Office
have live merge capability and may not need this feature as much.)
Marking a file as Reserved does not lock the document or prevent
uploading another version. But any other user who clicks Edit with
the intention of uploading a new file can see a message pointing out
that the file is currently reserved for editing.
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Marking as Reserved
You can reserve a document or file to aler t other users you're working on it. This
doesn't lock the document, but it aler ts other users that you are planning to update
the item.

Reserving documents is especially useful if you're using uploaded files, but can't
use the Jive for Office. The Reserved badge doesn't prevent anyone else from
editing, but it shows information about who is working with the item, making it easy
for other people to check in with you before adding their own edits. For more infor-
mation, see Reserving files and documents.

To mark a file as Reserved and remove to remove the marking:

1. Go to the document or file you want to reserve.

2. To mark the content item, click Actions > Mark as Reserved .

The Reserved badge is added at the top of the document.

3. To free the file for editing, use any of the following:

• Click Unmark next to the Reserved label on the document or file page.
• Publish the item. When you or anyone else publishes a new version, the

Reserved badge is removed.
• Mark it as Final, Official, or Outdated. These markings override Reserved, and

the reserved badge is removed.

Working with shared office documents
With Jive for Office, you can share your Office documents with others in your online
community.  As you make changes to a shared document on your

computer, Jive for Office synchronizes the document with the version
that's visible in the community and provides real-time notifications to
users working in the same document.The notifications tell users that

content has changed and give them the option to incorporate the changes into their
version using a merge tool. This keeps the content on the community up to date but
also synchronizes comments, tags, and collaboration settings between the community
and your document.

This feature is supported for Microsoft Office running on Windows. For more infor-
mation about supported Office versions, see the Jive for Office Guide or the Jive
for Office 365 Guide.

If you have the appropriate permissions, you can edit everything but the content of
a shared document in the community. In the community, you can edit descriptions,
tags, and categories, and you can use an Office program to edit the document
content.
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What you can do

With Jive for Office, you can upload Microsoft Office documents to your community,
then keep changes to the document in sync while you work in Office.

In par ticular, with Jive for Office you can:

• Upload Office documents to your community without leaving Microsoft Office.
When you upload a document, the community displays a preview of the document.
However, the document must still be edited by using Microsoft Office.

• Use Jive in the Office toolbar ribbon to:

• Change collaboration options to indicate who can edit the document in the
community.

• Create a document for your community.

• View the currently published version of your local document in your community.

• Share your document with others.

• Check for updates to the document.

• Use the Dashboard to:

• See who else is editing the document.

• See how many people viewed the document, who created it, and who’s
contributed to it.

• View, add, delete, and reply to comments.

• View and add tags to help categorize the document in the community.

• Edit the document's description.

• View older versions of the document.

• Rate the document and see how others rate it.

• Browse files similar to the open file.

• Take a look at more files created by the author.

Getting Jive for Office add-on
You need the Jive for Office add-on to share documents between Office
applications and your community, which requires Microsoft Windows.If

you don't have the add-in, you can get it when you're viewing an uploaded Office
document in the community.

To get the Jive for Office add-in:

1. In your community, go to an Office document.

2. To the right of your document, click the Download Jive Connects for Microsoft
Office link as shown in the following image.
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Getting connected to your community
After you first install Jive for Office, it might not be completely set up to connect to
the community you want to synchronize documents with. To connect, you need to
provide your user name and password.

To get connected to your community:

1. In the Jive menu, click Accounts.

2. Click Add to add your Jive account.

3. Enter the Community URL, which is the exact URL that you use to navigate and
login to your community.

4. Enter your Jive user name and password.

Now that you connected to your community, you can add documents to the commu-
nity. For more information, see Adding documents to community on page 97.
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Adding documents to community
To have an Office document appear in the community, you can either add it using
Jive Connects for Microsoft Office or upload the document from inside the community.

Adding documents from the Microsoft Office side

To add a document using Jive Connects for Microsoft Office:

1. Connect to the community. For more information, see Getting connected to your
community on page 96.

2. Open or create a document in Microsoft Office.

3. Click Jive > Publish New  as shown in the following image.

Note:  Once the document is added to the community, clicking Publish Update
uploads your changes to the community.

4. In the dialog box, navigate to the place in the community where you want to save
the document.

5. In the Document Name box, enter the name at the bottom of the dialog box.

You can also add tags to help other users find your document in the community;
provide an optional description; and decide who can edit your document. Also,
you can change the local file location for your document by editing the Store At
path.

Note: You don’t need to save your document or changes to your document locally
before publishing to Jive.

6. Click Save.

7.

You can synchronize the uploaded documents with the rest of the community. For
more information, see Keeping documents synchronized on page 99.
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Attention: When you add an Excel spreadsheet to a community, Jive for Office
adds a hidden spreadsheet that contains a copy of the original spreadsheet with
additional metadata. This copy is used to track changes and allow collaborative
working on the spreadsheet.

Once the document is added to the community, you can click Jive > Dashboard
to display a panel of information about the document, such as comments, ratings,
and the current version number. The following image shows the Dashboard.

Adding documents from the community side

To add a document from inside the community:

1. From your community, click  (Create) > Document .

2. Select Upload a File.

3. Select the location for your document.

4. Click Choose File.

5. Select the file from your desktop.

6. Click Publish.

Depending on the size of your document, it might take a few seconds to upload it.
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Create a new document from an existing one

To avoid a few steps, you can just upload an existing document and rename it as
a new document to star t fresh within the community. This creates a newly uploaded
document in the community, leaving the previously uploaded document in the com-
munity as it was when you last synchronized. The new document will have the content
of the previous one, but won't have its other properties, such as comments, collab-
oration settings, tags, and so on.

Note:  Making a new document in this way leaves you with an Office document that
has the same content, but without all of the community-related information. To get
the previous Office document with that information, go to that document's page in
your community and click the Download link beneath its preview.

To create a new document from an existing uploaded document:

1. In Office, open the document you want to star t from.

2. Select Jive > Publish As .

3. In the dialog box, navigate to the place in the community where you want to save
the document.

4. In the Document Name box, enter the new name at the bottom of the dialog box.

5. Click Publish.

Keeping documents synchronized
After you've connected your community to Office, Jive Connects for Microsoft Office
keeps your documents synchronized with the community.

Jive for Office does the following:

• Updates the document preview in the community when you save changes to the
document's content.

• Updates the Office document comments list with comments made in the community.

• Lets you see updates from others in your community and review them before
using them.

• Keeps changes to community-related document properties in sync between the
Office application and the community. When a change is made in one place, it
shows up in the other. You can see the following properties in the Dashboard:

• Tags

• Categories

• The document's title

• The document's description

• Revision activity

• Document's state
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To get document updates from the community:

1. When your document has been updated by someone in the community, you get
a real-time pop-up notification. Alternatively, you can also click Check for
Updates.

2. If there are no changes, a message tells you so. Otherwise, you can select how
you want to deal with the changes:

• Replace my version to accept the newer version, overwriting your own local
changes. (You can also Overwrite Local Version from the Jive toolbar at any
time if you want to discard your local work and star t over with the published
version.)

• Merge and Review to review which changes you want to use.

• Ignore to continue working without accepting or rejecting changes at this time.

3. When you're done working, save your changes so others in the community can
see your recent changes.

4. If at any time you want to overwrite the current local document with the version
on the community, click Check for Updates > Overwrite local version  in the
Jive toolbar.

Working with document versions
As you work on a document in Office, Jive Connects for Microsoft Office
keeps track of changes, including community-related information such
as comments.It can sync your changes with what's going on in the

community with the click of a button. You can even view the changes that have been
made since previous versions of the document while in Office. You can also save
a previous version as the current one.
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The version management feature does its work in par t by using the change tracking
feature built into Office. That means that if you download a document that someone
has made changes to, you might see revision marks placed there by the change
tracking feature. The document is fine, but the revision marks can make it hard to
read. You can hide the marks in the following ways:

• In Word 2007 or 2010, select the Review tab. In the Tracking group, select Final
in the Display for Review menu to hide the changes.

• In Word 2003, locate the Reviewing toolbar. In the Display for Review menu,
select Final.

Work with document revisions

Jive Connects for Microsoft Office creates a new version of a document whenever
you save changes to the document.

To view previous versions of a document:

1. Open a community document. You can see the dashboard on the right. If you
don’t, select Jive in the toolbar and click Dashboard.

2. Under Versions, if the version you want to see isn't visible, scroll down to display
it. Previous versions are listed with the date and time when they were saved. If
you hover over a version, you can see the name of the person who published that
version.

3. From the list of versions, click the one you want to view.

Note: You can't save a previous version as the current one. To recover a previous
version, open that version and publish it under a new name.

Work with document activity

Jive Connects for Microsoft Office displays a list of activity related to the document.
This activity includes versions saved and comments added. By clicking cer tain items
in the activity list, you can add information to it. For example, you can view and add
comments from the Comments tab.

To view document activity:

1. In Office, click Jive and then click Dashboard.

In the Overview panel, you can see details about the document, such as when
it was last edited and what version you're looking at.

2. Click the arrows next to tags, categories or description to add or edit this
information and have it shows up in the community.

3. In the Comments tab, click Reply to add a comment to the open document. These
comments show up in the community as comments. For more information, see
Adding comments on page 102.

4. You can also browse other documents that the author has created or documents
similar to the open document.
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Adding comments
When you comment on a document in Office or the community (as
opposed to adding inline comments in the body of a document), your
comments are synchronized and appear in both places. When you add

inline comments in either location, these comments are visible where they are
created, but are not synchronized or visible from the other location.

There are two kinds of comments for shared Office documents:

• Document comments are like those people make elsewhere in the community.
People can usually comment on shared documents just as they comment on other
kinds of documents. These are added in the community or in Office. You can see
these in Office when you go to Jive > Dashboard  and then click the Comments
tab.

• Inline comments appear in the document itself. An inline comment is a way to
add a comment to a par ticular par t of the document. When you add an inline
comment in the community, it shows up in the community on the Inline Comments
tab at the bottom of the document, as well as in the document preview, but is not
visible in Office. Inline comments you create in Office can be seen in the Review
tab when you select Final Showing Markup in the Tracking group, but cannot
be seen in the Jive community.

To add a document comment:

1. In Office, go to Jive > Dashboard , and then click the Comments tab.

2. Type your comment.

3. Click Add.

4. You can also click Reply to reply to an existing comment or Delete to delete an
existing comment.

Adding collaborators
You can add collaborators to work on your Office documents.

By default, when you use for Office to add a document to your community, the doc-
ument's collaboration options are set as follows:

• Only you can edit the document when you save to your personal container.

• Anyone can edit it when you save it to an open place.

You can change these defaults to fit the document needs.
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To change collaboration options:

1. On the Jive toolbar, click the Collaboration button.

2. In the dialog box, select the option to set who can edit:

• Specific people: Only the people whose names you choose can make changes.
If you select this, begin typing the person's name in the box beneath Specific
people. When their full name appears, click it to add it to the list.

• Just you: Only you can make changes to the document's content.

• Anyone: Anyone in the community can make changes.

3. Click Update.

Using blogs
Use blog posts to express ideas or opinions and get community feedback. If you've
got something to say, you can write it in a blog.

• Use your blog to express opinions, call attention to noteworthy items you've seen
(such as an ar ticle on the Internet), or make proposals.

• Because other people can comment on your blog posts, they are a great way to
pitch ideas that could impact the team or the organization. Of course, you can
comment on other people's blog posts, too.

• Your community might include several blogs, for example, "Bill's Blog" (with posts
from Bill) or "The Human Resources Blog" (with posts from people in the HR
department). Your administrator can also create personal blogs and associates
them with par ticular people or teams.

• If you want to see some of the blogs in your community, go to Your Avatar >
Your Content , select All on the left, and then click Blog Posts.

You can see the latest blog posts from around the community.

Adding blog posts

To star t a new blog post:

• Click  > Blog post  and write a post.

If you haven't created a blog before, you get a choice between setting up your own
personal blog and posting in a blog belonging to a par ticular place. Place blogs
typically relate to the subject matter of a group or space.

After you've written some content and decided where to publish it, you can also
decide whether to publish it r ight away by clicking Publish, or whether to schedule
it for a later date. Select Schedule when this post gets published and then select
the time and date you want.
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Managing blogs
When you manage your blog or your place blog, you can create new posts, view
and post comments, import content from an external blog into your Jive blog,
subscribe to your blog's comments, and set other options.

To manage your blog:

1. Go to Your Avatar > View Profile .

2. Click Content and click on your blog's name to go to your blog's home page.

Note: You may not see your blog if you haven't created any blog posts.

3. Click Manage in the Actions list on the right.

4. User the options in the right sidebar to manage your blog.

If you are a place owner, you can manage your place's blog, too. From your place's
landing page, go to the gear icon > Blog .

Designing blog posts
You can choose to arrest visual elements for your blog post, including images and
an enlarged initial capital.

Some blogs are more word-focused and others are more image-packed. However,
you can use the following information and best practices to help make your blog
posts look good:

• Include a banner image at the top. If you choose a wide image, you can select
which part is displayed by using the Background Position controls while you're
selecting the image. The image scales to the size of the browser or screen and
fills the banner area, so you can see some variation in how the banner is
presented. An image 1200 x 500 pixels typically works well.

• If you want to use a decorative initial capital, select Enlarge the first letter in
the blog post.

• Change the size of inline images by using drag and drop. To return an image to
its original size or change its alignment in relation to the text, click the image and
then the image icon.

Excluding blog posts from trending lists

You can exclude your blog posts from the trending lists if necessary. For more infor-
mation, see Removing content items from Top and Trending on page 76.

Importing content into blogs
If you have content from another blog that you want to bring into your Jive blog, you
can import it. Jive supports blogs in the Movable Type format.

If you've got a blog in Jive, you can import content from your other blogs. You need
to first export content from those blogs into the Movable Type import format. Some
blogging tools support this option.
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If you export content from WordPress, you might need to do a little editing of the
exported content before you import it. When your WordPress blog posts include
HTML tags, the file exported from WordPress omits tags that are needed to tell Jive
that the HTML is there. You need to enclose the content in <body> tags before im-
porting. Here is an example:

This is my <b>BOLD</b> HTML example.Before

<body>This is my <b>BOLD</b> HTML example.</body>After

To import content into your own Jive blog:

1. Go to your avatar > View Profile  to view your profile.

2. Click Content .

3. Under Your Blog, click your blog name.

Note: You won't see your blog here until you have published at least one blog
post.

4. Under Actions, click Manage  to open the blog management page.

5. Under Manage, click Import .

6. Click Browse .

7. Find and select your file, and then click Open .

8. Click Upload File .

Creating custom blog stream
You can use these steps to quickly create a custom stream for all your favorite
community blogs.

Before you star t adding blogs to a stream, you need to create your own custom
stream, as described in Creating custom streams on page 19. It can be something
like Awesome Blogs. Save the stream, but don't add anything to it yet.

To create a blog stream:

1. Navigate to a community blog you like. Go to Content > All > Blog Posts .

2. When you find a post from a blog you like, click on it, then click the name of the
blog post.

This opens the home page of the blog.

3. Click Follow, and select the blog you want to follow.

Every time the blog which you follow is updated or commented on, you can see a
stream update and get an email (if you enabled email notification).

If you get too many emails, you can turn off email notifications:

1. Go to your avatar > Preferences .

2. Clear Email for the blogs where you don't want to receive notifications by email.
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This option may be not unavailable in your community. For more information, see
Customizing notifications.

Images and collections in places
Jive places can be more engaging with sharing and saving sets of images
through collections. From the Images tab, you can view all of a place

images, gather images into collections for viewing together, and share collections
with others.

A collection is a group of images in a place that is gathered on filters and sor ting
that you select.

Viewing images and collections
When you select the Images tab, you see the place images and collections.

• The All Images collection is displayed when you select the Images tab. You can
see the Your Images collection, which includes any images that you added to
the place in the library.

• Select an image from the center of the page and use the right and left arrows to
star t scrolling through the collection.

• The library at the top of the page shows the available collections. The All and
Your Images collections are gathered by default.

• You can choose a different collection from the library to view the images in it.

• If you are a place owner, you can create and save a collection, and it is added
to the collections library. For more information, see Creating and editing image
collections on page 108 and Saving collections on page 112.

• The collections in the library are created and saved by the place owners, except
for All Images and Your Images collections.
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• Images appear in the Images tab when they are uploaded to a place. For more
information, see Adding images to places on page 107.

Restrictions

• Only uploaded images appear in collections. Images added through the inser t
image icon in the content editor; images attached to content; and images added
to tiles, widgets, or banners will not appear in Images and cannot be used in
collections.

• The Images tab can display no more than 200 images to avoid browser
performance issues.

Important: We do not recommend that you use widgets and widgetized Overview
pages (including the Home page) in your community. For more information, see
Understanding pages in places.

Adding images to places
If you have create permissions in a place, you can add images to it. Once you add
an image to a place, you and other place members can view it and use it in
collections.

Tip:  Collections are based on an image's tags, categories, and author, so it's a
good idea to tag and categorize your images when you add them.

To add images to a place:

1. You can add images to a place in one of the following ways:

• From the Images tab of the place: Select Images > Add Images .

• From the Edit menu: Select  > Files .
• From the Actions menu: Select Actions > Files .

This opens the Upload Files dialog box.

2. Click to select files to browse to the image or drag and drop the image file.
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Note: You can upload multiple images at once. To bulk upload, select or drag
and drop multiple files before moving onto the next step.

3. Add tags and categories to your image.

If you are uploading multiple images at once, any tags and categories you select
are applied to all images you are currently adding.

Note: Tagging images and adding that tag to the collection's tag filters may help
you to quickly gather images to a collection.

Your image or images are automatically displayed in any collections that are
gathering the tags and categories you selected. They also appear in the All
Images collection.

Now you can manage the uploaded images. For more information, see Creating and
editing image collections on page 108, Sharing collections on page 111, and Managing
collections on page 113.

• To add an image to a collection, add a matching tag or category to the image and
the collection.

• To remove an image from a collection, remove the tag that is shared by the image
and the collection.

• To delete your image from your community, select Delete from the Actions menu
of the image.

Creating and editing image collections
You can organize the place images into collections to share with other place members
if you have view permissions for the place. You can also select an existing collection
and change the filters and sor ting.

You need to add images to a place and tag or categorize them before you can create
a collection. Collections can be created by filtering by tags or categories. Collections
use image tags, categories, and author.

Tip: Tagging and categorizing your images when you add them let you use them
in collections. For more information, see Adding images to places on page 107.

Note: Only uploaded images appear in collections. Images added through the inser t
image icon in the content editor; images attached to content; and images added to
tiles, widgets, or banners will not appear in Images and cannot be used in collections.

To edit an existing collection, select that collection from the Collections library
at the top of the page first.

To create a new collection:

1. Add images to your place by using Images > + Add images .
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2. Once you see a few images on the Images tab, then click in the Filter by Tag,
Category or Author area.

3. From the menu, you need to filter all of the existing images before creating your
collection. Select tags, category, and authors until you've added filters that produce
the set of images you want.

Note:  Each collection can have only one category and one author. If you select
a new category or author, it will replace the current one.

4. Remove any existing filters that you don't want to use.
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5. If you want, select a different sor t order from the Sort by drop-down menu.

By default, collections are sor ted by Date uploaded (newest first).

With the collection created, you can share your collection with other community
members. For more information, see Sharing collections on page 111.
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If you are a place owner, you can save your new collection, too. For more information,
see Saving collections on page 112.

Tip:  If you don't have permission to save a collection, share the collection in a
message to yourself to view it later. For more information, see Sharing collections
on page 111.

Sharing collections
If you have view permissions for a place, you can share any of the saved collections
displayed in the Collections library on the Images page as well as sharing new
collections that you create.

To share a collection:

1. Select the collection that you want to share or create a new collection, as described
in Creating and editing image collections on page 108.

2. Click Share Collection.

3. Click Copy to Clipboard to copy a link to your new collection.

4. Paste the link into any Jive content to share your new collection.

Remember:  If you share your collection with community members who do not
have view permissions to the place you shared your collection from, they are not
able to view the collection.
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Saving collections
If you are a place owner, you can save collections for displaying on the place Images
page in the Collections library.

Each place can feature 30 custom collections.

Attention:  If you don't see Save Collection when creating a collection, then you
aren't a place owner and can't save collections, or you have reached the maximum
number of collections. You can still share your collection Sharing collections on
page 111.

To save a collection:

1. Create a new collection as described in Creating and editing image collections
on page 108.

2. Click Save Collection.

Note:  If you are unable to click Save Collection, then you have reached the
maximum number of collections. If you want to save another collection, you need
to delete one of the existing collections.

3. Select Save changes to update the collection with your new one or select Save
a new collection to make a new collection.

4. If you are saving a new collection, enter a name for your new collection and click
Save Collection.

Your new collection is displayed in the Collections library, after the other saved
collections. You can change the order that collections are displayed, as described
in Managing collections on page 113.
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Managing collections
If you are the place owner, you can rename, reorder, and delete collections.

To manage your place collections:

1. Go to the Images tab of your place.

2. Select the gear icon next to collections.

You are directed to Manage saved collections.

3. Select the collection you want to change.
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Restriction: You don't see the All Images and Your Images collections here
since they cannot be renamed, reordered, or deleted.

4. To rename the collection, enter the new name.

5. To change the viewing order of the collections, drag and drop the collections until
they are in the order you want.

6. To delete a collection, click  next to the collections.

Note:  Deleting a collection does not delete the images in it.

7. Click Save when you are done making changes.

Videos in Jive
Videos are one of the highly sought out ways to communicate and distribute
information. Jive supports uploading your videos and embedding videos from other
video services. And you can insert video within content or comments, or add them

by using .

Videos that were created by using  are known as standalone videos  (or video
objects). And videos that were inser ted into other content items or comments are
called inline videos.

You can upload video files to your community – these videos are called uploaded.
Or you can choose to add a video in your community from another site, such as
YouTube or Facebook, – these videos are called embedded.

Adding videos
You can insert a video in a comment, add it to content, or create one using  to
publish a video in the community.

Generally, you follow these steps to add a video:

1. Click  > Video  (to create a standalone video) or click  when you are adding
a comment or a content icon (to inser t an inline video).

2. Then you can:

a. Upload a new video: Click Upload, then add the video details and publish it.

b. Embed a video from another site: Click Embed, then enter the video URL and
import the video.

c. Embed a video from the community: Click Browse <community> Videos, then
find and select the one you want to add. This works for adding video to
comments or other content items.

These steps are described in detail in the following ar ticles.
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Uploading standalone videos to the community (with )
Use  to create new standalone videos  for your community. It can contain either
an uploaded video or a link to a video from another site.

These videos are published as the Video content type  and are visible when you
browse community content as separate content items.

For more information about the requirements for video files, images for thumbnails,
and caption / transcription files, see Supported video providers and formats on page
145.

To create a standalone video by using :

1. In your community, click  > Video .

The Publish a Video page opens.

2. Under Select a Video Source, select Upload. Browse for the video on your
machine, select the file, and then click Open.

The video is uploaded to the community and then prepared for storage. You won't
be able to publish the video until the process is completed.

Once the video is uploaded, the next processing stage star ts. At this time the
video is encoded for storage and playback and three thumbnails are auto-gener-
ated.
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3. If you want to change the video file, wait until the video becomes viewable and
click Change Video on the right, and then repeat Step Step 2 on page 115.

4. Add a title and description for the video.

5. Under Publish Location, select where you want to publish the video.

Note that you cannot publish a video only for yourself.

6. Under Tag This Video, specify the tags for this video.

7. Under Categories, select the categories.

The category selection depends on the publishing location.

8. Under Video Thumbnails, click on one of the available images to be used as the
video cover.
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You can select one of the auto-generated thumbnails or upload your own (click
Upload a Thumbnail and upload the desired cover image). You can upload mul-
tiple images, but only the image you select will be used as the thumbnail – it is
framed with a blue outline. In the example above, the first image is selected.
Other uploaded images are discarded when you save the video.

By default, the video thumbnail should be at least 640 pixels wide with the file
size less than 2 MB in one of the supported formats: JPG (.jpeg, .jpg), static GIF
(.gif), BMP (.bmp), PNG (.png). Animated GIFs are not supported. For the best
fit, it should be rectangular with a 4:3 ratio. Images with other proportions are
automatically adjusted to fit.

9. Under Caption / Transcription Options, choose one of the options for caption
/ transcription:

• If you don't need captions / transcriptions, choose No Caption / Transcription.

• If you want to have captions / transcriptions auto-generated and select the
original video language from the list, choose Auto Caption / Transcription.

Note:  If auto-generating captions / transcriptions is disabled, you won't see
this option but you can upload prepared captions / transcriptions anyway.
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• If you want to use prepared caption / transcription files in one or several
languages, choose Upload Caption Translation File. Then upload the caption
/ transcription files marking each with the language it has been designed for.

10.Click Publish.

Note that this button is unavailable until the video is fully uploaded.

When you click publish, you star t the next – complex – stage of the video processing.
During this stage, the speech in the video is converted to text and translated to the
required languages. Processing may take some time; the video duration, the number
of captions to be generated, and the general service availability may affect the
overall time.

Which files are auto-generated depends on your community configuration. If trans-
lations are enabled for your community:

• If you selected Auto Caption / Transcription, Jive generates all caption /
transcription files for the languages configured for translations.

Later you can download the autogenerated caption / transcription file, edit it in a
text editor, and upload it back.

• If you selected Upload Caption / Translation File and uploaded one or more
custom caption / transcription files, Jive generates files for all languages
configured for translations.
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If translations are disabled for your community:

• If you selected Auto Caption / Transcription, Jive generates only caption /
transcription file for the source language of the uploaded video.

• If you selected Upload Caption / Translation File and uploads one or more
custom caption / transcription files, Jive keeps the uploaded files only and does
not generate any additional translations.

After the processing is finished successfully, the video appears in News and activity
feeds. The video also appears in searches, and you can search not only the title
and description but also captions / transcriptions if they are available for the video.

For detailed information about uploaded standalone video processing, see About
Jive Video provider on page 142.

Embedding standalone videos to the community (with )
Use the create menu  to embed videos from other sites as new standalone videos

 for your community.

These videos are published as the Video content type  and are visible when you
browse community content as separate content items.

For more information about the requirements for video files, images for thumbnails,
and caption files, see Supported video providers and formats on page 145.

To embed a standalone video from another site by using :

1. In your community, click  > Video .

The Publish a Video page opens.

2. Under Select a Video Source, click Embed.

3. Enter the URL of the video you want to add and click Embed.
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The video is displayed and you can check it before publishing.

4. If the URL is incorrect or you want to embed another video, click Change video
on the right and repeat Steps Step 2 on page 119 and Step 3 on page 119.

5. Add a title and description for the video.

6. Under Publish Location, select where you want to publish the video.

Note that you cannot publish a video only for yourself.

7. Under Tag This Video, specify the tags for this video.

8. Under Categories, select the categories.

The category selection depends on the publishing location.

9. Click Publish.

The video becomes available immediately after you publish it.

Inserting inline videos into content items and comments
You can add a new or existing video to a content item or a comment or reply in your
community.

Unlike standalone videos, uploading inline videos does not support caption / trans-
lation functionality. This means that you won't be able to auto-generate or add a
custom caption / translation file to an uploaded inline video. Instead, you can publish

120AUREA CONFIDENTIAL

Chapter 1: Using a Jive community



To add a video in comments or content:

1. In the toolbar of the content editor, click .

The Insert Video box opens.

2. To upload a video:

a) Select the Upload, Record or Embed tab at the top of the box.
b) Click Upload, browse for the video on your machine, select the file, and then

click Open.

This star ts the video uploading.

c) If you want to change the video (if, for example, you uploaded a wrong file),
wait until the uploading finishes, click Change video on the right and repeat
Step Step 2.b on page 121.

d) After the upload completes, click Insert Video to add a video.

The dialog box is closed and the video is added to your comment.

3. To embed a video from another site:

a) Click Upload or Embed at the top of the box, then click Embed.
b) Paste the URL of the video and click Import Video.
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c) After video import completes, click Insert video.

The dialog box is closed and the video is added to your comment.

4. To embed a video from the community:

a) Click Browse <community> Videos at the top of the box.
b) Find the video you want to add.

By default, the list contains all available videos, both standalone and embedded
into other content or comments. You can list through the pages by using arrows
at the bottom of the box.
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You may find the following filtering and sor ting options useful to find the neces-
sary one:
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Filters the results by the text you type. The search is
done through all available video metadata. This filter also
removes all embedded videos from the list.

Type to filter by
text

Sorts the videos by their duration.Length

Sorts the videos by the time when they were created.Creation

Filters the list by author: you (Just me) or anyone in the
community (Anyone).

Created by

Filters the list by where it is published: in the space you
are in (by place name) or anywhere in the community
(Anywhere).

Created in

c) Once you have found the video, click on it, and then click Insert Video at the
bottom of the box.

The dialog box is closed and the video is added to your comment.

5. Once you see your video in the comment, you can click Add comment, Publish,
Create Document, or Post.

Viewing videos
Here you can find an overview of the options available when viewing videos.

The options listed here apply to uploaded videos: standalone, inline, and standalone
embedded as inline. Depending on the community configuration, the video settings,
and how they were uploaded, some of the options may be unavailable.

Videos embedded from third-party providers, such as YouTube or Vimeo, use the
functionality of the video source, and the experience with such videos differs.
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Viewing videos with captions and transcriptions
If a video has captions / transcriptions, you can view it with captions or transcriptions
(or both) turned on.

Captions appear on the video itself, while transcripts appear next to the video. You
can select if you want to view a video with captions or transcriptions (or both) and
the languages and the languages they should be displayed in.
Figure 12: A video with captions and transcription turned on

To turn captions on:

• While viewing a video, click  and select a language from the available list.

To turn captions off:

• While viewing a video, click  and select Captions off.

To toggle transcriptions:

• While viewing a video, click .

To change the transcription language:

• While viewing a video, click  and select a language from the list.

How captions look in the video player can be additionally configured.

Changing the video quality
By default, videos are played with the best quality fitting for the device you are using
and the capacity of your internet connection.

To change the video quality:

• While viewing a video, click  and select the desired quality.
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• Select auto to return to the default setting.

Changing playback speed
You can choose to watch videos at faster or slower speeds.

To adjust playback speed:

• While watching a video, click  and select the desired speed.

Viewing at fullscreen
Viewing a video on fullscreen is more comfortable at times.

• While viewing a video, click  to switch to the fullscreen mode.

• To switch back, click  or press Esc.
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Viewing in the picture-in-picture mode
With picture-in-picture enabled, you can continue viewing a video while switching
to another document or application.

The video is played in a special mini box. It stays on top of all other documents and
applications and you can drag it to any place on your screen.
Figure 13: Picture-in-picture mode on

To switch to the picture-in-picture mode:

• Open a video and click  and drag the miniaturized video to a place on your
screen where you'll comfor table watching it.

To turn the picture-in-picture mode off:

• Click  on the miniaturized video OR

• Click  on the video tab.
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Configuring captions in the video player
Captions are displayed over a video and at times you may want to configure them
to be comfortable to read.

To configure captions:

1. While viewing a video, click  and select caption settings.
Figure 14: Caption settings

2. Specify color and opacity for the caption text, text background, and window.

In the example above, the text color is set to yellow, the background color
to red, and the window color to cyan.

3. Specify the size, edge style, and type for the font.

In the example above, the text size has been increased, the edge style set to
raised, and the font type changed to monospace.

4. Click Done to save the changes and continue watching the video.

Note: These settings apply only to the video you are currently viewing.

To restore the default settings:

1. While viewing a video, click  and select caption settings.

2. Click Reset to restore the settings.

3. Click Done to save the changes and continue watching the video.
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Jive video player interface
Here you can find the details of the video player.

Figure 15: Video player overview

10987654321

Viewer does not support full SVG 1.1

Toggles video playback.(1) Play/Pause

Adjusts the volume for the player. You can also mute it completely.
Figure 16: Adjusting volume

(2) Volume/Mute

Shows which part of the video you are viewing.(3) Video track

Shows the time before the video end. In this example, the video would end in 1
minute 51 seconds.

(4) Video
duration

Toggles video playing speed. You can speed videos up or slow them down as
required. The normal speed is 1x.
Figure 17: Adjusting the playback rate

(5) Playback rate

Toggles captions and allows configuring how captions are displayed.(6) Captions
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With captions enabled, the video would look like this:
Figure 18: Captions example

You can turn on captions in one of the available languages (if any), turn them off
completely (captions off). You can also configure how captions are displayed on
the interface by clicking caption settings and adjusting the settings.
Figure 19: Selecting captions

130AUREA CONFIDENTIAL

Chapter 1: Using a Jive community



With the caption settings, you can make them easily readable for you. In the exam-
ple below, the font is changed and its size is increased, the text and text boxes
are colored to make the text stand out. And you want to restore the default settings,
click Reset.
Figure 20: Caption settings

Toggles picture-in-picture mode when you can switch to another document or
application while still viewing the miniaturized video.

(7)
Picture-in-picture

Toggles the fullscreen mode. Click the button again or press Esc or F11 to switch
back to the normal-sized video.

(8) Fullscreen /
Inline

Toggles the quality of the video.
Figure 21: Adjusting video quality

(9) Quality

With the auto setting enabled, the playback is adjusted to the best quality depending
on your screen resolution and the internet connection speed. You can select another
setting manually if you want to.
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Toggles transcriptions.
Figure 22: A video with transcription

(10)
Transcription

You can select which language you want to use or turn them off completely.
Figure 23: Selecting a transcription

Editing standalone videos
If you created a video and then found that you need to change it – add a better
thumbnail, for example – you can edit the video.

Standalone uploaded videos can be edited similarly to other content types. You can
change the video, title and description. Additionally, for uploaded videos, you can
choose another thumbnail and add or replace caption / transcription files.

Editing uploaded videos has some notable distinctions. The video may be processed
anew even if you do not upload a new video file; this is required to correctly update
all content files and metadata of the video. Until the processing is completed (which
may take some time), the video will be available only by its direct URL. Besides
that, even though the version counter is updated when you save the changes, Jive
does not keep previous versions of the video content, including the video itself and
its related files. That is, you will not be able to restore any of the previous versions
for a video. For more information on video processing when editing uploaded videos,
see About Jive Video provider on page 142.
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To edit a video:

1. Open the video  you want to edit.

2. Click Edit.
3. Make the desired changes.

4. Click Update.

The video becomes available once the processing is finished.

Downloading videos
You can download standalone uploaded videos and their captions / transcriptions
as long as you have permission to access the videos.

You can store community videos on your mobile device or computer – for example,
for use when you are not connected to the internet. You can only download stan-
dalone uploaded videos – that is, videos uploaded from  > Video > Upload a
Video . Videos are downloaded in the MP4 (.mp4) format.

You can also download caption / transcription files that are available for the videos.
A video can have a file in every language supported for captions / transcriptions in
your community. Captions / transcriptions are downloaded in the WebVTT (.vtt)
format.

Note that video downloads may be forbidden in your community. In this case, you
won't see the downloading link when viewing videos.

Important:  Jive is migrating from the Perceptive Media provider to the Jive video
provider. Options and configuration relevant only for the Perceptive Media provider
are marked with (Perceptive). They will be removed once the migration is finished.
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To download standalone uploaded videos:

1. Go to the video you want to download.

Figure 24: Downloading Options

2. To download the video, click Download > source  to the right of the video, and
then select where to save the file.

3. To download captions / transcriptions, click Download > Caption - <language>
for every language you need, and then select where to save the file.

4. To download the video(Perceptive), click Actions > Download video , and then
select where to save the file.

The selected files are downloaded to your computer.

Captions / transcriptions in standalone uploaded videos
A video can have a caption / transcription in every language supported for captions
/ transcriptions in your community, maximum one file for each language. Here you
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can find details on adding captions / transcriptions to videos and using them when
watching videos.

Jive Video provider support captions / transcriptions that convey what is being said
in the video. In the video player, captions are displayed over the video while tran-
scriptions – next to it. Some of the options described here may not be available in
your community due to custom community configurations.

Note that embedding videos from third-party providers, such as YouTube or Vimeo,
employs another process and the experience with such videos differs.

Adding and changing captions / transcriptions
You can add captions / transcriptions to standalone videos when uploading a new
video or later when editing it. You can also choose to generate captions /
transcriptions by using speech recognition technology.

To add or replace captions / transcriptions to an uploaded video:

1. If you are uploading a new video: Upload a new standalone video by using 
> Video .

2. If you are editing an existing standalone video: Open the video and click Edit.
3. Choose one of the options for adding or changing captions:

• If you want to have captions / transcriptions auto-generated and select the
original video language from the list, choose Auto Caption / Transcription.

Note:  If auto-generating captions / transcriptions is disabled, you won't see
this option but you can upload prepared captions / transcriptions anyway.

• If you want to use prepared caption / transcription files in one or several
languages, choose Upload Caption Translation File. Then upload the caption
/ transcription files marking each with the language it has been designed for.
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4. Click Publish / Save to save the video.

After you save the changes, the video undergoes the complex processing, and
captions / transcriptions are updated or generated per your choice.

Which files are auto-generated depends on your community configuration. If trans-
lations are enabled for your community:

• If you selected Auto Caption / Transcription, Jive generates all caption /
transcription files for the languages configured for translations.

Later you can download the autogenerated caption / transcription file, edit it in a
text editor, and upload it back.

• If you selected Upload Caption / Translation File and uploaded one or more
custom caption / transcription files, Jive generates files for all languages
configured for translations.

If translations are disabled for your community:

• If you selected Auto Caption / Transcription, Jive generates only caption /
transcription file for the source language of the uploaded video.

• If you selected Upload Caption / Translation File and uploads one or more
custom caption / transcription files, Jive keeps the uploaded files only and does
not generate any additional translations.

For more information on how videos are processed, see About Jive Video provider
on page 142.
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Viewing videos with captions and transcriptions
If a video has captions / transcriptions, you can view it with captions or transcriptions
(or both) turned on.

Captions appear on the video itself, while transcripts appear next to the video. You
can select if you want to view a video with captions or transcriptions (or both) and
the languages and the languages they should be displayed in.
Figure 25: A video with captions and transcription turned on

To turn captions on:

• While viewing a video, click  and select a language from the available list.

To turn captions off:

• While viewing a video, click  and select Captions off.

To toggle transcriptions:

• While viewing a video, click .

To change the transcription language:

• While viewing a video, click  and select a language from the list.

How captions look in the video player can be additionally configured.
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Configuring captions in the video player
Captions are displayed over a video and at times you may want to configure them
to be comfortable to read.

To configure captions:

1. While viewing a video, click  and select caption settings.
Figure 26: Caption settings

2. Specify color and opacity for the caption text, text background, and window.

In the example above, the text color is set to yellow, the background color
to red, and the window color to cyan.

3. Specify the size, edge style, and type for the font.

In the example above, the text size has been increased, the edge style set to
raised, and the font type changed to monospace.

4. Click Done to save the changes and continue watching the video.

Note: These settings apply only to the video you are currently viewing.

To restore the default settings:

1. While viewing a video, click  and select caption settings.

2. Click Reset to restore the settings.

3. Click Done to save the changes and continue watching the video.

Downloading captions / transcriptions
You can download captions / transcriptions of a standalone uploaded video as long
as you have permission to access the video.

You can download any or all available caption / transcription files. If you need to
make changes to auto-generated captions, you can download the caption file and
edit it before uploading it back to your video.

Caption / transcription files are downloaded in the WebVTT (.vtt) format.

Note that video downloads may be forbidden in your community. In this case, you
won't see the downloading link when viewing videos.
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To download the caption / transcription files of a video:

1. Open the video.

2. For every language you need, select Download > Caption - <language>  to the
right and specify where to save the file.

Figure 27: Downloading Options

The selected files are downloaded to your computer.

Captions in inline videos

If you need to have captions in an inline video, you can upload it as a
standalone video, and then insert it into your blog post or document.
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Adding captions / transcriptions to uploaded inline videos in content items and
comments is not supported. At the same time, an uploaded standalone video amounts
to a separate item that can be embedded into other content items similar to how
you can embed a YouTube video. When embedded, such videos can be played with
captions enabled.
Figure 28: A community-published video that is embedded in a document

For more information about embedding community-published videos, see Inserting
inline videos into content items and comments  on page 120.

Featuring videos in places
If you featured a video in your place, the users see the featured video in the Featured
Content and Featured Video tiles and widgets on the place pages.

You need to be the place owner or administrator to feature the videos.

To feature a video:

1. Go to the place.

2. Click Videos.

3. Select either the video you want to feature or Video under  and upload a new
video.
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4. Under Actions, click Add to featured content.
5. If you no longer want a video to be featured, you can select Remove from featured

content.

Important: We do not recommend that you use widgets and widgetized Overview
pages (including the Home page) in your community. For more information, see
Understanding pages in places.

Removing videos from Top and Trending
If you do not want your video feature in the trending lists of your community, you
can remove this video from the global lists.

Content authors and users with the Manage Users, Manage Community, Manage
System, or Full Access permissions can remove a content item from Top and
Trending lists. For more information, see Removing content items from Top and
Trending on page 76.

To remove a video from Top and Trending lists

1. Go to the video.

2. Click Actions > Remove from Top & Trending .

To add a video to Top and Trending lists

1. Go to the video.

2. Click Actions > Allow in Top & Trending .

Deleting videos
If required, you can delete uploaded videos.

When you delete a video, all video content, including the video file itself and the
related metadata, is deleted. You will not be able to restore a deleted video.

To delete a standalone video:

1. Open the video  you want to delete.

2. Click Actions > Delete , then confirm your decision.

The video is deleted.

To delete an embedded video:

1. Open the content item or comment in which the video is embedded.

2. Click Edit.

3. Select and delete the video.

4. Click Update.

The content item or comment is updated accordingly.
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About Jive Video provider
The Jive Video provider is used when you upload videos and view them directly in
the community. This provider supports automatic speech recognition with the
generation of captions / transcriptions and their translations to a number of
languages. Here you can find an overview of how the provider works.

The Jive Video provider blends AWS Elemental MediaConvert, AWS Transcribe,
AWS Translate with the native Jive functionality. Jive Video provider supports:

• Thumbnails. You can select one of the auto-generated ones or upload your
custom images.

• Captions / transcriptions and translations. Captions / transcriptions in the
video language and translated to other languages can be generated automatically
or you can upload your own prepared files.

• Video downloads control. Video and caption / transcription downloads can be
enabled or disabled for the community.

• Video player enhancements. Several options are available for users: time-indexed
transcriptions, playback speed and quality options, customizable texts. This allows,
for example, to get quality videos on different devices with the transcriptions
displayed alongside the video.

Note that embedding videos from third-party providers, such as YouTube or Vimeo,
employs another working process, and the experience with such videos differs.

A shortlist of video terms

Here you can find the basic video terminology that is used when talking about the
Jive Video provider.

A text representation of the audio in the video. Captions
usually describe what is being said.

Caption

A text version of all of the words spoken in the video. In Jive,
transcription is a visual representation of a caption file.

Transcription

Video and related files uploaded by the user directly or
created as an outcome of video processing, for example,
captions and thumbnails.

Video content

A static image that is displayed as the video cover. For
example, thumbnails are displayed instead of videos in News
and activity feeds.

Thumbnail

The process of converting the video file into the required
format for storage.

Transcoding

The process of converting speech to text.Transcribing

Formats and limitations

You can find information about supported video and caption / transcription formats
at Supported video providers and formats on page 145.
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How videos are processed: Uploading new standalone videos

Generally, every uploaded video file goes through the following steps.
Figure 29: Video processing with the Jive Video provider

Basic video processing

Uploaded video

Transcoded video for st...ThumbnailsTranscoded video...

  Transcoding job

Complex video processing

User starts upload... Uploading video job

Translated captions Prepared captions

Caption config job

Transcoded video

Transcripted original caption

    Transcription job        Translation job

Transcripted original caption Original and translated...

Video content objects

Jive video processing jobs

Prepared captions

User views, edits, se...

User clicks Publish

Viewer does not support full SVG 1.1

1. A user uploads a video file.

2. Basic processing star ts immediately after the file uploading finishes.

During this stage, the video is converted to the storage format (MP4) and the
streaming format (CMAF), and three thumbnail images are generated. While the
video is processed, the Publish button is unavailable.

Note:  All video content is stored in the geographic region associated with your
organization.

3. While the file is uploading, the user can add the metadata: type a title and
description, add a custom image to be used as a thumbnail, select one of the
caption / transcription options, and upload any prepared caption / transcription
files if required.

• If the auto-generated thumbnails are not satisfactory, the user can upload and
use a custom image as the thumbnail.

• Only one selected image (the one with the border around it) will be used as
the video thumbnail.

• If caption / transcription files are uploaded for any of the available languages,
these caption / transcription files will be used; they won't be auto-generated.

4. Once all required metadata is filled in and the basic processing is over, the Publish
button becomes available and the user publishes the video.

5. This star ts the complex video processing.

Complex processing includes converting speech to text and recognizing it, gener-
ating translations, and preparing captions / transcriptions so that they could be
used on the interface. The processing time varies depending on the video size
and the queue for AWS services at that time.
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Note that even though the video is already uploaded and you can even view it, it
is accessible only by its direct URL during this stage.

6. Jive processes the uploaded video as any other content item.

The major point of this step is adding all video metadata – both user-provided
and auto-generated during basic and complex processing – to the search index.

7. Once all processing tasks are finished, the video becomes accessible through
the interface, appears in feeds and searches.

How videos are processed: Uploading new inline videos

Unlike standalone videos, uploaded inline videos are processed using a limited
version of the uploaded standalone video processing. Consequently, uploaded inline
videos have the following distinctions:

• Inline videos are not transcribed and do not have any captions / transcriptions
including translated ones.

• The first of the auto-generated thumbnails is displayed when the containing item
is loaded.

Note that uploaded standalone videos can be inserted as inline videos as well. If
such a video has captions, users will be able to view the video with captions; tran-
scriptions are not supported. For more information, see Captions / transcriptions in
standalone uploaded videos on page 134 and Inserting inline videos into content
items and comments  on page 120.

How videos are processed: Editing videos

You can edit uploaded standalone videos as any other content item. Embedded and
uploaded inline images cannot be edited directly; but you can edit the containing
content item or comment, delete the video in the text editor and then add another
video.

When an uploaded standalone video is edited, it undergoes a process that is similar
to a new video upload. However, some of the processing stages may be omitted if
they are not necessary. The following describes the main video editing steps and
which processes may be invoked on each step.

1. A user opens a video for editing and makes changes.

If the user uploads a video file – be it a new version of this video or another video,
– the video will undergo basic processing during this step.

Alternatively, if the user edits only the video metadata (for example, renames the
video), the video is not processed during this step; basic processing is skipped.

2. The user clicks Update.

3. If any present changes may affect the results of the previous complex processing
of the video, clicking Update invokes complex processing for this video. Otherwise,
this step is skipped.

Either user actions or community configuration changes (or both) may cause a
repeat of complex processing when editing videos. For example, a video has been
uploaded when video translations were disabled – and this video does not have
any automatic translations. Later video translations were enabled for the commu-
nity. So, if you edit this video, it will undergo complex processing.
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The following changes invoke complex processing:

• User-related changes:

• The user uploads a new video file, either another version of the existing
video or a new video.

• The user uploads new custom caption / transcription files, either replacing
previously uploaded files or adding new ones for other languages.

• The user changes the video caption / transcription option.

• The user changes the source language of the video.

• Community configuration changes:

• Translations have been enabled or disabled for the community.

• The target languages have been changed for the community.

When complex processing is triggered, all previously generated files are deleted
and the video is processed as if it was a new video. Jive keeps only user-uploaded
thumbnails and captions / transcriptions.

Attention:  Jive does not keep the previous versions of video files.

4. Jive processes the uploaded video as any other content item.

5. After the processing finishes, changes are saved, and metadata updated, the
video becomes fully available in the community. The version number on the video
is updated.

How videos are processed: Deleting videos

When a video is deleted, all video content is deleted including the user-uploaded
thumbnails and captions / transcriptions.

Supported video providers and formats
Jive supports embedded and uploaded videos in content, comments, replies, and
standalone videos.

Important:  Jive is migrating from the Perceptive Media provider to the Jive video
provider. Options and configuration relevant only for the Perceptive Media provider
are marked with (Perceptive). They will be removed once the migration is finished.

Supported video providers

Uploaded standalone video (videos created from the pencil icon) sources:

• Jive Video provider for uploaded videos. For more information, see About Jive
Video provider on page 142.

• Perceptive Media for uploaded videos (Perceptive)
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Embedded sources for both standalone videos and inline in the body of other content
types:

• Any Embedly supported sources, such as YouTube or Vimeo. For their complete
list, see http://embed.ly/providers.

Custom support for the following sources:

• Brightcove - New Studio

• Kaltura Cloud

• Google Drive

Supported formats for uploaded videos

MP4 (.mp4), AVI (.avi), MOV (.mov), MPEG (.mpg, .mpeg)Supported video
formats By default, a video file selected for upload must be less than

2 GB and no longer than 4 hours. These settings may be
adjusted for your community. For the details, contact your
community administrator.

WebVTT (.vtt), DFXP (.dfxp), SRT (.sr t), SAMI (.sami, .smi),
SCC (.scc), TTML (.ttml)

Supported caption /
transcriptions file
types By default, the caption / transcription file size must not

exceed 10 MB. These settings may be adjusted for your
community. For the details, contact your community
administrator.

JPG (.jpeg, .jpg), static GIF (.gif), BMP (.bmp), PNG (.png)Supported image
formats for
thumbnails By default, the video thumbnail should be at least 640 pixels

wide with the file size less than 2 MB. Animated GIFs are
not supported. These settings may be adjusted for your
community. For the details, contact your community
administrator.

Supported formats for uploaded videos (Perceptive)

AVI, MOV, WMV, MP4, MPEG, FLV, 3GP, and 3G2Supported video formats

All of the popular MPEG-4 variants like DivX, XviD,
H.264, 3IVX, MSMPEG4, and Windows Media 9

Supported video codecs

MP2, MP3, WAV, AAC (typically seen in QuickTime
files), Windows Media audio, and for mobile devices
AMR in both narrow-band and wide-band varieties

Supported audio codecs

Video FAQ
Use these frequently asked questions to help you better understand Jive videos.

When you insert a video into content, reply or
comment by clicking Browse <community> Videos,

When adding a video to a
comment, will I see all

you can choose from all videos published to thevideos when I browse Jive
videos? entire community, shared with you, or published to

places you have access to, such as a private group
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you belong to or a space you have permission to
view.

No. You only see standalone videos  here that

you've uploaded by using the create menu ( ).

Should Your avatar > Your
Content > Videos  show all
of the videos I've uploaded?

When you upload videos into content types, they do
not show up in Your Content except as part of that
content type.

Video permissions are consistent with content type
permissions. When you publish a video to a private

Can I mark videos as
private?

place, it is only available to members of that place.
If you publish a video to a select few users, only
they are able to view that video.

Yes, if your administrators allowed embedding
videos from the platform. Note that the URL of the

Can I embed videos from the
Kaltura video platform?

embedded video must include the kaltura.com par t
in order to pass validation for the Kaltura platform.

If you attempt to upload the same video twice and
notice a variance in the time it takes to encode,

Is there a reason why the
same video may take

transcribe or translate it, that is impacted by thedifferent amounts of time to
queue for AWS services at that time. This encodingencode or complete the
time should not vary too significantly but there mightadvanced processing work
be minor discrepancies when uploading the same
video more than once.

(transcription and
translations)?

Yes. There is initial basic processing that transcodes
your video so it can be played. Then there is

Is there a delay between my
video being playable and

secondary, complex processing that’s requiredwhen captions /
before automatic transcriptions and translationstranscriptions and
become available. Processing takes some timetranslations become

available? before an uploaded or edited video becomes
available. For more information, see About Jive
Video provider on page 142.

Even if you upload several images for a custom
thumbnail, only the image you've selected (framed

Why are my thumbnails
missing after publishing the
video? with a blue outline) is saved and used. Other images

are removed from the system.

Copying content
You can copy a document as a new document, discussion, or blog post.

Restriction: You must be able to edit the document you want to copy.
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Copying documents streamlines quite a few use cases, such as the following:

• Copy documents to different places if you want to push out a clean version and
empty comments. This is great for posting release communications to different
audiences, such as customers and partners.

• Use a document as a template that can then be used again and again to easily
recreate documents. This is useful for processes in a company, or templates with
agencies. For more information, see Creating templates on page 148.

• Work privately with your team and then push out a clean copy to the Support
Center or even as a blog post to the News stream.

• Use ghost blogging where the ghostwriter authors the initial version. The publishing
author does a copy-document on the initial version to publish it under their name.

To copy a content item:

1. Go to a document you can edit.

2. Click Actions > Create a Copy  to open the Create a Copy dialog box.

3. Select the content type for the copied item from the available types.

The available options may differ if the place where the original document is stored
does not support some of them, or you don't have permission to publish a par ticular
content type there.

4. Click Create a Copy to create a copy of the document.

5. Edit the new item.

Note that the title, body, and tags have all been pulled in from the original
document. You can edit all of these, as well as change the place for the content
before publishing.

6. When you're finished editing, click Publish.

The new item is created based on the source item.

If you want to create a template from a document, see Creating templates on page
148.

Creating templates
You can use the Create a Copy feature to create templates for yourself or others
to use.

For example, you might want to create a baseline RFP for your salespeople to use
that they can edit and add to before publishing it as a new RFP.

Restriction: You must be able to edit the document you want to copy.

To create a template:

1. Go to a document you can edit.

2. Click Actions > Create a Copy  to open the Create a Copy dialog box.

3. Select the content type for the copied item from the available types.
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The available options may differ if the place where the original document is stored
does not support some of them, or you don't have permission to publish a par ticular
content type there.

4. If you want to use the item as a template, copy the link provided under Create a
Template, and then click Cancel to close the dialog box.

You don't need to publish a copy of this document.

5. Paste the link anywhere in the community, for example, in the Helpful Links tile
in a place that you own.

When a user clicks the link, they are taken to the template (based on your original
document) that they can edit and publish. They can change the title, body text, tags,
and place of the new item; all of these are optional. If they make no changes at all,
the new content is published exactly like the original but with a number inside square
brackets in the title.

Using Marking feature
You can turn a conversation into a real business decision or collaboration success
story.

Collaboration and discussion are free-form in your community, but decisions and
official versions should be marked clearly. The Marking feature allows you and
others to mark items for Action, as a Success, and so on. Visual badges for these
states let others know which document is Final, which comment became the Decision,
or who has Action items as a result of the discussion.

You and other users can mark the replies or comments of:

• Blog posts

• Discussions

• Questions

• Documents

In addition, users with edit permissions on top-level items can mark the items as
Final, Official, Outdated, Success, or for Action.

Your community manager may limit this feature to specific users and configure which
marking options are available in your community.

How Marking adds value
Here's an example of how to effectively use the Marking feature in your community.

Let's say the VP of sales has just published a discussion called "Possible Hotels
for Sales Kickoff." In the post, she has included a list of hotels that are available,
their amenities, and the pros and cons of each. She ends her post by @mentioning
the Sales Kickoff group and inviting comments and opinions about the hotels. Over
the next few days, over fifty comments are posted to the discussion.
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Here's what happens:

1. Two new hotels are suggested. Different thread participants mark those comments
for Action ( Actions > Mark for Action ) and ask the commenters to provide the
hotels' availability, amenities, and pros and cons. Those comments now have
Action Item badges on them. You can click the badge to see any notes included
with the action item.

2. The receptionist replies that she has dealt with Hotel ABC and highly recommends
it.

3. The two new hotels that were suggested are now included in the list, and those
actions have been resolved by their owners ( Action Item > Resolve ).

4. Based on the receptionist's and others' positive comments about Hotel ABC, the
VP of sales decides that it's the best hotel for the Sales Kickoff. She adds a final
comment to the thread explaining her decision and then marks it as the Decision
( Actions > Mark as Decision ).

5. Now, the VP marks the entire discussion as Final to let future readers know that
the post has been discussed and decided on. At the top of the discussion, the
Final badge is now displayed.
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Who can mark and unmark?
Different types of users have different permissions to mark and unmark items. The
following tables list who can do what for comments, replies, and top-level items, as
well as other rules of marking.

For comments and replies

Can Comm
Mgr globally

disable?

Mark depen-
dencies

Require-
ments / op-

tions

Who can un-
mark

Who can
mark

YesNoneNote is re-
quired

Original
marker, edi-
tor of top-
level item

All usersMark as Deci-
sion

YesUnmarking
moved to Re-
solved list

Note is re-
quired, share
is optional

Not availableAll usersMark for Ac-
tion

YesUnmarking
moved to Ac-
tion item

Note is re-
quired

Original
marker, ac-
tion partici-
pant

All usersMark as Re-
solve

YesNoneNote is re-
quired

Original
marker, edi-
tor of top-
level item

All usersMark as Suc-
cess
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Can Comm
Mgr globally

disable?

Mark depen-
dencies

Require-
ments / op-

tions

Who can un-
mark

Who can
mark

NoNoneNoneOriginal
marker, edi-
tor of top-
level item

All usersMark as
Helpful

YesNoneOnly avail-
able on
questions

Editor of top-
level item

Editor of top-
level item

Mark as Cor-
rect

Editors are users with permissions to edit the top-level content item. These users
can see the Edit option in the Actions menu of the right sidebar when viewing the
content item.

For top-level items (blog posts, discussions, questions, and documents)

Can Comm
Mgr globally

disable?

Mark depen-
dencies

Require-
ments / op-

tions

Who can un-
mark

Who can
mark

YesUnmarking
moved to Re-
solved list

Note is re-
quired, share
is optional

Not availableAll usersMark for Ac-
tion

YesUnmarking
moved to Ac-
tion item

Note is re-
quired

Original
marker, ac-
tion partici-
pant

Original
marker, ac-
tion partici-
pant

Mark as Re-
solve

YesNoneNote is op-
tional

Original
marker, edi-
tor of top-
level item

All usersMark as Suc-
cess

YesMutually ex-
clusive with
Official and
Outdated

NoneOriginal
marker, edi-
tor of top-
level item

All usersMark as Fi-
nal (discus-
sions and
documents
only)

YesMutually ex-
clusive with
Official and
Final

URL is op-
tional

Original
marker, edi-
tor of top-
level item

All usersMark as Out-
dated (dis-
cussions,
questions,
and docu-
ments only)

YesMutually ex-
clusive with
Final and
Outdated

NoneOriginal
marker, edi-
tor of top-
level item

All usersMark as Offi-
cial (discus-
sions, ques-
tions, and
documents
only)
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Can Comm
Mgr globally

disable?

Mark depen-
dencies

Require-
ments / op-

tions

Who can un-
mark

Who can
mark

YesNoneAvailable on
documents
only

Original
marker

All usersMark as Re-
served (docu-
ments only)

NoNoneAvailable on-
ly on ques-
tions

Original
marker

All usersMark as I
have the
same ques-
tion (ques-
tions only)

NoNoneAvailable on-
ly on ques-
tions

Editor of top-
level item

Editor of top-
level item

Mark as As-
sumed An-
swered
(questions
only)

Editors are users with permissions to edit the top-level content item. These users
can see the Edit option in the Actions menu of the right sidebar when viewing the
content item.

Searching for marked content
Marks are ranked differently in search results and have varying visibility options.
The following tables list the visibility and searching options of marks for comments,
replies, and top-level items.

For comments and replies

Can Comm
Mgr globally

disable?

Has a dedi-
cated tile?

Appears in
content,
people,
places

browse UIs?

Search
rankings in-

fluenced?

Appears in
Searched?

YesYesYesPositivelyYesMark as Deci-
sion

YesYesYesNoneYesMark for Ac-
tion

YesYesYesNoneYesMark as Re-
solve

YesNoYesPositivelyYesMark as Suc-
cess

NoNoYesNoneNoMark as
Helpful

YesYesYesNoneNoMark as Cor-
rect
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For top-level items (blog posts, discussions, and documents)

Can Comm
Mgr globally

disable?

Has a dedi-
cated tile?

Appears in
content,
people,
places

browse UIs?

Search
rankings in-

fluenced?

Appears in
Searched?

YesYesYesNoneYesMark for Ac-
tion

YesYesYesNoneYesMark as Re-
solve

YesNoYesPositivelyYesMark as Suc-
cess

YesYesYesPositivelyYesMark as Fi-
nal (discus-
sions, ques-
tions, and
documents
only)

YesNoNoNegativelyYesMark as Out-
dated (dis-
cussions,
questions,
and docu-
ments only)

YesNoYesPositivelyYesMark as Offi-
cial (discus-
sions, ques-
tions, and
documents
only)

YesNoYesNoneNoMark as Re-
served (docu-
ments only)

NoNoNoNoneNoMark as I
have the
same ques-
tion (ques-
tions only)

NoNoNoNoneNoMark as As-
sumed An-
swered
(questions
only)

Marking comments and replies
You can mark the comments or replies of discussions, documents, or blog posts in
places where you have permission to comment or reply. After you mark an item,
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you see a badge on it. This helps others quickly see what has been decided on or
a success, for example.

To mark a comment or reply:

1. Go to a discussion, question, document, or blog post and read through the
comments or replies.

2. Select the mark you want.

The options are listed in the table below. You may not see all of these depending
on how your community manager has set up the marking feature. For more infor-
mation, see Marking options for comments and replies on page 156.

DescriptionOptions

This mark shows others that this comment or reply
needs action. You can mark for action for yourself
this or, optionally, bring in other par ticipants and leave
them a note describing what you need them to do.

Actions > Mark for
Action

This mark shows others that this comment or reply is
a Decision. Note that there can be more than one
comment or reply marked as Decision.

Actions > Mark as
Decision

This mark shows others that the comment or reply
was a collaboration success story for your community.

Actions > Mark as
Success

This mark lets others know that this comment or reply
contains helpful information.

Helpful

Only system administrators, place owners, and
discussion authors can see the Correct Answer mark
option and only on questions.

Correct Answer
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Note the new badge on the comment or reply. If you change your mind later, just
click Unmark on this same item.

Marking options for comments and replies
You can mark a comment or reply Helpful, Correct, Decision, Success, for Action,
or Resolved. You may see all or only some of these marking options, depending on
how your community manager has configured this feature.

Note: The Marking feature is different from Tasks, which are a formal way to assign
work tasks to people. For more information, see Mark for Action or assign a task?.

When you mark a comment or reply, a badge appears that displays its state (for
example, Helpful or Decision). These badges are visual indicators only; they do not
prevent anyone from fur ther commenting or marking any comments or replies as a
Decision, Helpful, Resolved, Success, or for Action.

To see who marked the comment or reply and when, click its badge.

You may see all or only some of the following marking options, depending on how
your community manager has configured this feature.

Choose Mark for Action to assign an action to yourself, and,
optionally, bring in others. When you bring in others to help, note

Mark for
Action

that doing so doesn't assign the Action item to them; it sends a
notification to their Inbox about the action item. From there, they
can Take Ownership of the action item.

The Action Item badge on the comment or reply lets readers know
that the item has been assigned to someone. Other users may
Mark for Action other comments or replies as well.

For more information on how to resolve your actions, see Resolving
action items on page 163.

Choose Resolve on an Action (whether you own it or not) when
you have completed the action. This lets others know that you've
taken care of the issue.

Resolve

Choose Mark as Decision to let others know that this comment or
reply is the Decision or one of the Decisions. Other users may
mark other comments or replies as the Decision as well.

Mark as
Decision

Choose Mark as Success to let others know that this was a
collaboration success story for your community.

Mark as
Success

Click Helpful to let others know that this comment or reply contains
helpful information.

Helpful

Only system administrators, place owners, and discussion authors
can see the Correct Answer mark option and only on questions.

Correct
Answer
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There can be only one Correct Answer. In addition, your community
manager may disable this feature altogether.

Marking top-level items
You can mark a top-level item (a blog post, discussion, question, or document) if
you have edit permissions for it.

To mark a top-level item:

1. Go to the discussion, question, document, or blog post for which you have edit
permissions.

2. In the Actions menu, select the Mark as option you want.

You may see not all or any of these depending on how your community manager
has set up the marking feature.

Note the new badge at the top of the content item. If you change your mind later,
you can always Unmark from the right side of the badge box.

For the list of marking options, see Marking options for top-level items on page 157.

Marking options for top-level items
You can mark a top-level item (a blog post, discussion, or document) if you have
edit permissions for it.

Note: The Marking feature is different from Tasks, which are a formal way to assign
work tasks to people. For more information, see Mark for Action or assign a task?.

You mark a top-level item from its Actions menu. You don't see this menu if you
don't have edit permissions on the item.

After you mark a top-level item, a badge appears that displays its state (such as
Final or Outdated). These badges are visual indicators only; they do not prevent
anyone from fur ther commenting or marking any comments or replies as a Decision,
Helpful, Resolved, Success, or for Action. If you want to prevent fur ther replies on
a discussion or question, click Lock under the Actions menu.

You may see all or only some of the following marking options, depending on how
your community manager has configured this feature.

Choose Mark for Action to assign the item to yourself
or others. The Action Item badge lets others know
that the content item is being reviewed.

Mark for Action
(discussions, questions,
documents, and blog posts)

Choose Resolve on an Action when you have
completed it. This lets others know that you've taken
care of the issue.

Resolve (discussions,
questions, documents, and
blog posts)
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Choose Mark as Final to let others know that the
conversation is complete and no fur ther discussion

Mark as Final (discussions,
questions, and documents)

is encouraged. If you mark something Final, you
cannot also mark it Outdated or Official.

Choose Mark as Official to let others know that this
is the official version of this item. This can be helpful

Mark as Official
(discussions, questions,
and documents) for policies and company-wide communications such

as the 2014 Holidays in an HR space or the
company's Mobile Purchasing Policy. If you mark
something Official, you cannot also mark it Final or
Outdated.

Choose Mark as Outdated to let others know that this
is old information and no longer valid. This can be

Mark as Outdated
(discussions, questions,
and documents) helpful for old procedures, policies, and processes

such as 2011 Health Plan Coverage or Engineering
Intern Projects 2012. If you mark something Outdated,
you cannot also mark it Final or Official.

Marking an uploaded file or a document as Reserved
indicates that someone is currently editing it, so other

Mark as Reserved
(documents and uploaded
files) users don't edit it until the Reserved badge is

removed. It does not actually lock the file or
document.

Choose Mark as Success to let others know that this
was a collaboration success story for your community.

Mark as Success
(discussions, documents,
and blog posts)

Choose this to let others know you have the same
question. You see this only on questions that do not

I have the same question
(questions only)

yet have a reply marked as the Correct Answer or
Assumed Answered.

Choose this to let others know that the question is
assumed answered. You see this only on questions

Mark as Assumed
Answered (questions only)

that do not yet have a reply marked as the Correct
Answer.

Mark for Action or assign a task?
You should understand the differences between Mark for Action and creating tasks
and the best ways to use these features.

Mark for Action is par t of the Marking feature and allows you to assign
content items to yourself for action, or invite others to review them and

Actions

take ownership. Typically, you should use Mark for Action in an informal,
on-the-fly manner when you're discussing something. For more
information, see Using Marking feature on page 149.
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Tasks are a formal way to assign and track tasks for yourself or others

(  > Task  or Actions > Tasks > Create a task ). You can assign the

Tasks

task a deadline and associate it with a project, such as Sales Kickoff
January 2015, or save it as a personal task for yourself. All tasks that
are associated with a project are displayed on the Tasks tab of the
project. For more information, see Using projects and tasks on page 177.

Mark as Decision or Correct Answer?
Understand the differences between Decisions and Correct Answers and the best
ways to use these features.

Mark as Decision is designed to help you take control of a conversation
in the comments section of a discussion, document, or blog post. Users

Decisions

can easily Mark as Decision, or Mark for Action to send it to someone
else for review.

The Final and Official marks for a top-level item (discussion, question,
document, or blog post) are additional ways to let users know that a
decision has been reached and no fur ther discussion is needed.

More than one comment or reply per discussion, document, or blog post
may be marked as a Decision, Success, or for Action.

Note that you may see all, some, or none of these marking options,
depending on how your community manager has configured this feature.

When the Correct Answers feature is enabled, only system
administrators, place owners, and discussion authors can see the Correct

Correct
Answers

Answer option on questions. There can be only one Correct Answer per
question.

This feature is not limited to a cer tain type of space or group, but it is
most useful in places that are specifically designed to answer questions
quickly, such as a customer support space or a human resources group.

Community managers cannot configure the Helpful option. It is always
available.

159AUREA CONFIDENTIAL

Using content



Reserving files and documents
Marking an uploaded file or a document as Reserved indicates that someone is
currently editing it so that other users shouldn't edit it until the Reserved badge is
removed. It does not actually lock the file or document.

The Reserved badge provides important information about file status for anyone
who can't use Jive for Office to edit and merge uploaded files, for example, Mac
users. It can also be used to warn users of a published Jive native document that's
not ready to be edited by other people yet. The Reserved badge doesn't prevent
anyone else from editing, but it shows information about who is working with the
item, making it easy for other people to check in with you before adding their own
edits. Note that if you want to hide an in-progress Jive document before publishing
it, you can just save it as a draft and share it with anyone you want to.

When an author or editor marks a file as Reserved, anyone can see who reserved
the file and contact the person if they're unsure whether it's OK to proceed with
editing. Anyone with the rights to edit a file or document also has rights to mark it
as Reserved. When someone reserves a file, the author and anyone who has already
edited the document receive an Inbox notification. You can filter content to find re-
served documents, too.

Differences in reserving Jive documents and uploaded files

Jive already provide an indicator when someone has star ted editing
a document. (However, note that the lock on the document while

Jive native
documents

someone is editing only lasts ten minutes, and after that, it's possible
to edit the document and overwrite another user's changes.) Mark
as Reserved replaces the need to put "WIP" or another indicator in
the title when a document isn't in a state where you'd like other users
to contribute. It shows an author or editor's intention to keep working
on the document undisturbed until the next time that the author
publishes it.

Mark as Reserved warns users who don't use Jive for Office that
publishing a new version could overwrite and invalidate a version

Uploaded
documents

someone is working on locally. (Windows users with Jive for Office
have live merge capability and may not need this feature as much.)
Marking a file as Reserved does not lock the document or prevent
uploading another version. But any other user who clicks Edit with
the intention of uploading a new file can see a message pointing out
that the file is currently reserved for editing.
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Marking as Reserved
You can reserve a document or file to aler t other users you're working on it. This
doesn't lock the document, but it aler ts other users that you are planning to update
the item.

Reserving documents is especially useful if you're using uploaded files, but can't
use the Jive for Office. The Reserved badge doesn't prevent anyone else from
editing, but it shows information about who is working with the item, making it easy
for other people to check in with you before adding their own edits. For more infor-
mation, see Reserving files and documents.

To mark a file as Reserved and remove to remove the marking:

1. Go to the document or file you want to reserve.

2. To mark the content item, click Actions > Mark as Reserved .

The Reserved badge is added at the top of the document.

3. To free the file for editing, use any of the following:

• Click Unmark next to the Reserved label on the document or file page.
• Publish the item. When you or anyone else publishes a new version, the

Reserved badge is removed.
• Mark it as Final, Official, or Outdated. These markings override Reserved, and

the reserved badge is removed.

Managing your action items
Understand how to resolve, add participants, and manage your Actions.
Adding participants to action items
You can add participants to items that have been Marked for Action for you. This is
a way to get help on an action item.

Bringing in other people on your Action Item notifies them that you need help and
gives them the opportunity to Resolve the issue or Take Ownership of the action.
Note that adding participants does not assign the action to them. For formal task
management, you may need to use the task functionality. For more information about
the differences, see Mark for Action or assign a task?.

• To add participants to an existing action item that you own:

a) Go to the content item that is marked for action.

You can go to the item by searching for it or looking at your list of Action Items
under the Actions tab in Inbox.

b) Click the Actions  or Action Item badge.

c) Click Add Participants or .
d) Select the users you want to add to this action item.
e) Leave a note describing what you need.
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The note shows up only in the participant's Inbox, so it should let them know
specifically what you need from them, for example, Provide remaining RFP in-
formation.

f) Click Mark.

The new participants see an aler t in their Inbox, along with your note. They can
then Resolve or Take Ownership of the item.

• To add participants while creating an action item:

a) Go to the item and click Actions > Mark for Action .
b) Add a general description of the action that anyone in the community will be

able to see when they click the Action Item badge, for example, Provide
remaining RFP information.

c) Select Bring in others to resolve this action item.
d) Select the users you want to add to this action item.
e) Leave a note describing what you need.
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The note shows up only in the participant's Inbox, so it should let them know
specifically what you need from them, for example, Provide remaining RFP in-
formation.

f) Click Mark.

The new participants see an aler t in their Inbox, along with your note. They can
then Resolve or Take Ownership of the item.

Resolving action items
You can resolve action items and leave a note explaining why you are resolving it.
The author of the top-level item and owners of an action item have permission to
resolve action items.

To resolve something that's been Marked for Action:

1. Go to the item.

2. For comments or replies, click the Action Item badge and select Resolve.

3. Add a note explaining why you are resolving the Action and click Mark.
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This note is visible to others, so it's helpful to describe how you resolved the ac-
tion.

The Resolved badge appears on the content item.
Managing your action items
You can manage items that have been Marked for Action for you from the Actions
tab of Inbox.

To manage Action Items that you own:

1. Go to  > Actions .

On the Action Items > Active  tab, you can see a list of items awaiting Action
from you.

2. You can do any of the following:
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DescriptionMarking Option

Add a description of your resolution so that others
know what you did that resolved the item. When
you Resolve an item, it is moved from the Active
list to the Resolved list. If required, you can
unresolve the item from the Resolved list.

Resolve

Add other par ticipants to this Action and leave them
a note describing what you need. They can then
Resolve or Take Ownership of the item.

Add more people to the
item ( Resolve > View
Conversation > Add
participants )

Lets you review the full conversation. From there,
click the Action Item badge and Resolve the item
or Add Participants to bring in more people on
this item.

Go to the action item to
review it in context by
clicking on its title

Using Personal Insights
You can use Personal Insights to gain visibility into your community contributions.

Personal Insights provide analytics for the content you have created for your com-
munity. We derive this data from your event activities in your community and base
it on any activity that you have engaged in. You can use this feature to gauge how
the community responds to your content and to see your activity all in one place.

• To find your Personal Insights, click Your avatar > View Profile , and then click
Insights.

Note:  Note that only the data of the current and previous two calendar years is
available in Personal Insights. For more information, see Update to our Jive Analytics
Data Retention Policy on Worx.
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Making your content more engaging
It may seem obvious that good, clear writing draws people in. Writing well takes
practice. Getting people to actually open your blog post requires it to stand out as
it whizzes by the community.  Improving your writing and getting readers

to read your content are ways you can better your Personal Insights.

Here are a few tips you can use to grab your audience's attention:

• Write clearly using catchy, descriptive titles.

• Become familiar with your community, and keep them in mind when you write.

• Be consistent. By writing a blog post every Monday, people will learn to look for
it.

• Let your personality shine through! People want to learn your insights.

• Read it out loud. You can catch the snags that detract from your writing flow.

As you gain the attention of your community, think about how to get people to interact
with your content. Star t with a clear idea of what you need from readers. If you have
a specific question, ask it! If your community supports polls, you could also link to
a poll, asking people to par ticipate. If you have something specific to communicate,
state it early on, so people don't miss the point.

You should also find someone to review your content, especially if you think it's
perfect. Hint: It's usually not perfect, even for the pros. Hearing someone's perspec-
tive on your writing helps you remove anything that distracts from your point, which
gives it impact.

For more tips on writing, check out these classic books:

• The Elements of Style by William Strunk Jr.

• On Writing: A Memoir of the Craft by Stephen King

• On Writing Well: The Classic Guide to Writing Nonfiction by William Zinsser

Reaching your community
Personal Reach, Global Impact, and Sentiment summarize your effect on the
community, how well you contribute, and reactions to your contributions using data
from the past 12 months.

You can use these tools to continuously improve how you present content to the
community. You might strive to increase your numbers or to get a positive sentiment.
Here's help interpreting the values:

Shows the percentage of community members seeing your content
using mobile devices and the web.

Personal Reach

Shows how the community reacts to your content by looking at
their social actions, such as bookmarks, comments, likes, shares,

Global Impact
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and views. Personal Insights uses averages over the past 12
months to calculate this number.

Shows how well your content resonates with your community.
Content can achieve Neutral, Good, or Excellent sentiment based

Sentiment

on social action and views. Personal Insights uses averages over
the past 12 months to calculate this value.

Understanding interactions
To calculate your interactions, Personal Insights uses your social actions with other
community members and averages those using weighted metrics.

Personal Insights derives the metrics from your different social interactions, giving
activities like sharing an object a higher weight than commenting. You can either
see your interactions with other individuals or with entire departments.

Characterizing profile type
Your overall profile type status and pie chart are based on the level of different
participation types that you engaged in during a month.

Personal Insights determines the participation type for a given day, based on the
classifications established in the Events mapping document and then reports back
the percentage of time you were Contributing, Consuming, or Participating for a
given month. You can find the Events mapping document Engagement Analytics
Events Classifications - Participation Ladder and Engagement Ladder on Worx.

For example, consider a 30 day period. In the 30 days, the first 20 days the user
was classified as a par ticipant, and the next 10 day the person was classified as a
contributor. The display should say "Participating 66.67%", the pie chart would have
two pie charts - Participant 66.67% and Contributor 33.33%.
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Visualizing your personal impact
The Personal Impact section of your Personal Insights lets you see your
monthly tally of content created, likes given, content shared, views
received, likes received, and helpful answers received. Content includes

docs, blog posts, discussions, questions, polls, ideas, comments, tasks, uploaded
files, and status updates.

You can try changing the way you blog or add images to your documents and see
if reactions change. Maybe you get more likes when you announce a big project,
but more comments when documenting a process. Try to figure out why cer tain blog
posts are more popular than others. Have fun with it!
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Tracking popular content
Popular content is content that evokes the most reactions. You can sor t content by
the top 20 most views, comments, likes, or shares.

The rank is based on the absolute count of a given metric. For example, the Top
20 commented items ranked on the number of comments per document.

• Click a header in the popular content table to sor t by a par ticular interaction and
see the top 20 items in that category.

• Check out View Trends to see the sparkline, which represents a view for the
entire year.

Using Impact Metrics
Use Impact Metrics to gain insight on how documents and blog posts are received
by the community, including their Global Reach, Impact, and Sentiment.

Additionally, if your community is connected to Cloud Analytics, you can see more
features, such as:

• Impact metrics for discussions

• Number of subscribers

• List of top departments

• List of top referrers

• Number of emails generated by your content

169AUREA CONFIDENTIAL

Using content



Understanding Impact Metrics
There are two views of Impact Metrics: summary with a metrics overview and detailed
that provides details to the summary.

The summary view highlights the calculated metrics for global reach, impact, and
sentiment. Content in private and secret groups shows viewers instead of global
reach. The detailed view provides calculated metrics shown in the summary plus
an email metric, a graph of social actions that contribute to the metrics, and details
about viewers and referrers.

The summary view of calculated metrics can be found in the sidebar of your published
content:

When you click View More, you see the detailed view of Impact Metrics. For more
information on the detailed Impact Metrics, see Using detailed view on page 171.
The following calculated metrics are available for supported content type:

Conveys how widely viewed your content is in your community.
We use a calculation based on the number of registered users and

Global Reach

include web and mobile views only. This calculation does not
include those following content via email.

In private groups, you see Viewers instead of Global Reach. These
are the unique viewers who have looked at your content.

Viewers

Shows how your audience reacts to your content by looking at
their social actions, such as Bookmarks, Comments, Likes, Shares,
and Views.

Impact

Indicates how well your content resonates with your audience.
Content can achieve Neutral, Good, or Excellent sentiment based
on social action and views.

Sentiment

For more technical information on how impact metrics are counted and how you can
use them to your advantage, see Deep Dive: Impact Metrics on Worx.
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Using detailed view
In the sidebar of your content items, where you see the calculated metrics, click
View More to open the detailed view of Impact Metrics.

The Impact Metrics detailed view shows a graph with the number of Views, Viewers,
Comments, Likes, Shares, and Bookmarks of your content by date. It also gives you
the calculated metrics, which are the global reach, impact, sentiment, and email.
For videos, Impact Metrics shows more specific details, such as an average duration
of the view and retention.

Use these metrics to see how your content is being received in the community.

Note:  Some features described in this topic are only visible for communities which
use Cloud Analytics.

General metrics

Conveys how widely viewed your content is in your community.
We use a calculation based on the number of registered users

Global Reach

and include web and mobile views only. This calculation does
not include those following content via email.

In private groups, you see Viewers instead of Global Reach.
These are the unique viewers who have looked at your content.

Viewers

Shows how your audience reacts to your content by looking at
their social actions, such as Bookmarks, Comments, Likes,
Shares, and Views.

Impact
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Indicates how well your content resonates with your audience.
Content can achieve Neutral, Good, or Excellent sentiment based
on social action and views.

Sentiment

You can adjust the report dates in the upper left corner of the
detailed Impact Metrics graph. Either enter a custom date range

Report Dates

that focuses on a specific period of time, or select a
pre-configured report period that shows the first 7, 30, or 60 days
of publishing the content.

Note:  Impact Metrics are real time, so expect to see new viewers
right way.

When you click daily or hourly and then hover over the graph,
you see data for more specific chunks of times.

Daily or hourly
data

If your community has the News enabled, then you can click
Subscribers to see how many of the viewers clicked through to

Show Only
Subscriber
Metrics view this content from their News stream. When News is disabled,

you will not see the Subscribers button.

If you want to look at which departments have the most Views,
Viewers, Comments, Likes, Shares, and Bookmarks, then click

Data by
Department

Top Departments in the top right of the detailed Impact Metrics
graph.

Counts how many email notifications occur when one of the
following events happen:

Email

• Use @mention in content, comments, or replies.

• Share content.

• Add collaborators to content.

• Reply to discussions, or comment on blog posts, videos, or
documents.

• Create content when someone who follows you has email
notifications enabled.

Viewers tell you who's looking at your content, and top referrers
tell you who's generating interest in it. For more information, see
Who is viewing and referring your content? on page 175.

Viewers and
referrers
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Video-specific metrics
Figure 30: Impact Metrics of a video

The Video tab shows how people watch your video:

The average watch time metric shows the average time the video
has been watched.
Average watch time = the time the video has been watched in the
selected period / the total number of unique users

Average view
duration

The Video Analytics > Video > Avg. Watch Time  graphs show
the values for the selected period. And the table underneath shows
the average view duration for all time the video exists.

The Plays metric shows how many times the video has been
played. In this, plays are different from views: views count the

Play rate

openings of the video page, while plays count the times user
star ted watching the video, including replays.

The Play count is increased once a user hits Play on the video
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The Video Analytics > Video > Plays  graphs show the values
for the selected period. And the table underneath shows the total
plays in the selected period.

The retention metric shows how viewers watch your video. Do they
watch till the end or stop in the middle?

Retention shows the number of plays for a video moment as a
percentage of the total number of video plays.

Audience
retention

The Video Analytics > Video > Retention  graph shows the
values for the selected period.

Just because a viewer didn’t get to watch your video completely,
that doesn’t mean that they didn’t engage with it. They may have
found the answer they searching for or leave the video for later.

This metric shows the total time the video has been played after
its creation.

Total Watch Time = all time the video has been played

Total Watch
Time

This metric shows which part of the users watched the video till
its end. This value is counted for all time the video exists.

Avg. % Completion =

Avg. %
Completion

The Geography tab shows playback locations where people are engaged. This may
be especially relevant for geographically spread communities.

The graph under Video Analytics > Geography > Heat
Map  visually demonstrates where you where the video
is played the most – or the least.

The number of users from a country (by IP) who played
the video

Where the video was
played

The tables under Video Analytics > Geography > Top
Performing Countries  present you the total views by

Playback locations
versus watch time

country and the average view duration based on where
the video was played.

The Device Type tab segment views by device.

Jive segments all views by device type: desktop, mobile
phone, or tablet. If the device cannot be recognized the view
is counted under unknown.

Views by device

For more technical information on how impact metrics are counted and how you can
use them to your advantage, see Deep Dive: Impact Metrics on Worx.

Where are the Impact Metrics for this?
If you don't see impact metrics for a content type, you either don't have permission
to view them, or they're not available to that type of content.

Authors and a few others can use Impact Metrics as a way to measure how the
content is received by the community.

174AUREA CONFIDENTIAL

Chapter 1: Using a Jive community

https://community.aurea.com/docs/DOC-254862


The content author and everyone with admin rights
can see the Impact Metrics. When you publish the

Who can see impact
metrics for documents,
discussions, and videos? metrics to everyone, then everyone who can view the

content can see the Impact Metrics for it. For more
information, see Publishing Impact Metrics to everyone
on page 176.

The content author and the group or space owner can
see the Impact Metrics. When you publish the metrics

Who can see Impact
Metrics for blog posts?

to everyone, then everyone who can view your blog
post can also see the Impact Metrics for it. For more
information, see Publishing Impact Metrics to everyone
on page 176.

Blog posts, documents, discussions, questions, and
videos show Impact Metrics.

What types of content
show Impact Metrics?

Who is viewing and referring your content?
You can find out who's viewing and who's referring your content by looking
underneath the detailed Impact Metrics graph.

Viewers

If enabled in your community, find out who has viewed your content when you look
under the Impact metrics graph in the detailed view. Only the standard access user
can see this viewers panel, and external contributors can never see it. From the
Viewers panel, you can search for viewers based on first name, last name, and title.

Top referrers

If enabled in your community, see whose referrals gained new viewers to your con-
tent. It's under the detailed view of the Impact Metrics graph. You also see how
many viewers have been referred by that user. Only the standard access user can
see this viewers panel, and external contributors can never see it.

Improving your impact
Improve your Impact, Global Reach, and Sentiment by sharing your content with
either the entire community or just a few colleagues.

Consider your audience when posting or sharing content. If you're posting something
that only Sales need to pay attention to, then post it to the appropriate Sales group.
If you already posted your content in a place where it's not getting the attention you
need, then you can move it, or try @mentioning the appropriate group or users in
your status update to get the right people to see your content.
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When you share content with the right set of people, you can really improve your
impact. Sharing with users who interface with a lot of people can make your content
much more visible – if these users interact with it, it shows up in Top & Trending.
For example, many managers and executives are superstar users because people
who report to them pay attention to what they do.

Publishing Impact Metrics to everyone
You can expose Impact Metrics to everyone who has permission to view your content.

When you're ready to show everyone the Impact Metrics on your content:

1. Go to the sidebar and hover over the calculated metrics.

2. Click the pencil edit icon when it shows up.

3. Select Make these Impact Metrics public.

Translating content
You can translate content that you and other community members created, without
leaving your Jive community.

If Content Translation Service is enabled in your community, you can see a Translate
link in the Actions menu of published content, including comments.

• To translate the user-generated content into your default language, click Translate.

Note: Your default language is the language that your Jive application is in. You
can view your default language by clicking Your Avatar > Preferences  and
looking under Language. For more information, see Supported languages.

• Comments are translated separately. Go to the comment you want to translate,
and click Translate.

• If you want to translate into a language other than your default, click the drop-down
arrow next to Translate and select a language from the list that appears.

• After content is translated, Translate changes to Undo Translation. Select that
link, leave the page, or refresh the page to return the content to its original
language.
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Tip: The Translate link translates user-generated content only. If you want to use
Jive in a different language, change your default language by clicking Your Avatar
> Preferences  and selecting a different Language.

Using projects and tasks
Projects and tasks are a great way to turn collaboration into action and track your
progress.

A project is a great way to give collaborative work a context that is time-based and
outcome-based. With a project, you collect content in a way that focuses user work
along with a schedule toward a specific goal. You can then create and assign people
tasks and sub-tasks associated with the project to make sure everything gets done.

Overview of projects and tasks
Jive projects provide lightweight project management with tasks, due dates,
checkpoints, and notifications.

A project can contain various content types, including tasks. You can create tasks,
assign them to people, set due dates, and mark them as complete. Once you enter
all the tasks for a project, you can edit or delete them, add sub-tasks, set up email
notifications on tasks, and mark tasks complete. As with other content, you can
assign tags to tasks.

You can add checkpoints to a project as a way of making sure your project is pro-
ceeding on track. A checkpoint is a named place in the schedule, and it's often used
as a point at which to make a decision about what to do next.

To help you manage your project progress, Jive provides visual cues that snapshot
the project. On a project's home page, you get a checkpoint timeline that shows
where your checkpoints are between the project's star t and finish, and where the
current date falls on the timeline. A project calendar captures task due dates and
checkpoint dates in a traditional calendar style.

Creating projects
You can create and configure projects for collaborative work.

If you use the checkpoint and status functionality for tracking project tasks, you can
use the old-style Overview page rather than using the Activity page in the place
template format. The widgets in the Overview page more effectively support projects
at this time.

Important: We do not recommend that you use widgets and widgetized Overview
pages (including the Home page) in your community. For more information, see
Understanding pages in places.
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To create a project:

1. Click  > Project .

2. In the dialog box, select a location for the project.

Projects are associated with a place, such as a space or a group. The place you
choose determines who can see and collaborate on the project.

3. In Name, specify an identifying name for the project.

4. In Description, enter a brief description.

The description appears in the user interface.

5. In Project Start Date and Project End Date, specify the project duration.

You should use the target date for completing the project.

6. If necessary, change the project owner in Project Owner.

The default owner is the person creating the project.

7. In Tags, specify tags that can be used to find this project.

8. If available, in Categories, select the place category of the project.

The place categories are used to identify places while browsing. They are used
to classify places and differ from content categories. This option is available if
place categories are configured in your community.

9. To enable the Overview page, click Advanced Options and select the Overview
page check box.

By default, your project uses an Activity page as its main page with the option to
add more custom pages. We recommend using an Activity page because it can
be displayed on mobile devices and because it's more friendly to streaming
content. This option is available if widgets are enabled in your community.

10.Click Create Project.

The project is created.

11.If you are using the Activity page, apply a place template to this project, as
described in Applying place templates.

Note: The default template is Team Collaboration. For more information, see
General place template reference.

The project is created and you can add tasks to it. For more information, see Creating
tasks on page 179.

Additionally, you can fur ther customize the project. For more information, see Place
Templates for designing activity and custom pages for places.
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Deleting projects
When you delete a project, you remove the entire project, including its content, from
the system. You cannot undo a project deletion.

When a project and its content are deleted, the links and @mentions to the deleted
project are replaced with the "The specified item was not found" message. To avoid
this, you can archive the project instead of deleting it. For more information, see
Archiving projects.

To delete a project:

1. Go to the project and click gear icon > Delete project  in the upper right corner.

2. Confirm the project's deletion by clicking Delete.

The project and all its content are deleted from the application.

Creating tasks
You can create personal tasks for yourself or assign tasks for others and associate
them with projects.

Note that you can create tasks that are unassigned to a project only for yourself.
These tasks are called personal, and they are available only for you. If you want to
create tasks for other users, you must assign them to projects.

To create a task:

1. From the main navigation menu, click  > Task .

2. In Description, provide a brief overview of the task.

3. In Project, select a project for this task.

The default selection is None, which means it is a personal task for yourself and
only visible by you. You cannot create personal tasks for other people. By default,
the task is assigned to you.

4. To assign the task to someone else, click "x" next to your avatar, and then select
the user to whom the task must be assigned.

5. In Due Date, enter the date you want this task to be completed by.

The default due date is tomorrow.

6. If you want to use the content editor to describe the task and add tags to it, click
Advanced and fill in the necessary details.

7. Click Add Task to add the task.

Tasks assigned to projects are displayed on the project Tasks page. Personal tasks
appear on the Tasks page of the user.
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Managing tasks
You can edit a task, add a sub-task, delete a task, and follow it in a stream. You
can do this from either your personal task list ( Your Profile > Tasks ) or a project's
task list ( Project > Tasks ).

To manage tasks:

1. To view your tasks, including your personal tasks and project tasks, go to Your
profile > Tasks .

2. To view project tasks, go to Project > Tasks .

3. To view task details, click Show details next to the task.

This opens the task description and the task menu.

4. Select one of the available actions: edit a task, add a sub-task, delete a task, or
follow it in a stream.

Completing tasks
There are two ways to manage and complete tasks: through your personal tasks list
or the tasks list associated with a project.

1. To view your tasks, including your personal tasks and project tasks, go to Your
profile > Tasks .

2. To view project tasks, go to Project > Tasks .

3. Select the check box to the left of the task you want to complete.

You can briefly see the task with a line through its text before it disappears
completely from the list. If you want to see the completed tasks, select the Include
completed check box under View.

Importing and exporting tasks
Tasks can be transferred between Jive projects and other tasks management tools.
Jive uses comma separated values (CSV) files to import or export task data in bulk.

Importing tasks
Tasks can be imported into Jive projects from CSV files with commas used as
separators. You can map the columns in a CSV file to the Jive task fields after the
file is uploaded to Jive.

A template of a CSV file can be found here.

To import tasks into a Jive project:

1. Export the information from your other project management tool, saving it as a
CSV file with commas used as separators.

2. Go to your project in Jive and click Import/Export Tasks in the Actions list.
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3. On the Import/Export Tasks page, under Import tasks from a CSV file, click
Browse to locate the CSV file you exported, and then click Upload File.

After the file is uploaded, the page shows the column titles for Jive tasks (such
as Description Field, Assigned To Field, and Due Date Field), with dropdowns
that list column titles found in the CSV you're uploading.

4. Use the dropdowns to map a different CSV column title to each of the titles in the
Jive project.

This determines where the information goes in the Jive project. The page displays
a preview using the information found in your CSV file.

5. Click Proceed to accept the mappings.

6. Clear check boxes for those items you don't want to import.

7. If necessary, click the Edit link for a task to edit task information before you import
it.

8.

The imported tasks are linked to the project.

Exporting tasks
Tasks can be exported from Jive projects into CSV files with commas used as
separators.

To export tasks from a Jive project to a CVS file:

1. Go to your project in Jive and click Import/Export Tasks in the Actions list.

2. On the Import/Export Tasks page, under Export tasks to a CSV file, specify
exporting options:

a) Select which tasks should be exported: All or Incomplete tasks only.
b) Select if Username or First/last name should be used.
c) Select if the CSV file should be encoded for Microsoft Excel.

3. To export only some of the filtered issues, click Choose Tasks, clear the check
boxes for the tasks you don't want to export, and then click Export Selected
Tasks.

4. To export all filtered issues, click Export.

The CSV file with the exported tasks is downloaded to your computer.

Mark for Action or assign a task?
You should understand the differences between Mark for Action and creating tasks
and the best ways to use these features.

Mark for Action is par t of the Marking feature and allows you to assign
content items to yourself for action, or invite others to review them and

Actions

take ownership. Typically, you should use Mark for Action in an informal,
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on-the-fly manner when you're discussing something. For more
information, see Using Marking feature on page 149.

Tasks are a formal way to assign and track tasks for yourself or others

(  > Task  or Actions > Tasks > Create a task ). You can assign the

Tasks

task a deadline and associate it with a project, such as Sales Kickoff
January 2015, or save it as a personal task for yourself. All tasks that
are associated with a project are displayed on the Tasks tab of the
project. For more information, see Using projects and tasks on page 177.

Public and private communications
To enjoy the full power of Jive, we recommend keeping discussions and documents
public whenever possible. The following topics describe the visibility options for
content, as well as the security of the application for users.

Security of content and activities
Your organization has deployed Jive to provide a place for you to get your work
done by contributing to and collaborating in the community. Your activity in Jive is
safe and secure.

Your company owns your activity in the community, just as they own your activity
in your company email program. For more information on who can see your content
and how visibility works in Jive, see Content visibility on page 182 and Content visi-
bility options.

Related information

If you're concerned about the security of Jive and want to get a deeper understanding
of how your information is protected, see the security overview on the Security page
on the Jive Software website at http://www.jivesoftware.com/social-business/engage-
employees/technology/security/. Alternatively, you can see Jive Security in the
Community Administrator Guide.

Content visibility
The visibility of the content depends on the place where you published it. Different
places have different visibility permissions.

In Jive, people post content in places. This means that all content (such as discus-
sions, documents, and blog posts) is published in containers. A container can be a
space, sub-space, group, project, or your own personal content. All places have
visibility permissions set by the place owners that determine who can see the content
posted in that place.
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While it's best to keep things public whenever possible so that other community
users can benefit from all of the content pieces (such as discussions or documents),
there are times you may want to publish things only for yourself or a handful of
other people. In addition, you may want to keep entire categories of content private,
for example, accounting or human resources information. In that case, you can
create a space or group with the content visibility options that you need. For more
information about permissions, see Managing Permissions in the Community Admin-
istrator Guide.

For more information about the security of the community, see Security of content
and activities on page 182.

Content containers
Here you can find the types of containers in which you can publish content in the
community.

Your personal content

Your personal container is where you can store your documents and other content
types that are hidden or limited to specific people. Your personal tasks are also
stored here.

To see your content that is limited to only you or specific people:

1. Go to Your Avatar > Your Content > Authored > <Document type> .

This opens your personal container where you can find the content items of dif-
ferent types and filter them.

2. Select Filter by personal content to see content pieces available only to you.

A dark lock icon next to the item indicates it is limited to you; a light lock icon next
to the item indicates it is limited to you and the other designated people.

You can find your personal tasks on your profile page or in the project. For more
information, see Managing tasks on page 180.

Groups

Different types of groups have different content visibility permissions. For more in-
formation about the various options, see Types of groups on page 60.

To view the content of a group:

• Go to the group and open the Content tab.

You can filter the content by type to view, for example, discussions or documents.
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Spaces

Spaces have complex content visibility options that are set up by the owners of the
space. Also, spaces can be configured to contain some content types. For example,
you may not be able to create a discussion in Space A, but you can in Space B.
You can see the allowed content types on the Content tab of the space.

• Go to the space and click the Content tab.

You can filter the content by type to view, for example, discussions or documents.

Sub-spaces

By default, sub-spaces inherit all of the content visibility permissions of their con-
taining parent space.

• Go to the sub-space and click the Content tab.

You can filter the content by type to view, for example, discussions or documents.

Projects

Projects inherit all of the content visibility permissions of their containing parent
space or sub-space.

• Go to the project and click the Content tab.

You can filter the content by type to view, for example, discussions or documents.
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Content visibility options
You can limit to selected people the visibility of content that you create, or hide it
completely from other people. Here is a reference of the visibility options of all
content types.

Content visibility reference
Here you can find details on who can see content items in various places in the
community and which content types cannot be hidden.

Your personal content

Documents
and uploaded
documents

• Description: When you publish a document as Hidden, it is stored
in your personal container and is private to you.

• Are streams updated?: You can see a stream update when you
publish, but other users cannot.

• To set the item as Personal: Before you publish the document,
set its visibility to Hidden. For more information, see Creating
documents for yourself on page 84

• To find the item later: Go to Content > Authored > Documents
, and then select Filter by personal content. The dark lock icon
next to the document indicates it is limited to you.

External
bookmarks • Description: Your private bookmarks are stored in your personal

container and are private to you.

• Are streams updated?: You can see a stream update when you
save the bookmark, but other users cannot.

• To set the item as Personal: Go to  > Bookmark  and paste
in the external URL. Then, select Make this bookmark private
and save it.

• To find the item later: Click the Spotlight search and select
Bookmarked > Show all bookmarks . In the main navigation
menu, filter by External URL. The dark lock icon next to the
bookmark indicates it is limited to you.

Personal
tasks • Description: You can assign yourself personal tasks so that no

one else can see them.

• Are streams updated?: You can see a stream update when you
publish, but other users cannot.

• To set the item as Personal: Go to  > Task  and select
Project > None (personal task) .

• To find the item later: Go to Actions > Tasks . In the Project
menu, select Personal.

Content limited to specific people
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Documents
and uploaded
documents

• Description: When you publish a document limited to Specific
People, it is stored in your personal container and is private to
you and the other people you designated.

• Are streams updated?: You and the other specified people see
a stream update when you publish, but other users cannot.

• To set the item as Personal: Before you publish the document,
set its visibility option to Specific People.

• To find the item later: Go to Content > Authored > Documents
and then select Filter by personal content. The light lock icon
next to the document indicates it is limited to you and the other
people you designated.

Discussions
and
Questions

• Description: When you publish a discussion or question limited
to Specific People, it is stored in your personal container and is
private to you and the other people you designated.

• Are streams updated?: You and the other specified people see
a stream update when you publish, but other users cannot.

• To set the item as Personal: Before you post the discussion or
question, set its visibility option to Specific People.

• To find the item later: Go to Content > Authored >
Discussions/Questions  and then select Filter by personal
content. The light lock icon next to the item indicates it is limited
to you and the other people you designated.

Messages
• Description: You can send one or more other users a private

message.

• Are streams updated?: Messages are listed in the Inbox. They
do not appear in streams.

• To set the item as Personal: Go to  > Message  and select
the persons to whom you want to send the message.

• To find the item later: Go to Inbox. In the Filter drop-down menu,
select Messages.

Content that you cannot hide

• Blog posts.

• Discussions.

• Questions.

• Polls.

• Status Updates. However, you can limit your status update to a group if you want
to limit its audience. For more information, see Posting status update in groups
on page 62

• Projects.
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Setting up content visibility options
If you're concerned about privacy, you can limit who sees different par ts of your
profile by editing your privacy settings.

To limit profile visibility:

1. Go to Your avatar > Edit Profile .

2. Go to the Privacy tab.

3. For each profile field, select who can view it.

Your community administrator may control who sees cer tain fields, such as those
without a Visible to option.

4. Take a look at how others can see your profile by using the Preview your profile
option in the upper right corner of the page.

5. Click Finished to save the changes.

Creating direct messages and private discussions
By using messages and private discussions, you can limit your audience to only the
people you want.

Messages and private discussions show up in the Inbox of only the people you send
them to. These are useful features, but the power of Jive is that nearly all topics in
the community can be helpful to others, so try to keep things public whenever pos-
sible.

To send a message to someone, do one of the following:

• In your Inbox, click Send Message.

• Select  > Message .

• Click Message from the top of any of your attention streams.

• Hover over the person's name in any of your attention streams and click Message.

After your message is sent, the receiver can see it in their Inbox. From there, the
receiver can respond directly.

To create a private discussion:

1. Click  > Discussion  to create a discussion, then enter the title and details
of the discussion.

2. Select Specific People under Publish Location.

3. Select the participants you want to include in the discussion.

4. When you're finished drafting the discussion, click Post.

Only the participants you selected can see a discussion notification in their Inbox.
From there, they can respond to the discussion.
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Saving drafts
You can use the Save As Draft feature to quickly jot down and save your thoughts
in documents or blog posts. Then, you can come back later to edit and publish your
content. You can also collaborate with others on saved drafts before publishing
them.

You can save blog posts and documents as drafts. This can be useful if you need
time to finalize your thoughts before publishing something. Additionally, drafts are
not visible in any streams.

Creating and editing drafts

To save a blog post or a document as a draft:

1. Create and fill in a document or blog post.

2. Click Save Draft.

The document is saved as a draft and is not visible to anyone. You can find it on
the Drafts tab of Your Content.

To edit a draft:

1. Go to Your Avatar > Your Content  in the main navigation menu, and then click
Drafts in the left sidebar to see your drafts.

2. If required, filter your Drafts results by documents or blog posts.

3. Click on the draft to edit the content.

4. Click Publish to save and publish the draft.

You can edit the content and save it again as a draft, or publish it.

Collaborating on drafts

You can collaborate on drafts of blog posts or documents before you publish them
or share an existing draft with other users.

To get people to collaborate on an existing draft:

1. Open the draft.

2. Click Share in the upper right corner of the page.

3. In the Share dialog box, select the people you want to share the post with and
include a message for them.

4. Click Share.

The recipients are able to edit the draft and either save it as a draft or publish it.
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Awarding badges and points
You can award other community members a badge to recognize their contributions,
and even give them some of your status points.

If your community manager has enabled Jive Rewards, you can celebrate and thank
other community members by awarding them badges, and optionally some of the
status points you've earned yourself. Badges show up on the Rewards page, and
the community member receives a notification that explains the reason.

To hand out a badge and optional points:

1. Go to <your_community_url>/rewards.

You can see the available badges at the top of the Badges tab.

2. Select a badge.

3. Star t typing a person's name in Give to, and select their name. You can only give
one person a badge at a time.

4. In Add a personal message, type a brief thank-you message, or explain why
they're getting the badge.

For example, you could type "Thanks for answering so many customer questions!"
This message is shown on the Rewards page and in the notification the user
receives.

5. If you want to give points with the badge, move the points slider. Points are
removed from your community total and added to theirs. Point levels affect
leaderboards, but won't affect any missions that have already been earned.

6. Click Give Badge.

Using Jive Apps
Jive Apps are available in your community to help you get your work
done faster and more effectively. For example, an app could help you

and your team to arrange travel and schedules. An app could remind you to get up
and stretch as you are working. An app could send a notification when your expenses
have been approved.  Apps work within your community and can use

its features directly as well as pull in third-party systems to bring
additional functionality.
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Overview of Jive Apps and app actions
You can use Jive Apps to accomplish focused tasks, integrate with other systems,
or provide new functionality to your Jive experience.

Jive Apps are lightweight applications that are hosted by Jive or a third-party, which
means you don't have to download anything to your computer and you are always
looking at the latest version. When you install an app in Jive, you connect to it and
enable it to access information that helps you work more effectively.

You can find Jive Apps when you click Apps at the top of your screen, where they
always are when you're logged into the community. Some apps can bring in informa-
tion from outside of your community, while others manage information within the
community itself. You can also access some Jive Apps through extension points
throughout the UI known as app actions.

Contact your Community Manager for acquiring additional Jive Apps.

App actions

Apps can be used in other places beyond the Apps menu at the top of the screen.
These additional app extension points are called app actions. An app action can
appear in one of many different locations within the Jive UI: as a menu item in the
Create menu (within the Apps section), in the sidebar when viewing a document
(within the App Actions section), as a new tab in a group or project, when typing
"!" while editing content. It is up to the Jive App developer exactly which of these
extensions are accessible and exactly what action occurs when you select this action.

Using apps in content
By using !App, you can bring links and images from a Jive App into your community
so you can share them with others.

Similar to @mentions aler t people and places, there's also a symbol you can use
to invoke a Jive App from any discussion, blog post, document, or comment in Jive.
Just type "!" and you see a list of installed apps.

When you create or comment on content in your community, you have the ability to
!Apps. This is a way to share app ar tifacts with others. This enables you to generate
a conversation about the app ar tifact or share it with people. If they don't have the
app, they are invited to download it when they click the image or link.

To get content from a Jive App:

1. In the content editor, type the "!" symbol (or click the "!" icon if it is available).

A search dialog opens and suggests possible matches.

2. Select the Jive App from the list and navigate to the image or content in the Jive
App to produce a link.
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Troubleshooting and FAQs for Jive Apps
Here are answers to some specific questions about Jive Apps and how they work.

I have a problem with my app: what should I do?

Jive Apps are supported by the developers who created them, just like apps you
may have used on your smartphone or another mobile device. To get support for
an app, select the App Settings button and select About. You'll be presented with
a link to either the developer's support web site or a support email address.

I can no longer use my app: what happened?

Sometimes apps become disabled when their data stream is interrupted, or when
the app can't connect to the Internet. Your community administrator can also disable
an app if she decides it's not appropriate for your community. Finally, for paid apps,
billing issues like an expired credit card can result in the app getting temporarily
disabled. If a paid app is disabled, we will no longer charge your credit card for app
usage. In general, we try to give you detailed instructions on how to get your app
star ted again. However, if you need some help troubleshooting, you should reach
out to your community administrator.

I'm leaving my community: what happens to my information?

If you leave your community, your credit card will automatically be disabled when
your administrator turns off your access to the community. If you still see charges
on your card please contact Jive directly at app-billing@jivesoftware.com.

What happened to the Apps Market?

You can now access Apps automatically when the Community Manager installs them
into your community. However, if the Apps Market is enabled, you can also install
apps from the marketplace. For additional documentation, refer to Apps Market in-
formation found in the Jive 7.0 Community User Help. Contact your Community
Manager for more information.

Using external groups
You can use external groups to collaborate with users from outside your community.

When you create an external group, you can invite users from outside the community
to work with community users. These groups usually serve a specific purpose, such
as working on a project with a vendor. External contributors can see content only
in groups they belong to.

The external contributor brings a fresh perspective and their expertise to an internal
or employee community where you would usually suffer the pains of long email
threads or time-consuming conference calls to get information from people outside
your community. These users can provide quick answers, share files, and collaborate
on documents.
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External groups overview
External groups provide an area where standard community users can work with
people from outside the community, external contributors. Only secret or private
groups can have external access.

You can use external groups to invite people from outside your community to collab-
orate with standard community users. For example, a user in a music label company's
community could create a private group for a collaboration project they're working
on. They could then enable external access to the group, invite the external ar tists
who will be participating, and use the group to post schedules and communicate
ideas. The external ar tists are limited to viewing and participating in this group only.
They can't see anything else going on in the community.

Groups with external access are designated with visual cues such as either orange

Externally Accessible text or  the orange eye symbol that means people from
outside your company are welcome in that group. You can find the following bright
orange sign post at a group's home page.

Creating external groups
When creating a group, you can select Enable external access to turn a community
group into a place where standard users can invite external contributors to extend
their communication and collaboration to the outside world.

For the details on group creation, see Creating groups on page 54.

To create a group with external access:

1. Click  > Group .

2. On the Create group page, enter the group name and details.

3. Select Private or Private > Unlisted for the group type.

External groups are limited to private and private unlisted groups to help protect
community information.

4. Select Externally Accessible to allow external contributors to be invited to and
join the group. Externally Accessible groups must be private or private unlisted
. You may not see this option if it's not enabled for your community.

5. Click Advanced for more options.

6. Click Create Group .

7. If you see the Invite People to Join dialog box, then add a few users who you
want to invite to the group, and click Send Invitation.
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8. To manage group features and select the storage provider, select Gear icon >
Configure activity page .

9. Click the gear icon in the Enabled Features and Content Types tile.

10.Select or clear features for the group.

People will be able to create content items of the types you select.

11.If available, you can select a storage provider for storing your uploaded files.

12.Click Apply.

13.Click Save.

The group is created and the user you invited can star t using the group.

Who are external contributors?
An external contributor can join a secret or private group when invited into the group
by a group member. External contributors can view and participate only in that group.
They cannot see any other community content or activity, and they can only join a
maximum of 20 groups.

You can securely invite someone from outside your community to par ticipate in an
externally accessible group. The standard community user can only see external
contributors when they belong to the same group.

Public groupPublic: Re-
stricted group

Private groupPrivate: Unlist-
ed group (Se-

cret)

  v*v*Can group
members invite
external contrib-
utors?

NoneNoneNoneNoneWhat is visible
to an external
contributor who
is not a group
member?

  Only a group
member

Only a group
member

Can external
contributors see
content?

  Only a group
member

Only a group
member

Can external
contributors
participate?
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Public groupPublic: Re-
stricted group

Private groupPrivate: Unlist-
ed group (Se-

cret)

  v*v*Can external
contributors in-
vite new group
members?

n/an/aGroup adminis-
trator

Group adminis-
trator

Who approve
secret and pri-
vate group
members?

* Group administrators must approve invitations to private or private unlisted groups.
Inviting an external contributor doesn't automatically grant access to a group. The
external contributor has then to accept the invitation.

Differentiating between external contributors and
standard users
You can always tell the difference between standard community users and external
contributors because external contributors have either an orange icon or orange
text near their name.

Whether you are searching for users, browsing through community activity or looking
at someone's profile card, you can spot the external access symbol that helps you
identify external contributors.

An email notification also clearly indicates when you're replying to an external con-
tributor.
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Inviting external contributors
When you belong to a group with external access, use the email addresses of users
you want to invite from outside your community to par ticipate.

To invite external contributors to join an external group:

1. Go to the group's main page.

2. Select Actions > Invite members .

3. Enter the email addresses of people you want to invite. To invite several people
from your email address book, you can export a comma-, space-, or
semicolon-separated list of addresses from the email application and paste them
in.

4. Edit the message you want potential group members to see with their invitation.

5. Click Send Invitation .

What can external contributors see?
External contributors can't see everything in the community because they are limited
to the content in their groups and a few other restrictions.

External contributors can see:

• Groups they have joined

• Content and projects within those groups

• Other users who are also members of those groups

External contributors cannot see:

• Spaces or projects besides those in their groups

• Community Overview page found when you click Home

• Global or public content, such as status updates, public bookmarks, or public
documents and discussions

• Apps, but they can see images embedded by apps within their groups
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What is unavailable to external contributors?

External contributors can use the community similarly to a standard user with the
following exceptions:

• Update their status.

• Create public discussions and documents.

• See and work with private messages; only unauthorized messages are seen.

• See or use Jive Apps. External contributors cannot see or launch Apps or App
Actions.

• Use Connects Services. External contributors also cannot see Connects Services
in their user's Preferences page.

• See or use the Tools page, so they can't download modules like Outlook, Office,
and Jive Anywhere.

• Access public external URL bookmarks or social bookmarking. External contributors
can create and view internal bookmarks of Jive content.

• Become group owners.

Contributing to community as external user
A company may invite you to join one of their groups and become part of their online
community so they can work closely with you, making you an external contributor.

Becoming an external contributor is a way to collaborate in a community
on a limited basis. As an external user, you can view content and
participate only in the group you belong to.

Once you accept an invitation to join a community's external group, you can begin
contributing to that group. For more information, see How to begin contributing to
community on page 196.

How to begin contributing to community
When you first join a community's external group as an external contributor, you
can begin par ticipating by accepting invitations, setting up your profile, and
addressing your actions.

Accepting group invitations

The first thing that you should do when you sign into the community is to accept
any group invitations. You'll be doing all of your work in groups, so accepting invita-
tions is how you can see group content and activity.

• Go to Home > Actions  and then accept group invitations that you see under
Pending.

Note: You can only belong to a maximum of 20 groups, so choose wisely!
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Setting up your profile

Your user profile provides community members with an easy way to learn about
your skills and interests. Your profile shows up in search results when community
members search for keywords contained in your profile. You can update your infor-
mation at any time.

Checking out your actions

When you are assigned something to do, such as a task or something that's been
Marked for Action for you, you can see an aler t next to Actions in the left sidebar.
For more information, see Using Marking feature on page 149.

Use the following quick tips to use Actions effectively:

• Click Action Items to see a list of your Action Items. From here, you can Resolve
them, or bring in other par ticipants. To see the Action Items you have already
resolved, click Resolved.

• Click Tasks to see a list of tasks assigned to you, which you can sor t by project.
To see the tasks you've completed, select View: Include completed. For more
information, see Using projects and tasks on page 177.

Customizing email notifications

You can take advantage of custom email notifications if you feel like you might miss
something important when you're not signed in. For more information, see Customiz-
ing notifications.

Setting up your profile
Setting up your profile is the first step to par ticipating in the community.

Your user profile provides community members with an easy way to learn about
your skills and interests. Your profile shows up in search results when community
members search for keywords contained in your profile. You can update your infor-
mation at any time.

To set up your profile:

1. Go to Your Avatar > Edit profile  in the upper right corner.

2. On the Avatar or Photos tab, change your avatar and manage your photos.

Your avatar and other photos let people see and recognize you in person. Your
avatar lets community members quickly associate your comments and status
updates with a simple visual cue.

3. On the Profile Details tab, fill in as much profile information as you like.

Note that your profile can found when people search, so if you have professional
roles or interests that would be useful for others to know about, you should include
them. You may not be able to edit cer tain fields, such as username. Usually, the
community manager sets up these fields for you.

4. On the Privacy tab, edit your privacy settings.
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These control how different types of users see your profile. For more information
on privacy settings, see Setting up content visibility options.

5. Click Finished.

The profile is set up and becomes available in search.

What else can external contributors do?
Jive is a place where you can build your network, come together as a team, share
files, collaborate on documents, and get answers fast.

The group you belong to looks forward to hearing your ideas, and they need your
expertise to get work done. Think of the group as a 24-hour hotline where you can
communicate your concerns and give your opinion. You can write documents and
get input from all the experts without taking notes or sifting through long email
chains.

Using your Inbox

Your Inbox shows the activity that's most you-centric – the information that's sent
directly to you and has your name on it. This automatically includes @mentions,
replies to discussions you're par ticipating in, content people share with you, your
latest acclaim, new follower notifications, and direct messages.

Use the following tips and tricks to get the most out of the Inbox:

• You can use the Filter menu in Inbox to sor t the view to @mentions, messages,
notifications, or shares.

• You can filter Inbox by participant by entering a user name in the box. You can
see only the items that include this person as a par ticipant.

• Manage your unread communications and follow-ups by using the blue dot next
to messages you haven't read yet and clicking Unread Only to see only the
messages marked with the blue dot.

• When you click the Split View icon in the top right of the Inbox stream and then
select a message, you can see the content of the message in the lower pane and
the list of messages in the upper pane.

• Get rid of activity on any item that no longer interests you by clicking Hide new
activity in the lower pane of the split-pane view. The current activity stays in your
Inbox, but you'll see no more update aler ts for that item. For more information
about notifications, see Customizing notifications.

Discovering documents and discussions (and other content), commenting and
collaborating

Exchange ideas when you participate in discussions, questions, and documents:

• To comment on a content item, you should click Add a Comment or Reply at the
bottom of a document, blog post, question, or discussion. You can reply to an
individual message in a thread or the original post. Everyone reading the thread
sees your response.

• Documents have owners who control whether you can change the content of the
document, comment on it, or view it. You may be able to see documents that you
don't have permission to comment on or par ticipate in. If you think you should be
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able to comment on a document and you can't, contact the author and ask for
permission.

• If you can edit a document, you can see Edit near the Actions menu.

• A comment or a reply may have a badge showing Decision, Action Item, or
Success. These badges help you avoid endless discussion and quickly determine
the state or outcome of the conversation. For more information about marking,
see Using Marking feature on page 149.

• Comments and replies may also be liked or marked as helpful. These are tallied
for reporting activity in places or the entire community.

• A badge shows others how helpful someone has been to you. To give someone
a badge, go to their profile page and click Actions > Give Badge .

Using attention streams

You can see streams on the News page and the Activity page of any place. Streams
are updated when someone creates a document, replies to a blog post, posts a
status update, and so on.

Objectives of external contributors
As an external contributor, you are a crucial par t of a community that needs your
input. You may not be a community member, but someone in the community invited
you because they knew you'd add value. The benefit of being an external

contributor is that you only see the parts of the community that affect
you. You don't have to worry about seeing anything you shouldn't.

Your role is to help the community reach outside of its circle and to share knowledge,
so that you and other group members can work together successfully and efficiently.
You can feel free to ask questions in your groups and to post and comment on
documents and discussions. When you become part of the conversation, you improve
how work gets done.
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